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1.  INTRODUCTION

1.1  About This Manual
This manual is provided as a reference for the display and analysis software packages supplied 
with ATRAD radar systems.  Many aspects of the material contained herein may be addressed 
more conveniently using the on-line manuals available with the software itself.  The manner in 
which these help pages may be accessed is described in this manual.  The user is encouraged to 
take advantage of the interactive and graphical nature of the software suites in order to further 
and reinforce their understanding of the way in which the software performs its tasks.

It should be noted that ATRAD’s radar systems are very modular, and tend to be extensively 
adapted to meet the end-users’ needs.  This manual is intended to describe a super set of the 
functionality provided with the software for any given system.  For this reason it is possible that 
some, or even many sections included in this manual are not applicable to the local radar system. 

1.2  Typeface Conventions
The following typeface conventions are used throughout this manual:

Bold-italic is used for the names of executable programs.

Italics is used for internet addresses, URLs and names, or for program states.

Italics within double quotes (“Italics”) is used for on-screen computer menu entries, buttons and 
other forms of information entry.

Normal text within single quotes (‘Normal text’) is used for extracts from other text, such as 
computer commands or command output.

Courier font is used for file names and directories, computer output and command line syntax 
examples.

<Substitute text> indicates an item whose actual text content may vary, depending either on 
the user’s choice, or on the content of a computer response.

<ABBR>- indicates the use of a keyboard modifier, (such as <ALT>- or <CTRL>-) to be used in 
conjunction with another key or keys.
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2.  REPORTING PROBLEMS
Software problems should be reported to ATRAD in writing using the supplied Software Field 
Performance Report forms, or via electronic mail and addressed to:

Postal: The QA Manager,
ATRAD Pty Ltd
1/26 Stirling Street
Thebarton,
South Australia,  5031

Fax: +61 8 8303 3489

email: bugrep@atrad.com.au
web page: http://www.atrad.com.au
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3.  Administrative issues

3.1  IDL license file
If the hostname of the radar analysis computer is changed, the "SERVER" line in the IDL license 
file should be changed. Please refer to Appendix H: IDL License information for further 
information.  Since the hostname is normally associated with the Radar Network and the Radar 
Network configuration rarely changes this will not usually be an issue.

3.2  What happens to the radar data?
With reference to the Acquisition computer (‘radar-acq’) and the Analysis computer (‘radar-ana’):

a) On ‘radar-acq’, after successfully acquiring a complete data set, the raw data is written to 
the RawSpool/ directory.  The filename consists of the date and time, followed by _<tag>, 
(where <tag> is specified as part of the respective experiment's configuration in 
radarcfg), with a .raw extension.

Raw data is not written if:
i) an internal acquisition error occurred during the experiment.  An error will be 

displayed and also written to the log.

ii) The ‘analysis_IP’ parameter in the sysparam.cf file is set to “none”

If the raw data is written, the acquisition program tries to FTP the data to ‘radar-ana’, the 
machine and directory specified in the sysparam.cf file.  If the transfer cannot proceed 
due to network interruption, the raw data file remains queued in the RawSpool/ directory 
until the network is re-established.  If any of the system parameters, analysis_IP, 
analysis_directory, analysis_u or analysis_p specified in the sysparam.cf file change while 
raw data files are queued in the RawSpool/ directory, they are removed from the queue 
and remain in the RawSpool/ directory.  They must be transferred manually if required, as 
it is assumed the destination for all new raw data files is different.

Each file which has been successfully transferred is deleted from the RawSpool/ directory 
and the transfer queue.

b) On radar-ana, if the analysis.sh script is invoked and the analysis is running (see page 
10), the analysis monitor looks for raw data files (see page 13), normally in the 
/home/RadarData/AcqSpool directory.  If the tag for a raw data file matches (including 
case) a “Experiment Tag Name” specified in the “Analysis Control” section, and that 
analysis is invoked, the raw data file will be analysed and the analysed results appended 
to the daily analysis file created in the /home/RadarData/AnalysedData directory.

If archiving is enabled, the raw data is appended to the archived data file(s) in the 
/home/RadarData/Archive directory. The raw data files are then deleted from the 
AcqSpool directory.

Further details about the /home/RadarData directories can be found in the `Radar system 
reference manual'.
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4.  DATA ANALYSIS AND DISPLAY SUITE

4.1  Introduction
The Data analysis and display suite proceeds under the control of the user by means of graphical 
user interfaces. The functionality of each component of the suite and their relationship is 
illustrated on the following page. The Analysis and Display Control Graphical User Interface 
(ADCG) provides the interface for the control of all data analysis and display, and is described on 
page 10. The "Analysis monitor" is responsible for the analysis of all incoming raw data, and is 
described on page 15. The "Postanalysis monitor" is responsible for the postanalysis of data 
produced by the analysis monitor, and is described on page 15. The suite is designed in such a 
way that new analyses and their corresponding display modules may be added to the software 
suite in a modular, seamless manner, thus allowing users and third party software authors to add 
their own code to the ATRAD suite without recourse to the manufacturer.  To further this aim, the 
entire analysis and display suite is coded with the use of RSI’s Interactive Data Language (IDL), 
thus allowing non-professional programmers the means to create their own program modules.

In order to achieve independence between the three components of the suite, each component 
executes within its own IDL session. The display IDL session is invoked only whenever the user 
requests the display session. The analysis and postanalysis IDL sessions execute in the 
background and are usually only invoked when the host computer boots. Each IDL session records 
routine logging messages and error conditions to its own log file located in the 
/home/radar/analysis/log directory.  Additionally, more serious errors are logged using the 
system logger program.

The "Control" directory is used as a common directory for communications between the three IDL 
sessions. The control files and their purpose are described in `Control files used by the analysis
and display suite'. These files include the analysis “configuration files”, which instruct the analysis 
monitor about which raw data files should be analysed and which particular analysis should be 
used, and the postanalysis configuration files, which instruct the postanalysis monitor about which 
analysed data files should be postanalysed and which particular postanalysis should be used. 

The "Data directory" hierachy contains all data used by the suite. The directories are specified in 
terms of environment variables. The settings for these environment variables can be found in the 
file /home/radar/analysis/lib/analysisvars. The solid lines in the diagram indicate "active" 
file operations , such as data transfer between the data directories and the configuration of 
analysis and postanalysis configuration files. The dashed lines indicate “passive” or read-only file 
operations. For instance, the analysis and postanalysis configuration files can be configured by 
the ADCG, but can only be read by the analysis and postanalysis monitors.

The following sections describe the analysis and display control interface and the analysis and 
postanalysis monitor programs.  Following these are sections describing the analysis and/or 
display modules provided with this radar system. 
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4.2  Analysis and Display Control Interface

4.2.1  Description
The Analysis and Display Control Graphical User Interface (ADCG) is used to configure and enable 
the various installed data analysis and postanalysis modules as well as invoke their corresponding 
displays.  The ADCG is invoked by clicking the ATRAD logo with the label “Analysis” located in the 
on-screen menu bar on the right of the screen. Only one instance of the ADCG may be invoked at a 
time.  The ADCG master window will appear showing a set of menu headings across the top of the 
window and a number of informative labels and graphs within its main body.

On invocation, the ADCG firstly determines the installed analysis, postanalysis and display 
modules. Those modules present appear under the pull down menu headings “Analysis Control”, 
“Postanalysis Control” and “Display Control”.  Secondly, the ADCG checks which control files are 
present and configures the relevant pull down menu labels to reflect the current analysis state. 
This state is preserved from one incarnation of the ADCG to the next. Once invoked, the ADCG 
monitors the data spool directories (SPOOL_DIR and ANSPOOL_DIR) for newly acquired data sets 
and reflects any changes in four ways. First, the file name of the latest raw data set appears in the 
title bar of the ADCG window. Second, the time stamp of the latest data set (assuming that it is 
the latest acquired) appears in the “Latest Acquired Data Set” field. Third, the number of raw 
data sets awaiting analysis in the analysis queue is reported in the “Number of Analysis Queued 
Data Sets” field, and fourth, the number of analysed data sets awaiting postanalysis in the 
postanalysis queue is reported in the “Number of Postanalysis Queued Data Sets” field. Note that 
the last two fields are also updated as older data sets are processed and disappear from the 
queue.

The Analysis and Display Control Interface

The complete list of diagnostic information included in the ADCG window below the menu bar 
includes:

● The analysis monitor status

● The time at which the most recent data set was acquired (radar time stamp).

● The number of raw data sets awaiting analysis in the acquisition spool directory 
(SPOOL_DIR).

● The number of analysed data sets awaiting analysis in the analysed spool directory 
(ANSPOOL_DIR).

● The time at which the last analysis cycle began (computer system time).

● The time at which the last analysed data set was acquired (radar time stamp).

● The time taken for the last analysis cycle (seconds).
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● The amount of free time between analysis cycles - the latency time (seconds).

● A measure of the analysis load on the CPU’s time.

● The percentage of disk space consumed by the disk partition containing the raw data 
spool.

● The percentage of disk space consumed by the disk partition containing the raw data 
archive (only displayed if on a different partition to the raw data spool).

Used disk space and analysis CPU load are indicated as percentages with the use of bar graphs. 
When the occupied disk space reaches 75%, the bar graph changes from green (ok) to yellow 
(warning).  If the amount of disk space used reaches 90%, the bar graph changes colour to red 
(critical).  For the analysis load bar graph, the “warning” and “critical” thresholds are also 75% 
and 90% respectively.  If the analysis load exceeds 100%, acquired data sets will accumulate in 
the acquisition spool directory more rapidly than the analysis session can process them. 
Ultimately, this may result in the radar controller hard disk filling with raw data at which point 
the system will cease collecting new data.

Pull down menus are provided with headings “File”, “Analysis Control”, “Postanalysis Control”, 
“Display Control”, “Utilities”, “Options”, and “Help”. The “File” menu gives the user control over 
the execution of the analysis session.  At boot time, a Unix script called analysis.sh is 
automatically invoked to start the analysis IDL session. If the analysis session exits for any reason 
(such as a user-requested termination, or if an error is encountered) the Unix script resumes 
execution.  Since the analysis.sh script places the statement invoking the analysis IDL session 
inside an endless loop, the analysis session is restarted a short time after it exits. This is always 
true unless the user-requested termination control file is present in the control directory. Upon 
invocation, the analysis script calls a script called postanal.sh which handles the postanalysis 
IDL session in the same manner as the analysis script handles the analysis session. The functions 
of the ADCG “File” menu are interpreted as

“Invoke Analysis Script”: Spawn the analysis script analysis.sh.  This will 
subsequently restart the analysis and postanalysis IDL 
sessions and spawn the postanal.sh script.

“Start Analysis Session”: Instruct the analysis script to remove the .terminate 
control file and restart the analysis and postanalysis IDL 
session.

“Stop Analysis Session”: Instruct the analysis and postanalysis IDL sessions to exit 
and not restart until instructed to restart, or the system is 
rebooted.

“Pause Analysis Session”: The analysis and postanalysis sessions cease processing 
data files until the user instructs it to continue using the 
“Unpause Analysis Session” menu entry, or terminates the 
sessions using the “Exit Analysis Session” menu entry.

“Unpause Analysis Session”: Instruct the analysis and postanalysis sessions to continue 
processing data files.

“Analyse Archived Data”: Instruct the analysis and postanalysis IDL sessions to 
apply all configured analyses to a nominated archived raw 
data file.

“Exit”: Close the ADCG and all associated display windows.

The ADCG frequently checks to see if the analysis IDL session is still running, and sets the 
analysis status indicator and sensitises the analysis session invocation and termination pull down 
menu options appropriately.

The “Analysis Control” menu allows the user to instruct the analysis IDL session to “Invoke”, 
“Disable”, or “Configure” any of the available analysis modules.  The current status of each 
analysis is also reported.  The possible states of an analysis are: Running, Halted - Error, and 
Not Selected.  These three states are explained in the analysis monitor description on page 15. 
The “Configure” option launches a configuration utility allowing the user to configure the analysis 
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to their own specifications. This facility allows a particular raw data file to be analysed by a 
number of different analyses, and by the same analysis in a different configuration. The 
configuration utility is described on page 13. The “Postanalysis Control” menu allows the user the 
same functionality for the postanalysis IDL session as the “Analysis Control” menu does for the 
analysis IDL session.

The “Display Control” menu allows the user to launch any of the display programs installed - only 
one instance of each is allowed.  If additional analysis or display modules are installed after the 
ADCG has been invoked, then they will not be accessible from the ADCG until it is restarted. Note 
that the settings of any display widgets are not retained from session to session.

The “Utilities” menu provides the “Housekeeping Utility”, allowing the experiment parameters of 
raw data files to be viewed, and the "Data Management Utility", allowing analysed data to be 
backed up to a portable medium. If the ADCG is configured for offline use, the “Analysis utility”, 
allowing analysis of archived raw data files, and the “Postanalysis utility”, allowing postanalysis of 
analysed data files, will also be available from the “Utilities” menu.

The “Options” menu allows the user to specify acquired data set handling and display program 
options.  “Analysis Mode” specifies whether the analysis should be performed on all acquired 
data-sets in temporal order (“Queued”) or only on the latest data-sets (“Real Time”).   “Data 
Management” provides several options allowing the user to specify how data should be archived. 
“Archiving” specifies whether data is to be archived (“Invoked”) or deleted (“Disabled”) after 
analysis and postanalysis.  “Archiving Period” specifies the duration for each archived data-set if 
data archiving is set. The “Archiving utility” allows more sophisticated archiving options to be 
selected, and is described in section 4.6. The Archiving utility can be invoked by choosing the 
“Invoke”, and disabled by selecting “Disable”. Note that data archiving is automatically disabled 
when the percentage of disk space consumed by the disk partition containing the raw data archive 
exceeds 95%. The “archiving monitor” allows the user to specify how long archived data files are 
kept on the file system, and is described in section 4.7. The archiving monitor can be invoked by 
choosing the “Invoke”, and disabled by selecting “Disable”.  “Flush Analysis Queue” performs 
removal of queued raw data-sets awaiting analysis, while “Flush Postanalysis Queue” performs 
removal of queued raw data-sets waiting postanalysis. If the ADCG is configured to discard data-
sets after analysis and postanalysis rather than archiving them, flushing the queue results in 
permanent data loss over the duration of the queue. “Color Table” specifies the color table to be 
used for all display module image plots. If the ADCG includes the interference removal utility (see 
section 4.8), “Interference Removal” allows control of this feature via a submenu: it can be started 
by choosing the “Invoke” item stopped by choosing the “Disable” item and configured by choosing 
“Configure”. “Raw Data Transfer” enables the transfer of raw data files to remote computers as 
described in section 4.9. Raw data transfer can be invoked by choosing “Invoke”, disabled by 
selecting “Disable” and configured by choosing “Configure”. If the ADCG is configured for remote 
configuration, the “Remote Configuration” menu will also be available from the “Options” menu. 
This allows the user to configure remote on-line analyses and postanalyses.

Finally, the “Help” pull down menu allows the user to obtain version information for the software 
and to display the on-line manual page.

4.2.2  Keyboard Accelerators
Two keyboard accelerators are available with the ADCG. These are:

<ALT>-X Exit the ADCG (and all display widgets).

<ALT>-H Display the on-line manual page.
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4.3  Configuration Utilities

4.3.1  Description
All analyses and postanalyses have configuration utilities installed, and each utility allows the user 
to provide parameters relevant to the analysis concerned. Pull-down menus are provided with the 
headings "File" and "Help". Below the menu bar are left and right arrows allowing the user to 
scroll through the existing configurations. The index of the currently displayed configuration and 
the total number of configurations is indicated between the arrow keys. The "File" menu contains 
the options "Save Changes", "Add Configuration", "Copy Configuration" and "Remove 
Configuration". The "Save Changes" option allows the 
user to save any changes made to any of the currently 
defined configurations. "Add Configuration" allows 
the user to add a new configuration, while "Copy 
Configuration" allows the user to copy the currently 
displayed configuration to a new configuration. The 
"Remove Configuration" option removes the currently 
displayed configuration. The “Help” pull down menu 
allows the user to obtain information on the use of the 
configuration utility. As an example, the configuration 
utility for the FCA analysis is displayed on the right.

The configuration utilities allow the user to nominate 
the experiment tag name the raw data should possess 
in order for the analysis to process the file, and the 
analysed data tag name to append to the data file that 
the analysed data are to be written to. Similarly, the 
postanalysis configuration utilities allow the user to 
nominate the analysed data tag name the analysed 
data should possess in order for the postanalysis to 
process the file, and the postanalysed data tag name 
to append to the data file that the postanalysed data 
are to be written to. Other configuration options are 
analysis- and postanalysis-specific, and are 
documented in the on-line help accessed from the 
“File” pull-down menu. The postanalysis configuration 
utilities contain time fields which the postanalysis 
monitor uses to determine when a particular 
postanalysis should occur and which analysed data-
sets it should use: the “processing interval”, “offset”, 
and “duration”. The processing interval specifies the 
interval between successive invocations of a 
particular postanalysis. The offset specifies the offset from the multiple of the processing interval 
for the postanalysis to be performed. The processing duration specifies the duration of data to use 
for the postanalysis. The “Processing Interval Multiple” specifies whether the postanalysed data 
should have time stamps with “Integer” or “Integer + 0.5” multiples of the processing interval.  

The "Experiment tag" field in any analysis configuration can include one wildcard character, 
specified by "*". For instance, if the experiment tag for a particular analysis is set to "dbs7*", all 
data whose experiment tag includes the string "dbs7" will be analysed according to this 
configuration entry. This also applies to the "Analysed data tag" field in any postanalysis 
configuration utility.

Additionally, the "hyphen" character "-" can be used in the analysed data tag field of the analysis 
configuration utility to specify that the analysed data tag should be set to experiment tag, and in 
the postanalysed data tag field of the postanalysis configuration utility to specify that the 
postanalysed data tag should be set to the analysed data tag.

Additionally, the analysed data tag field of the analysis configuration utility and the postanalysed 
data tag field of the postanalysis configuration utility allow the results from a single analysis or 
postanalysis to be written to two different analysed or postanalysed data files. This is achieved by 
specifying the required tags sepeated by a comma. This facility is of use if the user requires that 
data from the analysis of two different experiment tags (e.g. low_mode and high_mode) are to be 
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written to both individual (e.g. low_mode and high_mode), and combined (e.g. "both_modes") 
analysed data tags. In this case, the analysed data tag specified for the experiment tag 
"low_mode" will be set to "low_mode,both_modes", while the analysed data tag specified for the 
experiment tag "high_mode" will be set to "high_mode,both_modes".

Furthermore, the "hyphen" character "-" can be used in the analysed data tag field of the analysis 
configuration utility to specify that the analysed data tag should be set to experiment tag, and in 
the postanalysed data tag field of the postanalysis configuration utility to specify that the 
postanalysed data tag should be set to the analysed data tag.

The configuration information is stored in IDL savefiles in “/home/radar/analysis/control.”

The configuration options available depend upon which control files are present. Information on 
the control files used by the analysis and display suite are provided in `Control files used by the
analysis and display suite'. Configuration options dependent on the presence of control files 
include specification of height/range limits, sea scatter removal, extra coherent integrations, 
processing intervals and durations, and analysis specific thresholds. If the analysis and display 
suite is configured for a radar system allowing interleaved polarisation, all analysis configurations 
(except DAE) allow the selection of the appropriate mode for analysis.

4.3.2  Keyboard Accelerators
Three keyboard accelerators are available with the configuration utilities. These are:

<ALT>-W Exit the configuration utility. 

<ALT>-H Display the on-line manual page.

<ALT>-S Save the configuration
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4.4  Analysis Monitor

4.4.1  Description
The Analysis Monitor is designed to poll for the arrival of newly-acquired raw data files, and then 
to sequentially invoke each installed and enabled analysis module once the presence of a new data 
set is detected.  The analysis monitor executes within its own IDL session, and is configured 
through the use of configuration files written to the “Control” directory.  Each configuration file 
may contain one or more configuration, allowing each raw data file to be analysed by each 
analysis in a number of different manners.

Upon the arrival of new data in the raw data spool directory (SPOOL_DIR), the analysis monitor 
reads the raw data and the experiment parameter information from the data file, checks which 
analyses are enabled, and looks for a configuration file for each of these analyses. The 
configuration information includes the experimental tag name on which the analysis should run, 
the analysed data tag name for the output data file, and information regarding how the analysis 
should be applied. Configurations for each analysis are defined with the use of the corresponding 
configuration utility (if installed), as described on page 13. If a configuration file exists, and any of 
the configured experiment tags match the experiment tag of the raw data file, the raw data, 
experiment parameter information and the configuration information are passed to the analysis 
module for analysis. If a configuration file is not found, the enabled analysis is called once and is 
analysed using the default setup for this analysis.

The analysed data is then written to file. For COVF and SPEC analyses, the data is written to the 
ANSPOOL_DIR directory, where it is spooled for postanalysis. The filename convention is

[year][month][day]-[hour][minute]_[analysed data tag].analysis,

where [year] is a four character field, [month],  [day], [hour], and [minute] are two character 
fields, the analysed data tag is specified in the analysis configuration utility, as described on page 
13, and "analysis" is the analysis type (covf or spec).  For the remaining analyses, the data is 
appended to daily files within the ANALYSED_DATA directory with filename convention 

[year][month][day]_[analysed data tag].analysis.

Once the analysis cycle has been completed for the current data set, the raw data file is either 
archived into the ARCHIVE_DIR (which may be specified as a mass storage device) or removed 
from the file system. The archived data filename convention is

[year][month][day][hour]_[experiment tag].raw,

where hour is a multiple of the "archival period", which is configured from the “Options” menu of 
the ADCG as described on page 10. Once the now-analysed raw data file has been dealt with 
appropriately, the analysis monitor waits for the arrival of the next data set.

At the beginning of each pass through the analysis cycle, the analysis monitor checks for files 
within the control directory corresponding with the installed analysis. Thus, it is not necessary to 
restart the analysis monitor after installing new analysis modules, nor after enabling an existing 
analysis module from the ADCG.  This behaviour contrasts with that of the ADCG, which must be 
restarted after installing new analysis and/or display modules.

In the event of an analysis module continually producing an error, the analysis monitor 
automatically disables that analysis and records the details of the module’s faulty nature in the log 
file.  This functionality is intended to prevent faulty third party analysis modules from adversely 
affecting execution of more stable analyses.

From version 4 onwards, the analysis monitor allows analyses other than DAE to be applied 
interleaved polarisation data.

4.5  Postanalysis Monitor

4.5.1  Description
The Postanalysis Monitor is designed to schedule the postanalysis of analysed data produced by 
the analysis monitor. After the analysis monitor has completed the analysis of each raw data file, a 
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control file is produced containing the timestamp of the latest analysed raw data set. The 
Postanalysis Monitor detects this file, and uses the timestamp information together with the 
configured invocation times for each installed postanalysis to determine whether any of the 
postanalyses should be invoked. The postanalysis monitor executes within its own IDL session, 
and is configured through the use control files.

Upon detecting the timestamp control file, the postanalysis monitor checks which postanalyses 
are enabled, and looks for a configuration file for each of these postanalyses. The configuration 
information includes the analysed data tag name on which the postanalysis should run, the 
postanalysed data tag name for the output data file, scheduling information, and information 
regarding how the postanalysis should be applied. The scheduling information is specified by the 
“processing interval”, “processing offset”, and “data duration”. The "processing interval" specifies 
the interval between successive invocations of a particular postanalysis. The "processing offset" 
specifies the offset from each [integer + half] multiple of the processing interval for the 
postanalysis to be performed. The "data duration" specifies the duration of data to use for the 
postanalysis. The scheduling process is illustrated on the following page. Some postanalyses (e.g. 
VEL) can be configured to be called at the completion of every experiment cycle. This facility can 
for instance be used to apply VEL postanalysis to the DBS analysed data obtained over a complete 
sysle of beam directions.

Each postanalysis is defined with the use of the corresponding configuration utility, as described 
on page 13. If the scheduling information for any enabled postanalysis indicates the postanalysis 
should be performed, the appropriate analysed data is read from file, and the analysed data, 
experiment parameter information and the configuration information are passed to the 
postanalysis module for postanalysis. 

For postanalyses producing postanalysed data, the data is then appended to daily files within the 
ANALYSED_DATA directory with filename convention

[year][month][day]_[postanalysed data tag].postanalysis,

where [year] is a four character field, [month] and [day] are two character fields, and 
"postanalysis" is the postanalysis type.

Once the postanalysis cycle has been completed, any spooled COVF or SPEC analysed data not 
required for subsequent postanalysis is either archived into the ARCHIVE_DIR (which may be 
specified as a mass storage device) or removed from the file system. The archived data filename 
convention is

[year][month][day][hour]_[analysed data tag].suffix,

where [hour]is a multiple of the "archival period”  configured from the “Options” menu of the 
ADCG as described on page 10, and suffix is the suffix of the spooled data in question (“covf” or 
“spec”). The postanalysis monitor then waits for the arrival of the control timestamp file.

In the event of a postanalysis module continually producing an error, the postanalysis monitor 
automatically disables that postanalysis and records the details of the module’s faulty nature in 
the log file.  This functionality is intended to prevent faulty third party postanalysis modules from 
adversely affecting execution of more stable postanalyses.
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Example of the scheduling process and data requirements used by the postanalysis monitor

ATRAD
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4.6  Archiving Utility

4.6.1  Description
The archiving utility (AU) allows the user to specify how analysed raw data files and postanalysed 
spectra, covariance function, and AOA files should handled on the completion of their 
analysis/postanalysis. Archiving of range subsets of raw data files can also be selected. 

The AU allows the use to specify which tags and data types should be archived. The tag can be 
specified in the "Tag Name" field, while the data type can be chosen by enabling the appropriate 
selection from the "Raw Data", "Spec Data", "Covf Data" and "AOA Data" fields. For instance, if 
archiving of raw data with tag "fca" and is required, the user would enter "fca" in the "Tag Name" 
field, and enable "Raw Data". If archiving of raw and spectral data with the tag "pmse" is 
required, the user would enter "fca" in the "Tag Name" field, and enable "Raw Data" and "Spec 
Data". The archiving period can be selected using the "Archiving Period" slider.

The AU also allows the archiving of a range subset of a raw data file. The user can select this 
option by enabling the "Raw Data Range Subset" field. This allows selection of the start and end 
ranges of the range subset (from the "Archiving start range" and "Archiving end range" fields), 
and the tag name to use for archiving ("Archived Data Tag" field). Note that one raw data file can 
be archived in full byselecting "Raw Data Archiving", and archived as a range subset by selecting 
"Raw Data Range Subset". It is recommended that the "Archived Data Tag" field is not set to the 
same value as "Tag name", as this will result in two different data-sets being written to one 
archived data file if "Raw Data Archiving" is also selected.

The AU can be configured by selecting "Options|Data Management|Archiving Monitor|
Configuration" from the Analysis and Display control GUI (ADCG). The AU is invoked by selecting 
"Options|Data Management|Archiving Monitor|Invoke", and is disabled by selecting the "Options|
Data Management|Archiving Monitor|Disable" option. The "Invoke" option  is only available if the 
AU has been configured. 

If the AU is invoked, it is called once analysis (postanalysis) of a raw (spec, covf or AOA) data file 
is complete. The AU checks the data archiving configuration settings to determine whether the 
data tag names match any of the values specified "Tag" field. If this is the case, the data is 
archived if the corresponding data type is enabled, and is deleted otherwise. If the AU is invoked, 
the AU configuration overrides the default archiving ("Options|Data Management|Archiving") and 
archiving period ("Options|Data Management|Archiving Period") settings. If the AU is disabled, 
archiving reverts to that specified by the default archiving and archiving periods.

The following describes some applications of the AU:

1. In the case where the user requires all raw data to be archived expect for a specific tag, 
this can be enabled by defining a configuration where the experiment tag is specified in 
the "Tag Name" field, and the "Raw Data" field is disabled. This can be useful for a meteor 
experiment, where raw data detection archiving can be configured in meteor analysis to 
save only the raw data for each detection.

2. In the case where a user wants to archive spectral or covariance function data rather than 
raw data, this can be enabled by defining a configuration where the required spec or covf 
data tags are specified in the "Tag Name" field, and the "Spec Data" or "Covf Data" field is 
disabled. This can provide a means of data compression for offline analysis in comparison 
to archiving raw data.

3. In the case where a user wants to archive only a specified range subset of a raw data file, 
this can be enabled by enabling the "Raw Range Data Subset" field and choosing the tag, 
and start and end ranges. This can provide a means of data compression for offline 
analysis.

4.6.1.1  Keyboard Accelerators
Only the "Close" and "Manual Page" options are accessible through keyboard accelerators. The 
appropriate keystrokes for these two options are <ALT>-W and <ALT>-H respectively.
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4.6.1.2  Log files
All use of the AU is logged to the file $ANALYSIS_DIR/log/display.log, while the resulting data 
analysis is logged to the file $ANALYSIS_DIR/log/analysis.log. Users should consult these files 
for further information on any problems observed using the AU or the analysis of the selected 
data.

For on-line Linux operation, the size of this file is controlled by "logrotate" as specified in the file 
/etc/logrotate.d/radarlogs.

Information about logrotate can be obtained from the command line using "man logrotate".

4.6.1.3  Files
The configuration file $ANALYSIS_DIR/control/.arch_util_config contains the configuration 
information.
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4.7  Archiving Monitor

4.7.1  Description
The archiving monitor (AM) allows the user to specify how long archived raw data, spectra, 
covariance function, and AOA files should be maintained in the archived data directory.

The AM allows the use to specify which tags and data types should be archived. The tag can be 
specified in the "Tag Name" field, while the data type can be chosen by enabling the appropriate 
selection from the "Raw Data", "Spec Data", "Covf Data" and "AOA Data" fields. For instance, if 
the user wishes to limit the amount of time  raw data with tag "fca" and is kept for, the user 
would enter "fca" in the "Tag Name" field, and enable "Raw Data". The data lifetime can be 
selected using the "Data Lifetime" slider.

The AM can be configured by selecting "Options|Data Management|Archiving Monitor|
Configuration" from the Analysis and Display control GUI (ADCG). The AM is invoked by selecting 
"Options|Data Management|Archiving Monitor|Invoke", and is disabled by selecting the "Options|
Data Management|Archiving Monitor|Disable" option. The "Invoke" option is only available if the 
AM has been configured.

If the AM is invoked, it is called at the commencement of each UT day, as determined from the 
timestamps of the data analysed by the analysis monitor. The AM checks the AM configuration to 
determine whether the existing archived raw, spectral, covariance function and AOA files match 
any of the values specified "Tag" field, and whether the appropriate data type is enabled. If this is 
the case, the data is deleted if it's age exceeds the corresponding value from the "Data Lifetime" 
field.

4.7.1.1  Keyboard Accelerators
Only the "Close" and "Manual Page" options are accessible through keyboard accelerators. The 
appropriate keystrokes for these two options are <ALT>-W and <ALT>-H respectively.

4.7.1.2  Log files
All use of the archiving monitor configuration is logged to the file 
$ANALYSIS_DIR/log/display.log, while the actions of the archiving monitor is logged to the file 
$ANALYSIS_DIR/log/analysis.log.

Users should consult these files for further information on any problems observed using the 
archiving monitor configuration and archiving monitor.

For on-line Linux operation, the size of this file is controlled by "logrotate" as specified in the file 
/etc/logrotate.d/radarlogs

Information on logrotate can be obtained from the command line using "man logrotate".

4.7.1.3  Files
The configuration file $ANALYSIS_DIR/control/.arch_mon_config contains the configuration 
information.
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4.8  Interference Removal
The interference removal procedure is based on the "sidelobe canceler", described in the paper 
"Adaptive Arrays" by S. P. Applebaum, IEEE Transactions on Antennas and Propagation, vol. AP-
24, No. 5, Sep. 1976, pp. 585-598. This technique is used to reduce the interference received 
through the sidelobes of a main antenna with a narrow antenna pattern using the signals received 
by multiple smaller antennas with near-isotropic antenna patterns. The correlation between the 
signals received on the large and smaller arrays is exploited to estimate the optimal linear 
combination of smaller array signals required to remove the interference received by the main 
array through the sidelobes.

In the current application, the same technique is used to remove interference correlated in range. 
The interference received at "secondary ranges" (i.e. ranges containing interference only) is used 
to remove the interference observed at the "primary ranges" (i.e. those ranges containing the 
desired atmospheric signal) by determining the correlation between signals in the primary and 
secondary ranges.

Interference removal can be configured by selecting "Options|Interference Removal|
Configuration" from the Analysis and Display control GUI (ADCG). Interference removal is invoked 
by selecting "Options|Interference Removal|Invoke", and is disabled by selecting the "Options|
Interference Removal|Disable" option.

If interference removal is invoked, it is called by the analysis immediately after each raw data file 
is read in. The analysis checks the configuration settings to determine whether the data tag 
names match any of the values specified "Experiment Tag" field. If this is the case, interference 
removal is applied.

The interference removal technique is applied to each receiver separately. The power spectra are 
calculated at each range to produce a range-Doppler (RD) spectrum. In order to determine the 
correlation between signals in the primary and secondary ranges it is necessary to preclude any 
"desired" (i.e. non interfering signal) from the correlation estimate. This is achieved using a 
normalisation technique whereby the spectral values at each Doppler are divided by the median 
value over all ranges, and the spectral values at each range are divided by the median value over 
all Dopplers to produce a "whitened" RD spectrum. The whitened spectrum shows only the 
desired signal, allowing the range-Dopplers of the desired signals to be estimated, and the 
corresponding spectral values set to zero to preclude their use in the correlation estimates. In the 
ideal implementation of this technique the secondary ranges should contain only interference. If 
this is not the case, it is possible that correlation between the signals observed in secondary and 
primary ranges can result in some signal cancellation in the primary ranges, or signal from one 
range being copied into other ranges. Fortunately, the whitening technique described above 
presents some protection against this effect. This is supported by the fact that no cases of signal 
cancellation has been observed in the development of the current interference removal algorithm. 
To further guard against this possibility, the user can indicate whether there may be possible 
atmospheric signal in the secondary ranges.

Despite this, it is recommended that ranges where the least amount of desired is expected are 
selected as the secondary ranges. For MF radar systems, secondary ranges below 50 km are 
optimal, but secondary ranges between 50 and 60 km should be adequate. For tropospheric VHF 
systems, secondary ranges above 20 km are desirable. For mesospheric VHF systems, ranges 
between 65 and 75 km are desirable, bearing in mind that PMSE and meteors (PMWE) are usually 
observed are ranges above (below) this. For meteor systems, the technique is not recommended 
for radars operating with PRFs above 100 Hz. This is because meteors can be range aliased and 
appear at any range, so that no secondary ranges can be selected which contain only interference.

The interference removal procedure is called by the analysis. If the tag of the raw data file to be 
analysed matched any of the tags setup in the interference removal configuration, interference 
removal is applied to produce "cleaned" data (i.e. Data with any interference removed). The 
analysis can then be performed using the "cleaned" data, or the cleaned data can be written to a 
new raw data file which can be analysed. 

The interference removal procedure can be configured using "Options|Interference Removal" 
from the "Options" menu of the analysis and display control GUI (ADCG). The use has the ability 
to set the following options:
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● Experiment tag: the experiment tag of the raw data files that the interference removal 
procedure is to be applied to. 

● Secondary Data Start Range: the lowest range to be used for secondary data

● Secondary Data End Range: the largest range to be used for secondary data

● Spool interference removed data: instructs the analysis what to do with the "cleaned" 
data. If this is set to "Invoke", the analysis analyses the "uncleaned" data, and writes the 
"cleaned" data to a new file in the directory specified by the SPOOL_DIR environment 
variable, where it will then be spooled for analysis. This allows the use to analyse both 
"cleaned" and "uncleaned" data to assess the effectiveness of the interference removal 
procedure, and also to archive the "cleaned" raw data to an archived data file.

● Cleaned data tag: the experiment tag of the raw data file containing the cleaned data.

● Allow for atmospheric signal: allows the user to indicate that there may be some 
atmospheric signal in the secondary data. If this is set, the interference removal 
procedure checks whether the signal characteristics match those of an atmospheric 
signal, and precludes this data from the correlation procedure to avoid cancellation of this 
signal

● Frequency range: the one-sided frequency range over which the atmospheric signal is 
expected. For example, if atmospheric signal may occupy the frequency range +/- 0.2 Hz, 
this value should be set to 0.2.   

The optimal values for the interference removal procedure can be tested using the "Interference 
Removal" option from the "Options" menu of the raw data display module, which can be selected 
from the "Display Control|RAW Display" option of the ADCG. It is highly recommended that the 
user tests their intended settings using the raw data display to verify their values are sensible.

4.8.1.1  Keyboard Accelerators
Only the "Close" and "Manual Page" options are accessible through keyboard accelerators. The 
appropriate keystrokes for these two options are <ALT>-W and <ALT>-H respectively.

4.8.1.2  Log files
All use of the interference removal configuration utility is logged to the file 
$ANALYSIS_DIR/log/display.log.

Users should consult this file for further information on any problems observed using the 
interference removal configuration utility.

4.8.1.3  Files
The interference removal configuration information is written to the file 
$ANALYSIS_DIR/control/.interf_removal_config.
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4.9  Raw data transfer
The Raw Data Transfer configuration utility allows the user to transfer spooled raw data files to a 
remote location. Specifically, the utility allows the user to select which experiment tags to use, the 
remote IP address and directory to which the data is to be transfered. The IP address requires an 
entry in the radar user's ".netrc" file with the username and password for ftp for use (see Remote
file transfer issues). 

The Raw Data Transfer configuration utility allows raw data files to be transfered to multiple 
sites. Additional configurations are composed by choosing the "Add Configuration" or "Copy 
Configuration" options under the "File" menu. "Add Configuration" allows the user to configure a 
new Raw Data Transfer, while "Copy Configuration" allows the user to copy the currently 
displayed postanalysis configuration and reconfigure it. Unwanted configurations may be deleted 
with the "Remove Configuration" option. Different configurations may be examined one at a time 
by clicking on the left and right selection buttons near the top of the window. 

Raw data transfer can be configured by selecting "Options|Raw Data Transfer|Configuration" from 
the Analysis and Display control GUI (ADCG). Raw data transfer is invoked by selecting "Options|
Raw Data Transfer|Invoke", and is disabled by selecting the "Options|Raw Data Transfer|Disable" 
option.

4.9.1.1  Keyboard Accelerators
Only the "Close" and "Manual Page" options are accessible through keyboard accelerators. The 
appropriate keystrokes for these two options are <ALT>-W and <ALT>-H respectively.

4.9.1.2  Log files
All use of the Raw Data Transfer configuration utility is logged to the file 
/home/radar/analysis/log/display.log, while the Raw Data Transfer is logged to the file 
/home/radar/analysis/log/ftp_transfer.log.

Users should consult these files for further information on any problems observed using the Raw 
Data Transfer configuration utility and Raw Data Transfer.

4.9.1.3  Files
The raw data transfer configuration information is written to the file 
$ANALYSIS_DIR/control/.pft2_config.
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4.10  Installable Software Modules

4.10.1  Introduction
The existence of a particular software module within the ATRAD Analysis and Display suite (ADS), 
be it an analysis, postanalysis or a display module, is dependent upon which modules are compiled 
into the IDL savefiles used by the ADS. Some analysis and postanalysis modules may be installed 
without a corresponding display module (e.g. AFT and PFT postanalyses).  Additionally, not every 
display module need have a corresponding analysis or postanalysis module (e.g., the raw data 
display module).  Installation of new modules requires the generation of a revised savefile with 
the appropriate modules compiled in. Alternatively, third party analysis modules may be included 
into the suite. The `Coding New Software Modules' section, gives some brief information 
concerning coding third party analysis modules. Once installed, a new analysis module will be 
recognised by the ADCG on its next invocation by the user, and must then be enabled via the 
ADCG before the analysis monitor will execute it.

4.10.2  The Raw Data Display Module

4.10.2.1  Description
The raw data display module (RDDM) is a compound widget which allows the user to display 
acquired radar data in one of several different statistical forms. These display formats include 
displaying data as time-series of data samples (as in-phase and quadrature components), as 
spectra, correlation functions, in-phase and quadrature components histogram and ball-of-wool 
plots, and power profile plots. Time-series and spectra may also be displayed as stacked or image 
plots. The raw data display module can also display spectral or covariance function data produced 
by SPEC or COVF analyses.

The widget is divided into six main areas. At the top of the widget is the motif-style pull-down 
menu, which provides access to all functionality. The menu headings are "File", "Format", "View",  
"Options", and "Help". The currently selected menu options indicated by an arrow in many cases.

The data set required for display can be selected from the "View" menu. Options include the most 
recent data-set (Latest data mode), data awaiting analysis in the analysis queue (Queued data 
mode), and archived data sets (Archived data mode). In latest data mode the widget automatically 
updates the display of latest data to arrive in the queue if the experiment tag matches the selected 
tag. In latest and queued data mode the user is able to select the experiment tag of the data to be 
displayed using the "Select Experiment Tag" option from the "View" menu. Selecting this option 
launches a widget allowing the selection of any of the available experiment tags. The "All tags" 
option allows data with any tag to be displayed, while the "Current Tag" option allows data with 
the same tag as the current experiment tag to be displayed. On selecting archived data mode the 
user is able to browse through the file system and select archived raw data files for display. 

Immediately below the menu bar appears the time selection thumbwheel slider. In archived data 
mode, this slider provides access to data records from various acquisitions within the file. In 
queued data mode, the slider provides access to different data files within the queue. The time of 
the data currently selected for display is centered immediately above the time slider. In queued or 
archived data mode the start and end times are also shown immediately above the slider on the 
left and right hand sides, respectively.
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The Raw Data Display Module

For multiple receiver channel systems a set of receiver channel selection buttons appear below 
the time selection slider. Different channels may be displayed on-screen by clicking on the 
appropriate channel selector button. Up to 16 channels may be displayed simultaneously - 
unavailable channels are not selectable and have a "grey" appearance. The "Combine" button 
combines the data from all selected channels into a single channel. If a receiver calibration record 
is contained in the raw data-set this information is used to correct any complex receiver gain 
differences in each channel prior to combining. The "All" button allows the display of all available 
channels. If all available channels are already selected, the "All" button resets the channel 
selection so only the first channel is selected.

At the bottom of the widget appear the vertically-oriented range selection slider and, to the right 
of the range slider, the display window itself. In all display formats besides stacked,  image, and 
power profile plots the data sampled from various ranges are selectable by the range slider. The 
range currently selected for display appears above the slider and is scaled in units of kilometres. 
If the slider is moved while the mouse button remains depressed, the range label is updated 
without updating the display. The display is then updated when the mouse button is released.

The display format can be selected from the "Format" menu. Data are displayed in various colors 
depending on the properties of the data concerned. For Cartesian time series and amplitude 
distribution display formats the in-phase data are displayed using a light blue shade, while the 
quadrature data are shown in red. For display formats in polar form the magnitude is shown in 
yellow while the phase is shown in green. In these cases the "tick marks" for the two axes are 
keyed by means of the corresponding color. Display formats where the data is displayed as a 
single component (e.g. Power spectra) are displayed using the light blue shade. The color scheme 
is extended for display of data from multi-mode experiments, where one of the experimental 
parameters is modified on a point-to-point basis throughout the record (e.g. beam direction, 
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polarisation mode, and transmission frequency). In all cases, information on the data component 
being displayed appears at the bottom left and/or the right of the display window and is keyed by 
the appropriate color.

The "Options" menu provides control over many features of the displayed data, including scaling 
of both axes (in some cases), and the size of the informative labels included with the display. In 
addition, the user may elect to display or hide arbitrary components of the data. For example, the 
user can configure the widget to plot only the quadrature component of the time series and ignore 
the in-phase component. Many of the display formats also support panning of the display once the 
ordinate axis scale has been expanded. This allows the user the magnify sections of the display 
not situated near the display origin.

Sea echo removal may be configured using the "Sea Scatter Removal Utility", which can be 
invoked from the "Sea Scatter Removal" option of the "Options" menu. The Sea Scatter Removal 
Utility is available from the "Help" menu of the Sea Scatter Removal Utility, and is also described 
in the Sea Scatter Removal Utility section below.

If provided, interference removal may be configured using the "Interference Removal Utility", 
which can be invoked from the "Interference Removal" option of the "Options" menu. The 
"Interference Removal Utility" manual page is available from the "Help" menu of the 
"Interference Removal Utility", and is also described in the Interference Removal Utility manual 
page (see section 4.8).

Hardcopies of the display can be obtained by selecting the "Print" option under the "File" pull 
down menu heading. This invokes the "Print Utility", allowing the current plot to be either be 
saved to file in any of a number of different formats, or sent to any nominated print queue along 
with any additional command line options to "lpr".

The default display on invoking the RDDM can be selected by choosing the "Set Display as 
Default" option from the "File" menus once the required parameter and display format has been 
selected. This saves the default parameters to a savefile which is restored on invocation of the 
RDDM. If a default parameter savefile does not exist, the default display on invocation is 
Cartesian time-series display in latest data mode. If a default parameter savefile exists, the default 
display can be returned to Cartesian time-series display in latest data mode by selecting the 
"Delete Default Settings" from the "File" menu.

4.10.2.2  Keyboard Accelerators
Many of the pull-down menu options are accessible from the keyboard with the use of <ALT>-
<single key> combinations. For example, the File menu options can be accessed using <ALT>-P 
to invoke the Print Utility, <ALT>-S to save the current display options as default, <ALT>-K to 
revert to the default options, and <ALT>-W to close the widget. In addition, the user may use 
<ALT>-L to quickly display the latest data set acquired, <ALT>-Q to access queued data sets, and 
<ALT>-A to allow the selection of archive data sets. In latest data mode, the <ALT>-T option can be 
used to change the experiment tag to be viewed. The Sea Scatter Removal Utility can be invoked 
using the <ALT>-E option. This manual page may be displayed by pressing <ALT>-H.

Of particular use are the keyboard accelerators used for changing the scaling of the various data 
displays. The up and down arrows control the scale of the abscissa axis for all plots other than 
stacked, image and ball of wool plots, and the display range for stacked and image plots. The left 
and right arrows control the scale of the ordinate axis, and the magnification of the ball-of-wool 
diagrams along both orthogonal axes. Abscissa panning for stacked and image plots is 
accomplished using up and down arrow key in combination with the shift key. Ordinate panning is 
accomplished with the use of the left/right arrow keys in combination with the shift key.

4.10.2.3  Resizing Facility
The raw data display module may be resized as desired.

4.10.2.4  Environment variables
ANALYSIS_DIR: The root directory of the analysis distribution.

ARCHIVE_DIR: The directory in which archived data are stored.
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SPOOL_DIR: The raw data file spool directory.

SUFFIX: The file name suffix stub to search for in the queue.

TMP: A temporary directory for spooling print jobs etc.

4.10.2.5  Files
RDDM usage is logged to the file "$ANALYSIS_DIR/log/display.log". Users should consult this 
file for further information on any problems observed using the RDDM.

For on-line Linux operation, the size of this file is controlled by "logrotate" as specified in the file 
"/etc/logrotate/radarlogs". Information on logrotate can be obtained from the command line 
using "man logrotate".

Savefiles of default parameters for use on invocation of RDDM are stored in 
"$ANALYSIS_DIR/control/.rddm_default".

The default filename for files produced by the "Print Utility" is "$TMP/rddm000.<ext>" where 
<ext> is the file extension appropriate to the file format.

4.10.2.6  Limitations
The data files in the queue must be ATRAD data format (ADF) files. This limitation is due to the 
way in which timestamps are extracted from queued files.

4.10.2.7  The Sea Scatter Removal Utility
The RAW data display sea scatter removal configuration utility allows the evaluation of the 
performance of different sets of parameter settings for sea scatter removal. This allows suitable 
parameters to be determined for analysis and postanalysis configurations.

The sea echo removal algorithm routine measures the ratio of the amplitudes of the sea echo peak 
to the maximum amplitude of the atmospheric echo component. (The atmospheric echo 
component is defined as that part of the frequency spectrum lying between, but not inclusive of, 
the positive and negative sea echo frequency bands.) The "Ratio limit" defines the threshold for 
determining whether the sea echo peak should be removed. If the actual ratio exceeds the ratio 
limit, the sea echo removal algorithm is applied. The "Frequency Notch Range" is the full-width 
frequency range (in Hz) over which the sea echo removal algorithm is applied. The "Start range" 
and "End range" define the ranges over which the removal algorithm is applied. The algorithm is 
applied inclusive of these end point ranges. The range of frequencies over which the notching is 
applied can be displayed for spectral plots by selecting the "Enable" option of "Display Frequency 
Notch Range". The dashed line denotes the sea scatter frequency, while the dotted line denotes 
the notching range.

The "Apply" and "Disable" buttons allow the algorithm to be applied and disabled, respectively. 
The "Save" button allows the currently configured parameters to be saved to a configuration file 
to be used whenever the sea scatter removal configuration utility is invoked. The "Close" button 
exits the utility.

On exiting the utility, the parameters used immediately prior to exiting are thereafter used for all 
raw data display formats.

4.10.3  The FCA Analysis Module

4.10.3.1  Description
The FCA analysis module embodies the full correlation analysis as described in “The Analysis of  
Spaced Sensor Records by Correlation Techniques”, by B. H. Briggs, Handbook for Middle 
Atmosphere Program, 13, pp 166 - 186, 1984.  A large amount of literature is available describing 
the FCA technique and its practical application to the analysis of radar data.  It is beyond the 
scope of this manual to describe the analysis itself, apart from such aspects as output data 
formats and the meanings of the various error codes produced.
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The FCA can be configured to store mean angles of arrival (MAOAs). This option allows the 
determination of "corrected vertical velocities", whereby the vertical velocity is corrected for 
leakage from the horizontal velocity due to non zero MAOAs, as described in "VHF radar 
measurements of in-beam incidence angles and associated vertical-beam radial velocity  
corrections", by. M. F. Larsen and J. Rottger, Journal of Atmospheric and Oceanic Technology,  vol 
8, 1991. As the MAOAs are affected by phase calibration errors, it is important that receiver 
calibration has been performed prior to analysis. Receiver calibration is described in Including
receiver calibration estimates in the analysis and display suite.

FCA analysis can  be configured to be performed using 3 or 4 antennas. For three antennas, the 
analysis is restricted to configurations where the angles between antenna baselines are all within 
30 to 90 degrees. For four antennas, the analysis is restricted to rectangular or Y- configurations, 
where the vector sum of the inner to outer spacings sum to zero. For alternative antenna 
configurations, the analysis will report that the antenna configuration is unsuitable for analysis. 

The FCA analysis can be configured to be applied over a limited height range, with extra coherent 
integration, and with access to additional analysis, as described in Control files used by the
analysis and display suite.

4.10.3.2  Analysed Data File Format
FCA analysed data are written to disk in a binary format.  Individual data files hold up to 24 hours 
of analysed data and are identified by the year, month, and day during which the data were 
recorded. During continuous data acquisition, each analysed data file begins at midnight, UTC. 
The FCA analysed data format is described in detail in Appendix C: ATRAD Analysed Data Format. 

4.10.3.3  Error Codes
The following table describes the types of error codes produced by the FCA analysis. Note that 
criteria 3, 5, and 10 may be reconfigured by the user if required by creating the appropriate 
control file, as described in Control files used by the analysis and display suite.

0 No error - analysis result ok.

1 Time series unsuitable for analysis (signal amplitude too low, or interference 
present)

2 Signal to noise ratio < -3 dB

3 Fading time > 6 s

4 At least one cross correlation function maxima lies outside end points 

5 Percentage time discrepancy > 35%

6 Vc
2 < 0

7 Ground diffraction pattern analysis breaks down

8 Apparent velocity magnitude Va > 400 ms-1 OR

True velocity magnitude Vt > 200 ms-1

9 Difference between apparent Va and true Vt direction exceeds 40 degrees.

10 Va > 10Vt

11 Vt > 1.5Va

12 Poor fit to cross-correlation function (CCF) maximum

13 At least one CCF maximum < 0.2

14 Poor zero-lag auto-correlation function (ACF) interpolation

15 Insufficient number of lags on main peak of mean auto-correlation function 
(MACF) to estimate fading time

16 Poor fit to MACF
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17 Secondary maxima in MACF > 0.5 (oscillatory)

18 Mean ACF > 0.5 at end lags

19 One or more CCF maxima exceeds 1.0

4.10.4  The FCA Display Module

4.10.4.1  Description
The Full Correlation Analysis Display Module (FCADM) is a compound widget allowing Full 
Correlation Analysis (FCA) analysed data to be displayed in one of a number of different statistical 
forms.  The FCA provides estimates of the horizontal and vertical wind velocities, and parameters 
relating to the spatial and temporal properties of the irregularities responsible for the radar 
backscatter.  As a by-product of the analysis the returned signal powers and signal-to-noise ratios 
(SNR) of all receiving channels are also estimated.

The FCA Display Module

The FCADM widget is divided into four main areas. At the top of the widget is a row of motif-style 
pull-down menus which provide access to all FCADM functionality. The menu headings include 
"File", "Format", "View", "Parameter", "Options", and "Help". Immediately below the menu bar 
(from left to right) appear the time of the initial available ("Earliest Data") record, the time-
duration mode, and the time of the final available record ("Latest Data"). Below these labels 
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appears the point-and-click time-selection window and the display window. The time-selection 
window displays the start and end times for the data currently on display in the display window. 

The FCADM allows the display of the estimated horizontal and vertical wind velocities, the 
returned signal power, and the SNR. The display parameter is selected from the "Parameters" 
menu. 

The display formats used for the FCADM include profile averages, time-series profiles, and image 
plots for all parameters, plus vector flow field plots of horizontal and vertical velocities, and 
windbarb plots of horizontal velocities. Image plots can be performed with or without contours or 
smoothing. The display format is selected from the "Format" menu. The default display on 
entering the FCADM is the average horizontal wind velocity profile for the last hour.

The FCADM allows the display of the FCA results over the last 24 hours, the last hour, and for the 
last analysed record. The required duration is selected from the "View" menu. Recently analysed 
data are automatically read into the FCADM. The analysed data tag to display can be selected 
using the "Select Analysed Data Tag" option from the "View" menu. Selecting this option launches 
a widget allowing the use to select any of the analysed data tags of FCA analysed data stored in 
the directory specified by the environment variable ANALYSED_DATA (see under the 
ENVIRONMENT VARIABLES heading below). Archived FCA-analysed data-sets for previous days 
can also be selected and viewed from the "Archived Data" option of the "View" menu. Selecting 
this option launches a pickfile menu allowing the user to select the required file.

In last 24 hour and archived modes the duration over which the results are displayed can be 
selected using the time-selection window. The left and right mouse buttons may be used to select 
the initial and final times, respectively, of the required time-selection window duration, while the 
middle mouse button may be used to select an individual record. The required time-selection 
window duration can also be specified from the "Window Averaging" option of the "Options" 
menu.

The user also has control over many features of the displayed data, including scaling of the 
horizontal axes for profile average plots, and selection of the size of the informative labels 
included with the display. These features may be chosen from the "Options" menu. Hardcopies of 
the display can be obtained by selecting the "Print" option under the "File" pull down menu 
heading. This invokes the "Print Utility", allowing the current plot to be either be saved to file in 
any of a number of different formats, or sent to any nominated print queue along with any 
additional command line options to "lpr".

The default display on invoking the FCADM can be selected by choosing the "Set Display as 
Default" option from the "File" menus once the required parameter and display format has been 
selected. This saves the default parameters to a savefile which is restored on invocation of the 
FCADM. If a default parameter savefile does not exist, the default display on invocation is the 
average horizontal wind velocity profile for the last hour. If a default parameter savefile exists, 
the default display can be returned to average horizontal wind velocity profile for the last hour by 
selecting the "Delete Default Settings" from the "File" menu.

4.10.4.2  Keyboard Accelerators
Many of the pull-down menu options are accessible from the keyboard with the use of <ALT>-
<single key> combinations. For example, the File menu options can be accessed using <ALT>-P 
to invoke the Print Utility, <ALT>-S to save the current display options as default, <ALT>-K to 
revert to the original default options, and <ALT>-W to close the widget. In addition, the user may 
use <ALT>-L to display the results of the last analysed record, <ALT>-R to display the last hour of 
analysed records, <ALT>-D to display the last 24 Hours of analysed data records, and <ALT>-A to 
allow the selection of archived analysed data sets. If archived data is not being viewed, the <ALT>-
T option can be used to change the analysed data tag to be viewed. Outlier rejection can be 
enabled and disabled using <ALT>-Y. A text print-out of the results of the last analysed record can 
be obtained using <Alt>-N. This manual page may be displayed using <ALT>-H. 

Of particular use are the keyboard accelerators used for changing the scaling of the various data 
displays. The up and down arrows control the scale of the vertical axis. Vertical panning is 
accomplished using up and down arrow key in combination with the shift key. The left and right 
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control the scale of the horizontal axis for profile average plots and the appropriate parameter 
scale for other formats.

4.10.4.3  Resizing facility
The widget may be resized as desired.

4.10.4.4  Environment variables
ANALYSIS_DIR: The root directory of the analysis distribution.

ANALYSED_DATA: The directory where analysed data files are placed.

PRINT_CMD: The command line switches to pass to lpr.

TMP: A temporary directory for spooling print jobs etc.

4.10.4.5  Files
FCADM usage is logged to the file "$ANALYSIS_DIR/log/display.log". Users should consult this 
file for further information on any problems observed using FCADM.

For on-line Linux operation, the size of this file is controlled by "logrotate" as specified in the file 
"/etc/logrotate.d/radarlogs". Information on logrotate can be obtained from the command 
line using "man logrotate".

Savefiles of default parameters for use on invocation of FCADM are stored in 
"$ANALYSIS_DIR/control/.fcadm_default".

The default filename for files produced by the "Print Utility" is "$TMP/fcadm000.<ext>" where 
<ext> is the file extension appropriate to the file format.

4.10.5  The DAE/DPE Analysis Module

4.10.5.1  Description
The differential absorption experiment (DAE) and the differential phase experiment (DPE) are 
employed to estimate mesospheric electron densities. The DAE uses the amplitude ratio of the 
extraordinary (E) to ordinary (O) mode backscattered signals, while the DPE uses the phase 
differences between the E- and O-mode signals.

The techniques require collision frequency and the magnetic field profiles, which are both site 
dependent. The collision frequency for each site is determined using pressure profiles 
interpolated from the COSPAR International Reference Atmosphere (CIRA86) model (see 
http://nssdc.gsfc.nasa.gov/space/model/atmos/cospar1.html), while the magnetic field 
profile is determined using the International Geomagnetic Reference Field (IGRF) model (see 
http://nssdc.gsfc.nasa.gov/space/models/igrf.html). The collision frequency and magnetic 
field profiles are then employed to calculate the complex refractive index profile, from which the 
reflection coefficient profiles are derived.

The DAE technique uses the differences in the amplitude ratios of the signal and reflection 
coefficients between adjacent heights to determine the electron density within the intermediate 
height interval. The DPE uses the difference in the phase differences of the signal and reflection 
coefficients. The height coverage of both experiments is limited at upper heights by small signal 
amplitude ratios due to a lack of E-mode returns, and at lower heights by small signal to noise 
ratios.

Although the height coverage for the DPE is the same as for the DAE, the numerator and 
denominator of the equation used for the DPE calculation usually pass through zero at about 66 
km. Spurious large electron densities can therefore result if the numerator and denominator do 
not pass through zero at the same height. To avoid this possibility, the DPE electron density is not 
calculated for heights where the magnitude of the denominator is less than a preset threshold.
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4.10.5.2  References:
A.H. Manson and C. E. Meek (1984),
Partial reflection D-region electron densities,
MAP Handbook 13, p113 - 123.

J. S. Belrose (1970),
Radio wave probing of the ionosphere by the partial reflection of radio waves (from heights below 
100 km), 
JATP, 32, 567-597

4.10.5.3  Analysed Data File Format
DAE analysed data are written to disk in a binary format.  Individual data files hold up to 24 hours 
of analysed data and are identified by the year, month, and day during which the data were 
recorded. During continuous data acquisition, each analysed data file begins at midnight, UTC. 
The FCA analysed data format is described in detail in Appendix C.

4.10.5.4  Error codes - SNR
0 Both O and E mode SNRs acceptable

1 Time series unsuitable for analysis (signal amplitude too low, or 
interference present , or saturation percentage too high)

2 One or both mode’s SNR is less than -3 dB

4.10.5.5  Error codes - DAE
0 Analysis successful

1 No calculation performed for this height. (DAE analysis requires 
information from adjacent ranges. There is therefore always a loss of one 
range at the edge of the sampling regime.)

2 SNR too low for this or next height

3 SNR too low for this and next height

4 DAE estimate of electron density less than 10 cm-3

5 Amplitude ratio below user selected threshold

4.10.5.6  Error codes - DPE
0 Analysis successful

1 No calculation performed for this height. (DPE analysis requires 
information from adjacent ranges. There is therefore always a loss of one 
range at the edge of the sampling regime.)

2 SNR too low for this or next height.

3 SNR too low for this and next height

4 DPE estimate of electron density less than 10 cm-3

5 Amplitude ratio below user selected threshold

6 Denominator for DPE calculation too small

ATRAD Page 32 of 110



AT R A D
DISPLAY AND ANALYSIS SOFTWARE REFERENCE MANUAL

4.10.6  The DAE/DPE Display Module

4.10.6.1  Description
The Differential Absorption Experiment Display Module (DAEDM) is a compound widget allowing 
the analysed data produced by the Differential Absorption Experiment (DAE) and Differential 
Phase Experiment (DPE) to be displayed in one of a number of different statistical forms. The 
Differential absorption and phase experiments each provide an estimate of the electron density in 
the range region where both O- and E-mode polarisation returns are appreciable. The DAE 
calculates the electron density using the ratio of the amplitudes of the E- to O- mode returns, 
while the DPE uses the phase difference between the E- and O- mode returns.

The DAE/DPE Display Module

The DAEDM widget is divided into four main areas. At the top of the widget is a row of motif-style 
pull-down menus which provide access to all DAEDM functionality. The menu headings include 
"File", "Format", "View", "Parameter", "Options", and "Help". Immediately below the menu bar 
(from left to right) appear the time of the initial available ("Earliest Data") record, the time-
duration mode, and the time of the final available record ("Latest Data"). Below these labels 
appears the point-and-click time-selection window and the display window. The time-selection 
window displays the start and end times for the data currently on display in the display window. 

The DAEDM allows the display of the estimated DAE and DPE electron density, the signal and 
reflection coefficient amplitude ratios and phase differences, and the O- and E-mode signal 
powers. The display parameter is selected from the "Parameters" menu.
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The display formats used for the DAEDM include profile averages, time-series profiles, and image 
plots. Image plots can be performed with or without contours or smoothing. The display format is 
selected from the "Format" menu. The default display on entering the DAEDM is the average DAE 
and DPE electron density profile for the last hour.

The DAEDM allows the display of the DAE results over the last 24 hours, the last hour, and for the 
last analysed record. The required duration is selected from the "View" menu. Recently analysed 
data are automatically read into the DAEDM. The analysed data tag to display can be selected 
using the "Select Analysed Data Tag" option from the "View" menu. Selecting this option launches 
a widget allowing the use to select any of the analysed data tags of DAE analysed data stored in 
the directory specified by the environment variable ANALYSED_DATA (see under the 
ENVIRONMENT VARIABLES heading below). Archived DAE-analysed data-sets for previous days 
can also be selected and viewed from the "Archived Data" option of the "View" menu. Selecting 
this option launches a pickfile menu allowing the user to select the required file.

In last 24 hour and archived modes the duration over which the results are displayed can be 
selected using the time-selection window. The left and right mouse buttons may be used to select 
the initial and final times, respectively, of the required time-selection window duration, while the 
middle mouse button may be used to select an individual record. The required time-selection 
window duration can also be specified from the "Window Averaging" option of the "Options" 
menu.

The user also has control over many features of the displayed data, including scaling of the 
horizontal axes for profile average plots, and selection of the size of the informative labels 
included with the display, and the overplotting of DAE and DPE electron densities or O- and E-
mode signal powers. These features may be chosen from the "Options" menu. Hardcopies of the 
display can be obtained by selecting the "Print" option under the "File" pull down menu heading. 
This invokes the "Print Utility", allowing the current plot to be either be saved to file in any of a 
number of different formats, or sent to any nominated print queue along with any additional 
command line options to "lpr".

The default display on invoking the DAEDM can be selected by choosing the "Set Display as 
Default" option from the "File" menus once the required parameter and display format has been 
selected. This saves the default parameters to a savefile which is restored on invocation of the 
DAEDM. If a default parameter savefile does not exist, the default display on invocation is the 
average DAE and DPE electron density profile for the last hour. If a default parameter savefile 
exists, the default display can be returned to the average DAE and DPE electron density profile 
for the last hour by selecting the "Delete Default Settings" from the "File" menu.

4.10.6.2  Keyboard Accelerators
Many of the pull-down menu options are accessible from the keyboard with the use of <ALT>-
<single key> combinations. For example, the File menu options can be accessed using <ALT>-P 
to invoke the Print Utility, <ALT>-S to save the current display options as default, <ALT>-K to 
revert to the default options, and <ALT>-W to close the widget. In addition, the user may use 
<ALT>-L to display the results of the last analysed record, <ALT>-R to display the last hour of 
analysed records, <ALT>-D to display the last 24 Hours of analysed data records, and <ALT>-A to 
allow the selection of archived analysed data sets. If archived data is not being viewed, the <ALT>-
T option can be used to change the analysed data tag to be viewed. Outlier rejection can be 
enabled and disabled using <ALT>-Y. A text print-out of the results of the last analysed record can 
be obtained using <Alt>-N. This manual page may be displayed using <ALT>-H. 

Of particular use are the keyboard accelerators used for changing the scaling of the various data 
displays.  The up and down arrows change the scale of the vertical axis. Vertical panning is 
accomplished using the up and down arrow key in combination with the shift key.  The left and 
right arrows control the scale of the horizontal axis for average plots and the appropriate 
parameter scale for other formats.

4.10.6.3  Resizing Facility
The DAE display module may be resized as desired.
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4.10.6.4  Environment variables
ANALYSIS_DIR: The root directory of the analysis distribution.

ANALYSED_DATA: The directory in which analysed data are stored.

PRINT_CMD: The command line switches to pass to lpr SPOOL_DIR:

TMP: A temporary directory for spooling print jobs etc.

4.10.6.5  Files
DAEDM usage is logged to the file "$ANALYSIS_DIR/log/display.log". Users should consult this 
file for further information on any problems observed using the DAEDM.

For on-line Linux operation, the size of this file is controlled by "newsyslog" as specified in the file 
"/etc/newsyslog.conf". Information on newsyslog can be obtained from the command line using 
"man newsyslog".

Savefiles of default parameters for use on invocation of DAEDM are stored in 
"$ANALYSIS_DIR/control/.daedm_default".

The default filename for files produced by the "Print Utility" is "$TMP/daedm000.<ext>" where 
<ext> is the file extension appropriate to the file format.

4.10.7  The SCA Analysis Module

4.10.7.1  Description
The SCA analysis module embodies the spatial correlation analysis as described in “Spatial 
Correlation analysis revistied : Theory, and application using "radar backscatter model  data", by 
D. A. Holdsworth, Radio Sci., 34(3), 629 - 642,. Although a relatively new analysis, its advantage 
lies in its relative insensitivity to measurement biases introduced through inappropriate antenna 
spacings and characteristic differences between different channels. 

SCA analysis can only be configured to be performed using 4 antennas. The antenna configuration 
allowed is limited to two general possibilities: 1) the case where the antennas are arranged in a 
"Y-configuration", such that the vector sum of the inner to outer antenna separations sum to zero, 
and the angles between antenna baselines for the "outside" antennas are within 30 to 90 degrees. 
2) The case where the antennas are arranged in a rectangle, such that the ratio of the largest to 
smallest baselines are less than 1.5. For alternative antenna configurations, the analysis will 
report that the antenna configuration is unsuitable for analysis.

The SCA can be configured to store mean angles of arrival (MAOAs). This option allows the 
determination of "corrected vertical velocities", whereby the vertical velocity is corrected for 
leakage from the horizontal velocity due to non zero MAOAs, as described in "VHF radar 
measurements of in-beam incidence angles and associated vertical-beam radial velocity  
corrections", by. M. F. Larsen and J. Rottger, Journal of Atmospheric and Oceanic Technology,  vol 
8, 1991. As the MAOAs are affected by phase calibration errors, it is important that receiver 
calibration has been performed prior to analysis. Receiver calibration is described in Including
receiver calibration estimates in the analysis and display suite.

The SCA analysis can be configured to be applied over a limited height range, with extra coherent 
integration, and with access to additional analysis, as described in Control files used by the
analysis and display suite. 

4.10.7.2  Analysed Data File Format
FCA analysed data are written to disk in a binary format.  Individual data files hold up to 24 hours 
of analysed data and are identified by the year, month, and day during which the data were 
recorded. During continuous data acquisition, each analysed data file begins at midnight, UTC. 
The FCA analysed data format is described in detail in Appendix C: ATRAD Analysed Data Format.

4.10.7.3  Error Codes
The following table describes the types of error codes produced by the SCA analysis. 
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0 No error - analysis result ok.

1 Poor zero-lag interpolation

2 Signal to noise ratio less than 0 dB

3 Mean auto-correlation function (MACF) half-width exceeds 6 s, or is oscillatory

4 Spatial correlation maxima lie more than twice antenna spacing from zero 
spatial lag

5 Estimate of characteristic ellipse axis parameter negative (not implemented)

6 Fitted spatial correlation maxima exceed unity

7 Significant difference in correlation for middle spatial lags

8 Significant difference in widths of Gaussian fits to parallel arm

9 Poor Gaussian fit to at least one spatial lag arm of spatial correlations

10 Gaussian fit to one more arms locates a minimum

11 Poor intersection of lines through the spatial correlation maxima (not 
implemented)

12 Velocity > 200 ms-1

4.10.8  The SCA Display Module

4.10.8.1  Description
The Spatial Correlation Analysis Display Module (SCADM) is a compound widget allowing Spatial 
Correlation Analysis (SCA) analysed data to be displayed in one of a number of different statistical 
forms. The SCA provides estimates of the horizontal and vertical wind velocities. As a by-product 
of the analysis the returned signal powers and signal-to-noise ratios (SNR) of all receiving 
channels are also estimated.
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The SCA Display Module

The SCADM widget is divided into four main areas. At the top of the widget is a row of motif-style 
pull-down menus which provide access to all SCADM functionality. The menu headings include 
"File", "Format", "View", "Parameter", "Options", and "Help". Immediately below the menu bar 
(from left to right) appear the time of the initial available ("Earliest Data") record, the time-
duration mode, and the time of the final available record ("Latest Data"). Below these labels 
appear the point-and-click time-selection window and the display window. The time-selection 
window displays the start and end times for the data currently on display in the display window. 

The SCADM allows the display of the estimated horizontal and vertical wind velocities, the 
returned signal power, and the SNR. The display parameter is selected from the "Parameters" 
menu. 

The display formats used for the SCADM include profile averages, time-series profiles, and image 
plots for all parameters, plus vector flow field plots for horizontal and vertical velocities, and 
windbarb

plots of horizontal velocities. Image plots can be performed with or without contours or 
smoothing. The display format is selected from the "Format" menu. The default display on 
entering the SCADM is the average horizontal wind velocity profile for the last hour.

The SCADM allows the display of the SCA results over the last 24 hours,the last hour, and for the 
last analysed record. The required duration is selected from the "View" menu. Recently analysed 
data are automatically read into the SCADM. The analysed data tag to display can be selected 
using the "Select Analysed Data Tag" option from the "View" menu. Selecting this option launches 
a widget allowing the use to select any of the analysed data tags of SCA analysed data stored in 
the directory specified by the environment variable ANALYSED_DATA (see under the 
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ENVIRONMENT VARIABLES heading below). Archived SCA-analysed data-sets for previous days 
can also be selected and viewed from the "Archived Data" option of the "View" menu. Selecting 
this option launches a pickfile menu allowing the user to select the required file.

In last 24 hour and archived modes the duration over which the results are displayed can be 
selected using the time-selection window. The left and right mouse buttons may be used to select 
the initial and final times, respectively, of the required time-selection window duration, while the 
middle mouse button may be used to select an individual record. The required time-selection 
window duration can also be specified from the "Window Averaging" option of the "Options" 
menu.

The user also has control over many features of the displayed data, including scaling of the 
horizontal axes for profile average plots, and selection of the size of the informative labels 
included with the display. These features may be chosen from the "Options" menu. Hardcopies of 
the display can be obtained by selecting the "Print" option under the "File" pull down menu 
heading. This invokes the "Print Utility", allowing the current plot to be either be saved to file in 
any of a number of different formats, or sent to any nominated print queue along with any 
additional command line options to "lpr".

The default display on invoking the SCADM can be selected by choosing the "Set Display as 
Default" option from the "File" menus once the required parameter and display format has been 
selected. This saves the default parameters to a savefile which is restored on invocation of the 
SCADM. If a default parameter savefile does not exist, the default display on invocation is the 
average horizontal wind velocity profile for the last hour. If a default parameter savefile exists, 
the default display can be returned to average horizontal wind velocity profile for the last hour by 
selecting the "Delete Default Settings" from the "File" menu.

4.10.8.2  Keyboard Accelerators
Many of the pull-down menu options are accessible from the keyboard with the use of <ALT>-
<single key> combinations. For example, the File menu options can be accessed using <ALT>-P 
to invoke the Print Utility, <ALT>-S to save the current display options as default, <ALT>-K to 
revert to the default options, and <ALT>-W to close the widget. In addition, the user may use 
<ALT>-L to display the results of the last analysed record, <ALT>-R to display the last hour of 
analysed records, <ALT>-D to display the last 24 Hours of analysed data records, and <ALT>-A to 
allow the selection of archived analysed data sets. If archived data is not being viewed, the <ALT>-
T option can be used to change the analysed data tag to be viewed. Outlier rejection can be 
enabled and disabled using <ALT>-Y. A text print-out of the results of the last analysed record can 
be obtained using <Alt>-N. This manual page may be displayed using <ALT>-H. 

Of particular use are the keyboard accelerators used for changing the scaling of the various data 
displays. The up and down arrows control the scale of the vertical axis. Vertical panning is 
accomplished using up and down arrow key in combination with the shift key. The left and right 
control the scale of the horizontal axis for profile average plots and the appropriate parameter 
scale for other formats.

4.10.8.3  Resizing facility
The widget may be resized as desired.

4.10.8.4  Environment variables
ANALYSIS_DIR: The root directory of the analysis distribution.

ANALYSED_DATA: The directory where analysed data files are placed.

PRINT_CMD: The command line switches to pass to lpr.

TMP: A temporary directory for spooling print jobs etc.

4.10.8.5  Files
SCADM usage is logged to the file: "$ANALYSIS_DIR/log/display.log". Users should consult this 
file for further information on any problems observed using SCADM.
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For on-line Linux operation, the size of this file is controlled by "logrotate" as specified in the file 
"/etc/logrotate.d/radarlogs". Information on logrotate can be obtained from the command 
line using "man logrotate".

Savefiles of default parameters for use on invocation of SCADM are stored in 
"$ANALYSIS_DIR/control/.scadm_default".

The default filename for files produced by the "Print Utility" is "$TMP/scadm000.<ext>" where 
"<ext>" is the file extension appropriate to the file format.

4.10.9  The IDI Analysis and Postanalysis Modules

4.10.9.1  Description
The IDI analysis module embodies the imaging Doppler interferometry analysis as described in 
“Mesospheric Observations using a 2.66 MHz Radar as an Imaging Doppler interferometer:  
Description and first results”, G. W. Adams et al, J. Geophys. Res 91(A2), 1671-1683. A large 
amount of literature is available describing the IDI technique and its practical application to the 
analysis of radar data.  It is beyond the scope of this manual to describe the specifics of the 
analysis itself, apart from such aspects as output data formats and the meanings of the various 
error codes produced.

The first step in the IDI analysis is the determination of the angles of the effective scattering 
positions (ESPs). The second step is the determination of the analysis parameters. The ESP can be 
written to file and spooled for IDI postanalysis for the determination of  the analysis parameters 
from multiple data acquisitions. As the ESP are affected by phase calibration errors, it is 
important that receiver calibration has been performed prior to analysis. Receiver calibration is 
described in Including receiver calibration estimates in the analysis and display suite.

IDI analysis can be configured to be performed using either 3 or 4 antennas. For 3-antenna 
analysis, the analysis is restricted to configurations where the angles between antenna baselines 
are all within 30 to 90 degrees. For 4 antenna analysis, the antenna configuration allowed is 
limited to the case where the antennas are arranged in a "Y-configuration", such that the vector 
sum of the inner to outer antenna separations sum to zero, and the angles between antenna 
baselines for the "outside" antennas are within 30 to 90 degrees. For alternative antenna 
configurations, the analysis will report that the antenna configuration is unsuitable for analysis.

The IDI analysis can be configured to be applied over a limited height range, with extra coherent 
integration, and with access to additional analysis thresholds, as described in Control files used by
the analysis and display suite. If access to additional analysis thresholds is available, and the 4 
antenna Y-configuration is selected, the IDI analysis configuration module allows an extra control 
allowing the user to enable the use of normalised phase discrepancy threshold. This threshold is 
applied as a plane wave criterion to verify that the ESP for any frequency bin results from a single 
discrete scatterer. No plane wave criterion is available for 3-antenna analysis.

IDI analysed (and postanalysed) data can be calculated as height profiles rather than range 
profiles. Strictly speaking, the analysis is intended for calculating height profiles, but calculation 
of range profiles may prove more useful for comparison with FCA and SCA analyses, which 
necessarily use range profiles since they are applied to data collected from a single range gate.   

4.10.9.2  Analysed Data File Format
IDI analysed data are written to disk in a binary format.  Individual data files hold up to 24 hours 
of analysed data and are identified by the year, month, and day during which the data were 
recorded. During continuous data acquisition, each analysed data file begins at midnight, UTC. 
The IDI analysed data format is described in detail in Appendix C: ATRAD Analysed Data Format.

4.10.9.3  Error Codes
The following table describes the types of error codes produced by the IDI analysis. 

0 No error - analysis result ok.

1 Time series unsuitable for analysis (signal amplitude too low, or interference 
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present)

2 Fewer than three scatterers available at this height (IDI requires a minimum 
of three scatterers for wind velocity determination)

3 Velocity > 200 ms-1

4 Vertical velocity > 10 ms-1

5 Scatterer azimuth estimate not available (note, parameters other than 
scatterer azimuth are still valid)

6 Turbulent velocity estimate not available (note, parameters other than 
turbulent velocity are still valid)

4.10.10  The DBS Analysis Module

4.10.10.1  Description
The DBS analysis can be performed using two different techniques. The combined analysis 
combines the signals from each receiving channel and performs a standard single channel 
Doppler analysis to estimate the radial velocity, spectral width, SNR and Power. This analysis may 
be succeptible to the effects of aspect sensitivity, which acts to produce effective beam directions 
biased towards the zenith, thereby resulting in the underestimation of the estimated radial 
velocities.

The Hybrid Doppler interferometry (HDI) uses of poststatistics steering (PSS) to steer the receive 
antenna beam pattern through a series of preselected beam directions. The effective returned 
power is estimated for each receive beam, and the direction of maximum power is estimated from 
the resulting power variation. If a Gaussian form is assumed for the transmit and receive beam 
patterns the resulting direction of maximum power can be shown to correspond the effective 
beam direction (EBD). The receive beam is re-steered into the EBD, and the standard Doppler 
analysis is applied to estimate the radial velocity, spectral width, SNR and Power. The aspect 
sensitivity parameter (θ s) is calculated for off-zenith beams provided the zenith component of the 
EBD lies between the zenith and the transmitted beam zenith angle, and the EBD azimuth 
component of the EBD lies within 45o of the transmit beam azimuth.

For transmission on rows and columns, the HDI receive beam is steered in an array of 21 
directions between the 1/e full-width angles of the transmit beam along the azimuth of the 
transmit beam direction. The EBD is estimated by performing Gaussian fit to the returned signal 
powers calculated for each receive beam direction. For transmission on spaced antennas, the HDI 
receive beam is steered in an 11 by 11 grid bounded by the 1/e full-width angles in the cardinal 
directions. The EBD is estimated by performing a two-dimensional Gaussian fit to the returned 
signal powers calculated for each receive beam direction.

Both the combined and HDI analyses can be applied using either correlation or spectral analyses. 
The choice of analysis (i.e. HDI or combined) and domain (i.e. correlation or spectral) can be 
made using the DBS analysis configuration utility. It is recommended that the spectral analysis is 
used for sites with interference problems, such as clutter, sea scatter, and aircraft echoes, as 
spectral analysis is better suited to coping with such problems. Prior to analysis, the time-series 
can have extra coherent integration applied, and be combined into a single receiver channel. 
Spectral smoothing can be applied by splitting the time-series, and then calculating and 
combining the “split” spectra.

The DBS analysed data can subsequently be used to produce three-dimensional wind velocities 
using the VEL postanalysis. Please refer to the description of the VEL postanalysis on page 51 for 
further information.

4.10.10.2  Analysed Data File Format
DBS analysed data are written to disk in a binary format. Individual data files hold up to 24 hours 
of analysed data and are identified by the year, month, and day during which the data were 
recorded. During continuous data acquisition, each analysed data file begins at midnight, UTC. 
The DBS analysed data format is described in more detail in Appendix C: ATRAD Analysed Data
Format.
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4.10.10.3  Error codes
Please note that criteria 4 to 7 are applicable for HDI analysis only:

0 Analysis OK

1 Low dynamic range, or interference rejection (data contaminated by non-
atmospheric signals)

2 SNR less than -6 dB

3 Projected horizontal velocity based on EBD and radial velocity  > 200 ms-1 

(off zenith beams only)

4 Maxima in power estimates is too close to edge of receive beam directions to 
allow estimation the EBD.

5 Azimuth angle of the EBD not within 45 degrees of the transmitted beam 
azimuth.

6 Zenith angle of EBD < 0

7 Zenith angle of EBD > transmitted beam zenith

8 Insufficient good power estimates with received beam angle to estimate the 
EBD

4.10.11  The DBS Display Module

4.10.11.1  Description
The Doppler Beam Steering Display Module (DBSDM) is a compound widget allowing Doppler 
Beam Steering (DBS) analysed data to be displayed in one of a number of different statistical 
forms. The DBS analysis provides estimates of the radial velocity, spectral width, effective beam 
pointing direction, aspect sensitivity, signal-to-noise ratio (SNR), and power for a number of 
transmitted beam directions.
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The 
DBS Display Module

The DBSDM widget is divided into five main areas. At the top of the widget is a row of motif-style 
pull-down menus which provide access to all DBSDM functionality. The menu headings include 
"File", "Format", "View", "Parameter", "Options", and "Help". Immediately below the menu bar 
(from left to right) appear the time of the initial available ("Earliest Data") record, the time-
duration mode, the time of the final available record ("Latest Data"), and the point-and-click beam 
selector widget, which allows the user to display any of the available beam directions. Below these 
labels appears the point-and-click time-selection window and the display window. The time-
selection window displays the start and end times for the data currently on display in the display 
window. 

The DBSDM allows the display of the estimated radial wind velocities, spectral widths, effective 
beam zenith angles, aspect sensitivity parameters, returned signal power, and the SNR. The 
display parameter is selected from the "Parameters" menu. The display formats used for the 
DBSDM include profile averages, time-series profiles, and image plots. Image plots can be plotted 
with and without smoothing and contours. The display format is selected from the "Format" menu. 
The default display on entering the DBSDM is the average radial velocity profile for the last hour.

The DBSDM allows the display of the DBS results over the last 24 hours, the last hour, and for the 
last analysed record. The required duration is selected from the "View" menu. Recently analysed 
data are automatically read into the DBSDM. The analysed data tag to display can be selected 
using the "Select Analysed Data Tag" option from the "View" menu. Selecting this option launches 
a widget allowing the use to select any of the analysed data tags of DBS analysed data stored in 
the directory specified by the environment variable ANALYSED_DATA (see under the 
ENVIRONMENT VARIABLES heading below). Archived DBS-analysed data-sets for previous days 
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can also be selected and viewed from the "Archived Data" option of the "View" menu. Selecting 
this option launches a pickfile menu allowing the user to select the required file.

In last 24 hour and archived modes the duration over which the results are displayed can be 
selected using the time-selection window. The left and right mouse buttons may be used to select 
the initial and final times, respectively, of the required time-selection window duration, while the 
middle mouse button may be used to select an individual record. The required time-selection 
window duration can also be specified from the "Window Averaging" option of the "Options" 
menu.

The user also has control over many features of the displayed data, including scaling of the 
horizontal axes for profile average plots, and selection of the size of the informative labels 
included with the display. These features may be chosen from the "Options" menu. Hardcopies of 
the display can be obtained by selecting the "Print" option under the "File" pull down menu 
heading. This invokes the "Print Utility", allowing the current plot to be either be saved to file in 
any of a number of different formats, or sent to any nominated print queue along with any 
additional command line options to "lpr".

The default display on invoking the DBSDM can be selected by choosing the "Set Display as 
Default" option from the "File" menus once the required parameter and display format has been 
selected. This saves the default parameters to a savefile which is restored on invocation of the 
DBSDM. If a default parameter savefile does not exist, the default display on invocation is the 
average radial velocity profile for the nominal "first" beam (usually vertical) for the last hour. If a 
default parameter savefile exists, the default display can be returned to average radial velocity 
profile for the last hour by selecting the "Delete Default Settings" from the "File" menu.

4.10.11.2  Keyboard Accelerators
Many of the pull-down menu options are accessible from the keyboard with the use of <ALT>-
<single key> combinations. For example, the File menu options can be accessed using <ALT>-P 
to invoke the Print Utility, <ALT>-S to save the current display options as default, <ALT>-K to 
revert to the default options, and <ALT>-W to close the widget. In addition, the user may use 
<ALT>-L to display the results of the last analysed record, <ALT>-R to display the last hour of 
analysed records, <ALT>-D to display the last 24 Hours of analysed data records, and <ALT>-A to 
allow the selection of archived analysed data sets. If archived data is not being viewed, the <ALT>-
T option can be used to change the analysed data tag to be viewed. Outlier rejection can be 
enabled and disabled using <ALT>-Y. A text print-out of the results of the last analysed record can 
be obtained using <Alt>-N. This manual page may be displayed using <ALT>-H. 

Of particular use are the keyboard accelerators used for changing the scaling of the various data 
displays. The up and down arrows control the scale of the vertical axis. Vertical panning is 
accomplished using up and down arrow key in combination with the shift key. The left and right 
control the scale of the horizontal axis for profile average plots and the appropriate parameter 
scale for other formats.

4.10.11.3  Resizing facility
The widget may be resized as desired.

4.10.11.4  Environment Variables

ANALYSIS_DIR: The root directory of the analysis distribution.

ANALYSED_DATA: The directory where analysed data files are placed.

PRINT_CMD: The command line switches to pass to lpr.

TMP: A temporary directory for spooling print jobs etc.

4.10.11.5  Files
DBSDM usage is logged to the file: $ANALYSIS_DIR/log/display.log. Users should consult this 
file for further information on any problems observed using DBSDM.
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For on-line Linux operation, the size of this file is controlled by "logrotate" as specified in the file 
"/etc/logrotate.d/radarlogs". Information on logrotate can be obtained from the command 
line using "man logrotate".

Savefiles of default parameters for use on invocation of DBSDM are stored in 
"$ANALYSIS_DIR/control/.dbsdm_default".

The default filename for files produced by the "Print Utility" is "$TMP/dbsdm000.<ext>" where 
<ext> is the file extension appropriate to the file format.

4.10.12  The IDBS Analysis module

4.10.12.1  Description
The IDBS analysis is a Doppler beam steering (DBS) analysis configured for collection of 
ionospheric E- and F-region echoes. The analysis is applied in the frequency (or spectral) domain, 
and can be applied to data recorded using co-linear (or Hybrid Doppler interferometry (HDI)) or 
meteor antennas. The IDBS analysis estimates the radial velocity, spectral width, SNR and Power. 
If the SNR exceeds -12 dB, the effective beam direction of the echoes is determined.

For co-linear antennas, the effective beam direction cannot be unambiguously determined, and 
can only be determined in the plane of the antenna configuration.  Poststatistics steering (PSS) is 
used to steer the receive antenna beam pattern through a series of preselected beam directions. 
The effective returned power is estimated for each receive beam, and the effective beam direction 
(or direction of maximum power) is estimated by performing Gaussian fit to the returned signal 
powers calculated for each receive beam direction. from the resulting power variation. For meteor 
antennas, the effective beam direction is unambiguously determined using the same method as 
applied for MET analysis.

In the event that there are multiple spectral peaks at any range, the analysis estimates 
parameters for the combined spectral peaks, and also the individual spectral peaks. At any range 
where there are N (> 1) spectral peaks, the analysed data contains (N + 1) entries. The first entry 
will contain parameters estimated from the combined spectral peaks. The 2nd to (N+1)th entries 
will contain parameters estimated from the individual spectral peaks. The error code for the 2nd 
to (N+1)th are set to values of 100 + the actual error code to denote that they are multiple 
spectral peaks. The actual error codes are therefore determined using the error code modulus 
100. Note that the IDBS display module will only display the the combined spectral peak results at 
ranges where there are multiple spectral peaks.

4.10.12.2  Analysed Data File Format
IDBS analysed data are written to disk in a binary format. Individual data files hold up to 24 hours 
of analysed data and are identified by the year, month, and day during which the data were 
recorded. During continuous data acquisition, each analysed data file begins at midnight, UTC. 
The IDBS analysed data format is described in more detail in Appendix C: ATRAD Analysed Data 
Format.
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4.10.12.3  Error codes
Please note:

● criteria 3 is applicable to meteor antenna only

● criteria 4 to 7 are applicable for HDI antennas only

● as described above, the actual error codes are the error code modulus 100

0 Analysis OK

1 Low dynamic range, or interference rejection (data contaminated by non-
atmospheric signals)

2 SNR less than -12 dB

3 EBD cannot be estimated (meteor antennas only)

4 Maxima in power estimates is too close to edge of receive beam directions to 
allow estimation the EBD.

5 Not used (maintained for compatibility with DBS analysis)

6 Not used (maintained for compatiblity with DBS analysis)

7 Zenith angle of EBD > transmitted beam zenith

8 Insufficient good power estimates with received beam angle to estimate the 
EBD

4.10.13  The IDBS Display module

4.10.13.1  Description
The Ionospheric Doppler Beam Steering Display Module (IDBSDM) is a compound widget 
allowing Ionospheric Doppler Beam Steering (IDBS) analysed data to be displayed in one of a 
number of different statistical forms. The IDBS analysis provides estimates of the radial velocity, 
spectral width, signal-to-noise ratio (SNR), and power for a number of transmitted beam 
directions.

The IDBSDM widget proivides identical functionality to the DBSDM widget, and is divided into 
five main areas. At the top of the widget is a row of motif-style pull-down menus which provide 
access to all IDBSDM functionality. The menu headings include "File", "Format", "View", 
"Parameter", "Options", and "Help". Immediately below the menu bar (from left to right) appear 
the time of the initial available ("Earliest Data") record, the time-duration mode, the time of the 
final available record ("Latest Data"), and the point-and-click beam selector widget, which allows 
the user to display any of the available beam directions. Below these labels appears the point-and-
click time-selection window and the display window. The time-selection window displays the start 
and end times for the data currently on display in the display window.

The IDBSDM allows the display of the estimated radial wind velocities, spectral widths, effective 
beam zenith angles, aspect sensitivity parameters, returned signal power, and the SNR. The 
display parameter is selected from the "Parameters" menu. Note that although the IDBS analysis 
is capable of estimating multiple spectral peaks at any range, the IDBS display module will only 
display the the combined spectral peak results at these ranges.

The display formats used for the IDBSDM include profile averages, time-series profiles, and image 
plots. Image plots can be plotted with and without smoothing and contours. The display format is 
selected from the "Format" menu. The default display on entering the IDBSDM is the average 
radial velocity profile for the last hour.

The IDBSDM allows the display of the IDBS results over the last 24 hours, the last hour, and for 
the last analysed record. The required duration is selected from the "View" menu. Recently 
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analysed data are automatically read into the IDBSDM. The analysed data tag to display can be 
selected using the "Select Analysed Data Tag" option from the "View" menu. Selecting this option 
launches a widget allowing the use to select any of the analysed data tags of IDBS analysed data 
stored in the directory specified by the environment variable ANALYSED_DATA (see under the 
ENVIRONMENT VARIABLES heading below). Archived IDBS-analysed data-sets for previous days 
can also be selected and viewed from the "Archived Data" option of the "View" menu. Selecting 
this option launches a pickfile menu allowing the user to select the required file.

In last 24 hour and archived modes the duration over which the results are displayed can be 
selected using the time-selection window. The left and right mouse buttons may be used to select 
the initial and final times, respectively, of the required time-selection window duration, while the 
middle mouse button may be used to select an individual record. The required time-selection 
window duration can also be specified from the "Window Averaging" option of the "Options" 
menu.

The user also has control over many features of the displayed data, including scaling of the 
horizontal axes for profile average plots, and selection of the size of the informative labels 
included with the display. These features may be chosen from the "Options" menu. Hardcopies of 
the display can be obtained by selecting the "Print" option under the "File" pull down menu 
heading. This invokes the "Print Utility", allowing the current plot to be either be saved to file in 
any of a number of different formats, or sent to any nominated print queue along with any 
additional command line options to "lpr".

The default display on invoking the IDBSDM can be selected by choosing the "Set Display as 
Default" option from the "File" menus once the required parameter and display format has been 
selected. This saves the default parameters to a savefile which is restored on invocation of the 
IDBSDM. If a default parameter savefile does not exist, the default display on invocation is the 
average radial velocity profile for the nominal "first" beam (usually vertical) for the last hour. If a 
default parameter savefile exists, the default display can be returned to average radial velocity 
profile for the last hour by selecting the "Delete Default Settings" from the "File" menu.

4.10.13.2  Keyboard accelerators
Many of the pull-down menu options are accessible from the keyboard with the use of <ALT>-
<single key> combinations. For example, the File menu options can be accessed using <ALT>-P 
to invoke the Print Utility, <ALT>-S to save the current display options as default, <ALT>-K to 
revert to the default options, and <ALT>-W to close the widget. In addition, the user may use 
<ALT>-L to display the results of the last analysed record, <ALT>-R to display the last hour of 
analysed records, <ALT>-D to display the last 24 Hours of analysed data records, and <ALT>-A to 
allow the selection of archived analysed data sets. If archived data is not being viewed, the <ALT>-
T option can be used to change the analysed data tag to be viewed. Outlier rejection can be 
enabled and disabled using <ALT>-Y. A text print-out of the results of the last analysed record can 
be obtained using <Alt>-N. This manual page may be displayed using <ALT>-H.

Of particular use are the keyboard accelerators used for changing the scaling of the various data 
displays. The up and down arrows control the scale of the vertical axis. Vertical panning is 
accomplished using up and down arrow key in combination with the shift key. The left and right 
control the scale of the horizontal axis for profile average plots and the appropriate parameter 
scale for other formats.

4.10.13.3  Resizing facility
The widget may be resized as desired.

4.10.13.4  Environment variables

ANALYSIS_DIR The root directory of the analysis distribution.

ANALYSED_DATA The directory where analysed data files are placed.

PRINT_CMD The command line switches to pass to lpr.

TMP A temporary directory for spooling print jobs etc.
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4.10.13.5  Files
IDBSDM usage is logged to the file $ANALYSIS_DIR/log/display.log.  Users should consult this 
file for further information on any problems observed using IDBSDM.

For on-line Linux operation, the size of this file is controlled by "logrotate" as specified in the file 
"/etc/logrotate.d/radarlogs". Information on logrotate can be obtained from the command 
line using "man logrotate".

Savefiles of default parameters for use on invocation of IDBSDM are stored in 
"$ANALYSIS_DIR/control/.idbsdm_default".

The default filename for files produced by the "Print Utility" is "$TMP/idbsdm000.<ext>" where 
<ext> is the file extension appropriate to the file format.

4.10.14  The SPEC Analysis and DBS Postanalysis modules
The SPEC analysis is used to produce spectral (.spec) data files. These files are written to the 
ANSPOOL_DIR directory, where they are queued for postanalysis. The files are written in ADF 
raw data format, as described in Appendix B: ATRAD SPEC, AOA and COVF Data Format. The 
SPEC analysis configuration utility specifies how the spectral data is calculated. The time-series 
can have extra coherent integration applied, and be combined into a single receiver channel. 
Spectral smoothing can be applied by splitting the time-series, and then calculating and 
combining the “split” spectra. The spectral data files can be archived in the same manner as raw 
data files; they are archived into the ARCHIVE directory if data archiving is selected. The spectral 
data files can also be viewed using the Raw Display module (RDDM) in archived data mode. 

The DBS postanalysis performs postanalysis on spectra produced by incoherently averaging 
spectra from individual data acquisitions over an extended time interval. The DBS postanalysis 
uses the same processing procedures as the spectral DBS analysis. The only major difference is 
that the DBS postanalysis is called from the postanalysis monitor rather than the analysis monitor, 
and processes incoherently spectra rather than spectra calculated from individual raw data 
records. The analysed data format and error codes for DBS postanalysis are the same as 
described for the DBS analysis, as described on page 41. As such, the DBS postanalysis results 
can be displayed using the DBS display module. 

Archiving of the incoherently averaged spectra used for DBS postanalysis can be selected from 
the DBS postanalysis configuration utility.

The processing times and spectral data requirements for the DBS postanalysis are specified by the 
DBS postanalysis configuration utility, as described on page 15.
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4.10.15  The MET Analysis Module

4.10.15.1  Description
The MET analysis was written for application to antenna arranged in the 5-antenna "Jones et al" 
configuration, as described in "An improved interferometer design for use with meteor radars", 
Jones et al., Radio Science 33(1), 55-66, 1998. This arrangement allows unambiguous AOAs to be 
determined. The analysis has also been adapted for use in alternative antenna configurations, 
such as hybrid Doppler interferometer (HDI) configurations. However, such configurations may 
not produce an unambiguous AOA. Furthermore, the HDI configuration only allows AOAs to be 
estimated in the plane perpendicular to the inter-antenna separation. The analysis is described in 
an article "The Buckland Park meteor radar - description and initial results", by Holdsworth and 
Reid, which is available from the web page http://www.atrad.com.au/publications.html.

The MET analysis is used to detect underdense meteor echoes and to determine their angles of 
arrival (AOAs), radial velocities, and decay times. The decay times are subsequently used to 
estimate diffusion coefficients. Meteor detection can be performed using one of two techniques. 
"Incoherent detection" involves coherently averaging the time-series for each range to produce an 
effective sampling time of approximately 0.01 seconds, and then averaging the resulting power 
time-series over all receivers. The mean noise level is determined for each range, and events 
where two or more successive points exceed a threshold "D" times the noise level are recorded. 
"Coherent detection" involves splitting the time-series data into separate small (typically 1 
second) segments and applying criteria to determine the presence of a coherent signal. If a 
coherent signal is found, the phase differences between receivers are determined, and the time-
series are combined taking the phase differences into account. At this point, the mean noise level 
is determined for each range, and events where two or more successive points exceed a threshold 
"D" times the noise level are recorded. The detection type and value of D can be configured by the 
user using the MET analysis configuration utility. The AOA for these events are then determined, 
and the time-series are combined and steered to the AOA estimate to improve the SNR and 
determine the mean power time-series. The mean power time-series is subjected to a number of 
criteria in order to reject data which are not indicative of an underdense meteor echo. For the 
events considered underdense, the decay time is estimated using an exponential fit to power time-
series and a linear fit is applied to the phase time-series.

The AOA is calculated as follows. For the 5-antenna Jones et al. configuration, the zero-lag cross-
correlation phases calculated for the appropriate antenna pairs are used to determine the AOA. 
For the HDI configuration, post-statistics steering is used to steer the receive beam through an 
array of directions spanning the range of unambiguous AOAs. The AOA is determined by applying 
a Gaussian fit to the power estimated at each receive beam direction to estimate the direction of 
maximum power. As the AOAs are affected by phase calibration errors, it is important that 
receiver calibration has been performed prior to analysis. Receiver calibration is described in 
“Including receiver calibration estimates in the analysis and display suite“ (Appendix G).

The meteor analysis is capable of resolving events where the PRF may result in range aliasing of 
the meteor echo. For instance, at a PRF of 2 kHz, the data is ranged aliased to the actual range 
modulus 75 km. The analysis software is capable of resolving range ambiguity for most meteor 
events up to PRFs of 2 kHz, but cannot be guaranteed to unambiguously resolve range at PRFs 
above this. 

The analysis applies criteria to assess the likelihood that any detected event is indeed a meteor. 
This includes checking the rise and decay times of the event, and checking the power levels 
before and after the event to ensure there are no coherent signals present. This latter criteria is 
used to reject coherent mesospheric and ionospheric echoes.

ADF version subsequent to version 4.2 support some new analysis parameters. Meteoroid speeds 
are estimated using the Fresnel transform technique, as described in the article “Radar 
observations of meteor trails, and their interpretation using Fresnel holography: a new tool in 
meteor science”, Atmos. Chem. Phys., 4, 911-921, 2004, by W. G. Elford. In the case where a 
meteoroid speed cannot be estimated, a value of zero is written to the analysed data file. Range 
fitting can be used to increase the accuracy of echo range by applying a Gaussian fit to the echo 
range profile. In order to make best use of this facility it is advisable to use PRFs of the order of 
500 Hz to avoid range aliasing, and a range sampling interval small enough to allow each meteor 
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echo to be observed over 4-5 contiguous ranges. Range accuracy can be further enhanced using 
frequency agility, using two frequencies around 10-20 kHz apart.

The MET analysed data can subsequently be used to produce three-dimensional wind velocities 
using the VEL postanalysis. Please refer to the description of the VEL postanalysis on page 51 for 
further information.

Raw data archiving of detected meteor events, both underdense and otherwise, and archiving of 
estimated receiver phase differences can be selected from the MET analysis configuration utility. 
Interference removal may also be selected from the MET analysis configuration utility.

4.10.15.2  Analysed Data File Format
MET analysed data are written to disk in a binary format. Individual data files hold up to 24 hours 
of analysed data and are identified by the year, month, and day during which the data were 
recorded. During continuous data acquisition, each analysed data file begins at midnight, UTC. 
The MET analysed data format is described in more detail in Appendix C: ATRAD Analysed Data
Format.

4.10.15.3  Error Codes
The following table describes the types of error codes produced by the MET analysis.

 

0 No error - analysis result ok.

1 Low SNR

2 Meteor angle of arrival (AOA) may be unambiguously determined (HDI only)

3 No feasible AOA can be determined (all sky only)

4 Large difference in AOAs obtained from different antenna baselines (all sky 
only)

5 Meteor event cannot be analysed because at start or end of time-series

6 Length of event too short for analysis

7 Event rise time too long to be a meteor

8 Decay time less than twice rise time

9 Power level before meteor event too large

10 Power level after meteor event too large

11 Poor fit to meteor event amplitude variation for estimation of decay time

12 Poor fit to meteor event phase variation for estimation of radial velocity

13 Range and AOA estimate does not yield a height lying within the expected 
height range for a meteor (70 to 110 km for VHF radars, 80 - 140 km for MF 
radars)

14 Range and AOA estimate yield more than one height within the expected 
height range for a meteor

15 Radial velocity (or projected horizontal velocity) exceeds 200 m/s

16 Oscillatory event, indicating event is most likely not an underdense meteor

17 Event is most likely a "spike" rather than a meteor
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4.10.16  The MET Display Module

4.10.16.1  Description
The meteor display module (METDM) is a compound widget allowing meteor analysed data to be 
displayed in one of a number of different statistical forms. The MET provides displays of radial 
wind velocities, decay times and diffusion coefficients, SNRs and detection skymaps, and 
histograms of the range, time, zenith and azimuth distributions of the meteor detections. 

The MET Display Module

The METDM widget is divided into four main areas. At the top of the widget is a row of motif-style 
pull-down menus which provide access to all METDM functionality. The menu headings include 
“File”, “Format”, “View”, “Parameter”, “Options”, and “Help”. Immediately below the menu bar 
(from left to right) appear the time of the initial available (“Earliest Data”) record, the time-
duration mode, and the time of the final available record (“Latest Data”). Below these labels 
appears the point-and-click time window and the display window. The time-window displays the 
start and end times for the data currently on display in the display window. 

The METDM allows the display of the estimated horizontal wind velocities, the decay times and 
diffusion coefficients, the returned signal power and the SNR, the skymap of meteor angles of 
arrival, and histograms of the height, range, time, azimuth and zenith angle distributions. The 
wind velocity components displayed are calculated using all meteor echoes within 20 degrees of 
the cardinal directions. The display parameter is selected from the “Parameters” menu. The 
METDM also allows the display of the MET results over the last 24 hours, the last hour, and for 
the last analysed record. The required time-duration is selected from the “View” menu. Recently 
analysed data are automatically read into the display module. In last 24 hour mode the duration 
over which the results are displayed can be selected using the time window. The left and right 
mouse buttons may be used to select the initial and final times, respectively, of the required time-
duration, while the middle mouse button may be used to select an individual record. Archived 
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MET-analysed data-sets for previous days can be viewed and selected using a file selection menu. 
The display formats used for the METDM include average profiles, time-series profiles, and 
contour plots for all parameters, plus vector flow field plots for horizontal and vertical velocities. 
The display format is selected from the “Format” menu. The default display on entering the 
METDM is the average horizontal wind velocity profile for the last hour.

The user also has control over many features of the displayed.  This includes scaling and panning 
of vertical axes, scaling of horizontal axes for average profile plots, the thickness of the lines used 
in the plots, and the size of informative labels included with the display.  These features may be 
chosen from the “Options” menu. Hardcopies of the display can be obtained by selecting the 
"Print" option under the "File" pull down menu heading. This invokes the "Print Utility", allowing 
the current plot to be either be saved to file, or sent to any nominated print queue along with any 
additional command line options to lpr.

The default display on invoking the DBSDM can be selected by the "Set Display as Default" option 
of the "Options" menu once the required parameter and display format has been selected. This 
saves the default parameters to a savefile which is restored on invocation of the DBSDM. If a 
default parameter savefile does not exist, the default display on invocation is the average 
horizontal wind velocity profile for the last hour. If a default parameter savefile exists, the default 
display can be returned to average horizontal wind velocity profile for the last hour by selecting 
the "Delete Default Settings" from  "Options" menu.

4.10.16.2  Keyboard Accelerators
Many of the pull-down menu options are accessible from the keyboard with the use of <ALT>-
<single key> combinations.  For example, the “File” menu options may be invoked with the use 
of <ALT>-O (while in archived data mode)  for “Open”, <ALT>-P for “Print”, and <ALT>-W to “Close” 
the FCADM window.  In addition, the user may use <ALT>-R to display the results of the last 
analysed record, <ALT>-L to display the last hour of analysed records, <ALT>-D to display the last 
24 hours of analysed data records, and <ALT>-A to allow the selection of archived analysed data 
records.  Once in archived data mode, the <ALT>-O option must be used to view other archived 
data sets.  If archived data is not being viewed, the <ALT>-T option can be used to change the 
analysed data tag to be viewed.  A text print-out of the results of the last analysed record can be 
obtained using <ALT>-N.  Outlier rejection can be enabled and disabled using <ALT>-Y. The 
current display format and parameter combination can be saved as the default combination on 
invocation using <ALT>-S. If a default combination has been saved, the default combination can be 
returned to the original values using <ALT>-K. This manual page may be displayed by pressing 
<ALT>-H.

Of particular use are the keyboard accelerators used for changing the scaling of the various data 
displays. The up and down arrows change the scale of the vertical axis. Rapid vertical panning is 
accomplished using the up and down arrow key in combination with the shift key. The left and 
right control the scale of the horizontal axis for average plots and the appropriate parameter scale 
for other formats.

4.10.17   The DSC Analysis Module

4.10.17.1  Description
The Doppler simulator calibration (DSC) analysis determines receiver amplitudes, phases, and 
zero-mean in-phase and quadrature offsets for data collected using the Doppler simulator. The 
results are written in ascii format to the text file “/home/radar/analysis/lib/dopp_sim.dat”.

DSC analysis first estimates the zero-mean mean in-phase and quadrature offsets by taking the 
mean values for each receiver over all height and time samples collected. These values are then 
subtracted from each sample, and the mean amplitude and phase over all height and time samples 
are then determined.
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4.10.18  The MPC Postanalysis Module
The meteor phase correlation (MPC) postanalysis uses the technique described in the paper 
"Interferometric meteor radar phase calibration using meteor echoes", by D. A. Holdsworth, M. 
Tsutsumi, I. M. Reid, T. Nakamura, and T. Tsuda (2004), Radio Science, 39, RS5012, 
doi:10.1029/2003RS003026. This technique is applicable to data collected using the Jones et al. 
configuration. The relative phase offsets between the outside and inside antennas on each 
antenna arm are first determined. This information is then used to produce a grid of phase offsets. 
At each grid position, the echo heights are determined, and the grid position which maximises the 
number of echo height estimates within expected height limits is determined. This process is 
repeated using a new grid of phase offsets centered on the previous phase offset estimate. Once 
the difference between subsequent phase offset estimates is determined, a smaller grid size is 
used. This process is repeated until the difference between subsequent phase offset estimates has 
not converged on a stable solution in five iterations, indicating that the phase offsets have been 
determined as accurately as possible. The grid sizes (and maximum differences) used (in degrees) 
are 180 (10), 45 (10), 20 (5), 10 (3), 5 (1), and 2 (0.5). 

The configuration of the MPC postanalysis is handled by the MPC postanalysis configuration 
utility, allowing the postanalysis to be configured to run in a number of different manners. The 
simplest form involves using a single stage analysis which maximises the number of echoes with 
heights between the "Minimum Height" and "Maximum Height". For a VHF meteor radar, values 
of 70 and 110 km, respectively, are typically used.

A more involved analysis can be configured by selecting "Perform Secondary Calibration". This 
analysis makes use of the fact that reducing the height limits used has been shown to improve the 
accuracy of the phase calibration estimates. Two types of secondary calibration are available: 
"Median", and "Height limit". If "Median" is selected, the calibration is re-performed using all 
heights within the mean plus or minus the standard deviation of the height distribution. If "Height 
limit" is selected, the calibration is re-performed using all heights within the "Minimum Height" 
and "Maximum Height". In this case, it is necessary that these height limits are set to values 
smaller than those used in the initial stage of the calibration. At this stage insufficient testing has 
been performed for determining which mode of secondary calibration yields the best calibration 
estimates, hence the availability of both "Median" and "Height limit" options.

The MPC postanalysis has one subtle difference from other postanalyses: in that it is performed in 
a separate IDL session. This is necessary since the MPC postanalysis can take up to 10 minutes to 
perform. Information on the MPC postanalysis is logged to the file:

$ANALYSIS_DIR/log/mpc_postanal.log.

The MPC analysed data format is described in in Appendix C: ATRAD Analysed Data Format. As 
for all analysed and postanalysed data, the results from the MPC postanalysis are written to daily 
files. To ensure that the data used for MPC postanalysis is performed using data from a single 
UTC day the following postanalysis options must be set: Processing interval = 24 hours, 
Processing duration = 24 hours, Processing interval multiple: Integer + 0.5. This ensures that 
analysis is performed using data from +/- 12 hours centered on 12 UTC.
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4.10.19  The VEL Postanalysis Module

4.10.19.1  Description
The VEL postanalysis is used to determine three dimensional wind velocities from radial velocities 
and angles of arrivals (AOAs) or effective beam directions produced by DBS (both HDI and 
combined) and MET analyses. The analysis can be performed using radial velocities and AOAs 
determined over selected intervals, including over an complete sequence of experiments, or over a 
fixed time interval; for instance, half-hourly, hourly, or two-hourly intervals.

For VEL postanalysis on DBS-HDI and MET radial velocities and effective beam direction/AOA 
pairs, a least squares fit is used to determine the three dimensional wind component at each 
height. A recursive outlier rejection technique is used to remove bad data from the postanalysis. 
An initial estimate of the three dimensional wind velocity is determined, and a "projected" radial 
velocity is obtained by projecting the fitted wind component onto each AOA. The differences 
between the radial velocity and projected radial velocity are calculated, and the standard 
deviation of the differences is calculated. Data whose differences are more than 2.5 times the 
standard deviation are rejected, and the least squares fit is repeated using all remaining good 
data. This process is continued until there are no data where the differences lie outside 2.5 times 
the standard deviation, or until there are less than three points remaining. In the latter case, no 
velocity estimate is possible as a minimum of three radial velocity and AOA pairs is required to 
estimate the three dimensional wind velocity. The VEL postanalysis can be configured to use data 
with SNRs above a selected threshold if required.

For VEL postanalysis of DBS-combined radial velocities, consensus averaging is used to determine 
the average radial velocity from each beam direction. The average radial velocities and beam 
pointing directions are then used in a least squares fit to determine the three dimensional wind 
velocity.

The VEL postanalysis calculates winds from DBS analysed data at all heights where data is 
acquired, and for MET analysed data at 2 km intervals from 70 to 110 km. For DBS analysed data, 
the average SNR and power estimated for each beam direction are determined. 

It should be noted that the VEL postanalysed data are stored as height profiles rather than range 
profiles. 

4.10.19.2  Analysed Data File Format
VEL analysed data are written to disk in a binary format.  Individual data files hold up to 24 hours 
of analysed data and are identified by the year, month, and day during which the data were 
recorded. During continuous data acquisition, each analysed data file begins at midnight, UTC. 
The VEL analysed data format is described in more detail in Appendix C: ATRAD Analysed Data
Format.

4.10.19.3  Error Codes
There are two error codes for VEL postanalysis: 0 indicates the VEL analysis had sufficient data to 
calculate a velocity estimate, while 1 indicates the VEL analysis had insufficient data to calculate 
a velocity estimate.
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4.10.20  The VEL Display Module

4.10.20.1  Description
The velocity analysis display module (VELDM) is a compound widget allowing VEL analysed data 
to be displayed in one of a number of different statistical forms. The VELDM is essentially 
identical to the Full Correlation Analysis Display module (FCADM), as described on page 29.The 
widget is divided into four main areas.  At the top is a row of motif-style pull-down menus which 
provide access to all VELDM functionality.  The menu headings include “File”, “Format”, “View”, 
“Parameter”, “Options”, and “Help”.  Immediately below the menu bar (from left to right) appear 
the time of the initial available (“Earliest Data”) record, the time-duration mode, and the time of 
the final available record (“Latest Data”).  Below these labels appear the point-and-click time 
selection window and the display window.  The time-window displays the start and end times for 
the data currently on display in the display window.

The required display parameter is selected from the “Parameter” menu.  The VELDM also allows 
the display of the VEL results over the last 24 hours, the last hour, or for the last analysed record. 
The required time-duration for the display is selected from the “View” menu.  Recently analysed 
data are automatically read into and displayed by the display module as they become available.  In 
the last 24 hour mode the duration over which the results are displayed can be selected using the 
time selection window.  By placing the mouse cursor within the time selection window, the left 
and right mouse buttons may be used to select the initial and final times, respectively, of the 
required time-duration, while the middle mouse button may be used to select an individual record. 
Archived VEL-analysed data-sets for previous days can be viewed and selected using a file 
selection menu.  The display formats used for the VELDM include average profiles, range- and 
time-series profiles, and image-intensity plots for all parameters, plus monochrome and colour 
vector flow field and “windbarb” plots for horizontal velocities.  The display format required is 
selected from the “Format” menu.  The default display format and time interval on entering the 
VELDM is the average horizontal wind velocity profile for the last hour.

The user also has control over many features of the displayed data, including scaling of the 
horizontal axes for profile average plots, and selection of the size of the informative labels 
included with the display. These features may be chosen from the "Options" menu. Hardcopies of 
the display can be obtained by selecting the "Print" option under the "File" pull down menu 
heading. This invokes the "Print Utility", allowing the current plot to be either be saved to file in 
any of a number of different formats, or sent to any nominated print queue along with any 
additional command line options to "lpr".

The default display on invoking the VELDM can be selected by the "Set Display as Default" option 
from the "Options" menu once the required parameter and display format has been selected. This 
saves the default parameters to a savefile which is restored on invocation of the VELDM. If a 
default parameter savefile does not exist, the default display on invocation is the average 
horizontal wind velocity profile for the last hour. If a default parameter savefile exists, the default 
display can be returned to average horizontal wind velocity profile for the last hour by selecting 
the "Delete Default Settings" from  "Options" menu.

4.10.20.2  Keyboard Accelerators
Many of the pull-down menu options are accessible from the keyboard with the use of <ALT>-
<single key> combinations.  For example, the “File” menu options may be invoked with the use 
of <ALT>-O (while in archived data mode)  for “Open”, <ALT>-P for “Print Postscript”, and <ALT>-W 
to “Close” the FCADM window.  In addition, the user may use <ALT>-R to display the results of the 
last analysed record, <ALT>-L to display the last hour of analysed records, <ALT>-D to display the 
last 24 hours of analysed data records, and <ALT>-A to allow the selection of archived analysed 
data records.  Once in archived data mode, the <ALT>-O option must be used to view other 
archived data sets.  If archived data is not being viewed, the <ALT>-T option can be used to 
change the analysed data tag to be viewed.  A text print-out of the results of the last analysed 
record can be obtained using <ALT>-N.  Outlier rejection can be enabled and disabled using 
<ALT>-Y. The current display format and parameter combination can be saved as the default 
combination on invocation using <ALT>-S. If a default combination has been saved, the default 
combination can be returned to the original values using <ALT>-K. This manual page may be 
displayed by pressing <ALT>-H.
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Of particular use are the keyboard accelerators used for changing the scaling of the various data 
displays.  The up and down arrows change the scale of the vertical axis. Vertical panning is 
accomplished using the up and down arrow key in combination with the shift key.  The left and 
right arrows control the scale of the horizontal axis for average plots and the appropriate 
parameter scale for other formats.

4.10.21   The BUFR Postanalysis Module

4.10.21.1  Description
The BUFR postanalysis produces files of averaged data from FCA and DBS analyses. BUFR is an 
acronym for Binary Universal Format for the Representation of Meteorological data, as 
administered by the World Meteorological Organisation (WMO).

The BUFR postanalysis configuration utility specifies the output of the BUFR postanalysis. The 
utility allows the user to select which form of analysed data (FCA, DBS, or RASS) and which 
analysed data tag to use, the processing duration, and the file type, and whether the file should be 
ftp'd to a remote location. If ftp is required, the remote IP address and directory can be specified.

The processing interval specifies when the BUFR postanalysis should occur, and the relevant data 
to use. For instance, if processing interval is 900 (seconds), the BOM postanalysis will run at 7.5, 
22.5, 37.5 and 52.5 minutes past every even hour, using all the previous 15 minutes of analyed 
data.

The World Meteorological Organisation (WMO) block number, station number and station prefix 
can be specified, as can the station type (usually 2 for a wind profiler), radar beam width, latitude, 
longitude and height above sea level. Data averaging  options can also be specified. Either a 
“mean” or “median” velocity components can be estimated. If “mean” is selected, the mean (M) 
and standard deviation (SD) are estimated. Data outside M +/- N*SD are rejected, where M is 
“Standard Deviation multiple”. The mean and standard deviation are then recalculated. This 
process is repeated until there is no data outside M +/- N*SD, or until the percentage of data 
remaining is below the “Minimum Data Percentage”, in which case a velocity component estimate 
is not made. If the final standard deviation exceeds the “Deviation Threshold” a velocity 
component estimate is not made. If “median” is selected, the median velocity is determined using 
all data within the upper and lower quartiles. If the percentage of data remaining is below the 
“Minimum Data Percentage” a velocity component estimate is not made. If the difference between 
the median and the upper and lower quartiles exceeds the “Deviation Threshold” a velocity 
component estimate is not made. For both “Mean” and “Median” averages, a velocity is reported 
only if an estimate is possible for both velocity components. Only data with SNR exceeding 
“Minimum SNR” are used in the processing.

If ftp is required, the remote IP address can be specified. The specified IP address requires an 
entry in the radar users ".netrc" file with the username and password for ftp for use. Remote file
transfer issues provides information on the use of the ".netrc" file. If ftp is required, the file 
destination corresponds to the directory to store the file on the remote ftp site. If ftp is not 
required, file destination corresponds to the directory to store the file locally.

Multiple configurations may be configured to allow the BUFR postanalysis to run at different 
times with different averaging intervals and analysis types. Multiple copies of the BUFR 
postanalysis may be configured to act on each data set, each with its own unique parameters. For 
example, it is possible to perform two or more BUFR postanalyses on the same analysed data-set, 
allowing, for instance, files to be produced and sent to different destinations, or borh display and 
pilot files to be generated for the same processing interval. Additional configurations are 
composed by choosing the "Add Configuration" or "Copy Configuration" options under the "File" 
menu. "Add Configuration" allows the user to configure a new PFT postanalysis, while "Copy 
Configuration" allows the user to copy the currently displayed postanalysis configuration and 
reconfigure it. Unwanted configurations may be deleted with the "Remove Configuration" option. 
Different configurations may be examined one at a time by clicking on the left and right selection 
buttons the top of the window.
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4.10.22  The BOM Postanalysis Module

4.10.22.1  Description
The Bureau of Meteorology  (BOM) postanalysis produces files of averaged data from FCA, DBS, 
and RASS analyses. The files can be written in one of two different formats specified by the 
Australian Bureau of Meteorology.

The BOM postanalysis configuration utility specifies the output of the BOM postanalysis. The 
utility allows the user to select which form of analysed data (FCA, DBS, or RASS) and which 
analysed data tag to use, the processing duration, and the file type, and whether the file should be 
ftp'd to a remote location. If ftp is required, the remote IP address and directory can be specified.

The processing interval specifies when the BOM postanalysis should occur, and the relevant data 
to use. For instance, if processing interval is 900 (seconds), the BOM postanalysis will run at 7.5, 
22.5, 37.5 and 52.5 minutes past every even hour, using all the previous 15 minutes of analyed 
data.

The World Meteorological Organisation (WMO) number and station name can be specified, along 
with the required file type. The available file types are "Pilot" and "Display" files. The specifies 
WMO station number and name are used in the display file header information and filenames. If 
ftp is required, the remote IP address can be specified. The specified IP address requires an entry 
in the radar users ".netrc" file with the username and password for ftp for use. Remote file
transfer issues provides information on the use of the ".netrc" file. If ftp is required, the file 
destination corresponds to the directory to store the file on the remote ftp site. If ftp is not 
required, file destination corresponds to the directory to store the file locally. The files are also 
locally stored in the directory specified by the “AVERAGE_DATA” environment variable, which is 
setup in the file “/home/radar/analysis/lib/analysisvars” . The default value of the 
“AVERAGE_DATA” environment variable is “/home/RadarData/BomData/”.

Multiple configurations may be configured to allow the BOM postanalysis to run at different times 
with different averaging intervals and analysis types. Multiple copies of the BOM postanalysis may 
be configured to act on each data set, each with its own unique parameters. For example, it is 
possible to perform two or more BOM postanalyses on the same analysed data-set, allowing, for 
instance, files to be produced and sent to different destinations, or borh display and pilot files to 
be generated for the same processing interval. Additional configurations are composed by 
choosing the "Add Configuration" or "Copy Configuration" options under the "File" menu. "Add 
Configuration" allows the user to configure a new PFT postanalysis, while "Copy Configuration" 
allows the user to copy the currently displayed postanalysis configuration and reconfigure it. 
Unwanted configurations may be deleted with the "Remove Configuration" option. Different 
configurations may be examined one at a time by clicking on the left and right selection buttons 
the top of the window.

4.10.23  The MTMP Postanalysis module

4.10.23.1  Description
The MTMP postanalysis is used to determine temperatures from decay times produced by the 
MET analysis. The postanalysis is based on the analysis described in the paper by Holdsworth et 
al., "Antarctic mesospheric temperature estimation using the Davis VHF radar", Journal of 
Geophysical Research, 111, D05108, doi:10.1029/2005JD006589., 2006. Two temperature 
estimates are made: "pressure climatology" (PC) and "temperature gradient climatology" (TGC) 
estimates. PC estimates are made using the mean decay time at the peak height and the 
climatological pressure estimate at that height. TGC estimates are made using the estimated slope 
of the log diffusion coefficient versus height scatter plot and the height distribution weighted 
climatological temperature gradient.

The pressure and temperature gradient climatologies are derived using the NRLMSIS model 
(Picone et al., "Enhanced Empirical Models of the Thermosphere", Physics and Chemistry of the 
Earth, Part C: Solar, Terrestrial & Planetary Science, 25(5), 2000, 537-542) derived using the 
latitude and longitude of the radar site. The NRLMSIS model data is stored as an array of daily 
values at heights between 60 and 120 km at 1 km intervals. The model data is stored as IDL 
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savefiles in the mtmp_press.dat and mtmp_temp.dat files, located in $ANALYSIS_DIR/lib 
directory.

The option for users to create their own pressure and temperature gradient climatologies is also 
available. This may be desireable where locally derived pressure and temperature gradient 
measurements are available, such as those derived from in-situ measurements. First, a peak 
height model can be setup in the file mtmp_peak_height.dat, containing a 365 element array 
"peak_ht_model" containing the peak heights for each day of the year. Use of this climatology can 
be configured invoking the "User Peak Height Climatology" option. Second, a pressure 
climatology at the peak height can be setup in the file "mtmp_pres_peak_height.dat", containing 
a 365 element array "press_peak_ht_model" containing the pressure climatology at the peak 
height for each day of the year. Use of this climatology can be configured invoking the "User 
Pressure Climatology" option. Third, a temperature gradient climatology at the peak height can be 
setup in the file "mtmp_temp_grad_peak_height.dat", containing a 365 element array 
"temp_grad_peak_ht_model" containing the temperature gradient climatology at the peak height 
for each day of the year. Use of this climatology can be configured invoking the "User Temp. 
Gradient Climatology" option.

The processing interval, offset, and duration specify when the post-analysis should occur, and the 
relevant data to use. All of these times are specified in seconds. The processing interval specifies 
the interval between successive postanalyses. The processing offset specifies the offset from the 
multiple of the processing interval for the postanalysis to be performed. The processing duration 
specifies the duration of data to use for the postanalysis. The processing interval multiple 
specifies whether the analysed data should be centered on a multiple of the processing multiple, 
or an integer plus half multiple. For instance, if meteor temperature estimation is to be performed 
on the data from a single universal time day, the processing interval should be set to 24 hours, the 
processing duration to 24 hours, and the processing multiple to an integer plus half multiple (i.e. 
centered on the middle of the day).  The postanalysis is ideally performed using 24 hours of MET 
analysed data to ensure there is sufficient data for a statistically accurate temperature estimate to 
be made. The analysis can be performed over selected intervals; for instance, half-hourly, hourly, 
or two-hourly intervals. However, no guarantees are given for the reliability of temperature 
estimates made at such short time intervals.

Multiple copies of the postanalysis may be configured to act on each data set, each with its own 
unique parameters. For example, it is possible to perform two or more MTMP post-analyses on the 
same analysed data-set, allowing, for instance, plot files of velocity profiles and power image plots 
to be produced. Additional configurations are composed by choosing the "Add Configuration" or 
"Copy Configuration" options under the "File" menu. "Add Configuration" allows the user to 
configure a new MTMP postanalysis, while "Copy Configuration" allows the user to copy the 
currently displayed postanalysis configuration and reconfigure it. Unwanted configurations may 
be deleted with the "Remove Configuration" option. Different configurations may be examined one 
at a time by clicking on the left and right selection buttons near the top of the window. 

4.10.23.2  Analysed Data File Format
MTMP postanalysed data are written to disk in a binary format. Individual data files hold up to 24 
hours of analysed data and are identified by the year, month, and day during which the data were 
recorded. During continuous data acquisition, each postanalysed data file begins at midnight, 
UTC. The MTMP analysed data format is described in more detail in Appendix C: ATRAD Analysed 
Data Format.

4.10.23.3  Error codes
There are no error codes for MTMP postanalysis. When a temperature estimate is not made the 
pressure and temperature gradient climatology temperatures is set to zero. Pressure and 
temperature gradient climatology temperature estimates are not made if there are less than 100 
echoes available for processing. A temperature climatology temperature estimate is not made if 
the slope of the log diffusion coefficient Vs height variation cannot be estimated.

4.10.24  The MRAD Postanalysis Module
The meteor radiant determination (MRAD) postanalysis uses meteor (MET) analysis observations 
for measuring meteor radiants. This postanalysis is based on the technique described in Jones, J., 
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Jones, W. Meteor radiant activity mapping using single-station radar observations. Mon. Not. R. 
Astron. Soc. 367 (3), 1050-1056, doi:10.1111/j.1365-2966.2006.10025.x, 2006.

The meteor radiant of an echo lies on a great circle aligned perpendicularly to the vector from the 
radar to the meteor trail. The MRAD postanalysis exploits the perpendicularity condition by 
forming a two-dimensional histogram in right ascension (RA) and declination (DEC) of the great 
circle for each echo. Well-defined sources of meteors, such as meteor showers, result in a narrow 
maximum in the RA/DEC histogram. In the standard implementation of this technique, the great 
circle for each echo is assigned a finite “passband” width to account for angle of arrival errors 
and the finite width of radiant sources. This is effectively equivalent to convolving the great circle 
with a “top-hat” convolution function, which is non-ideal since the response for a point radiant has 
a very diffuse halo, which has the potential to obscure weak radiants. This led Jones and Jones 
(2006) to propose a new convolution function which enhances the apparent activity of meteor 
shower radiants, allowing the detection of a number of weak showers that have not been 
previously catalogued.  The MRAD postanalysis RA-DEC histogram uses 1 degree intervals in RA 
and DEC. The RA dimension is dependent on the location of the radar and covers the range of RAs 
from which the radar can receive meteor echoes, while the DEC dimension is 360. A "pass band 
width" of 4 degrees is used.

The MRAD postanalysis requires a site file:

$ANALYSIS_DIR/lib/site.dat

This is an IDL savefile that contains the PRF, antenna coordinates, radar frequency (for MPC 
postanalysis) and latitude and longitude (for MRAD postanalysis). This file is required as this 
information is not contained in the MET analysed data files used for MRAD postanalysis.

The configuration of the MRAD postanalysis is handled by the MRAD postanalysis configuration 
utility, allowing the postanalysis to be configured to run in a number of different manners.

Like the MPC postanalysis, the MRAD postanalysis is performed in a separate IDL session. This is 
necessary since the MRAD postanalysis can take up to 4 minutes to perform. Information on the 
MRAD postanalysis is logged to the file:

$ANALYSIS_DIR/log/mrad_postanal.log

The MRAD analysed data format is described in in Appendix C: ATRAD Analysed Data Format. As 
for all analysed and postanalysed data, the results from the MRAD postanalysis are written to 
daily files. To ensure that the data used for MRAD postanalysis is performed using data from a 
single UTC day the following postanalysis options must be set: Processing interval = 24 hours, 
Processing duration = 24 hours, Processing interval multiple: Integer + 0.5. This ensures that 
analysis is performed using data from +/- 12 hours centered on 12 UTC.

4.10.25  The AFT Postanalysis Module

4.10.25.1  Description
The Analysis File Transfer (AFT) postanalysis produces files of averaged data from FCA, DBS, and 
RASS analyses. 

The AFT postanalysis configuration utility specifies the output of the AFT postanalysis. The utility 
allows the user to select which form of analysed data (FCA or DBS) and which analysed data tag 
to use, the processing duration, and the file type, and whether the file should be ftp'd to a remote 
location. If ftp is required, the remote IP address and directory can be specified.

The processing interval specifies when the AFT postanalysis should occur, and the relevant data 
to use. For instance, if processing interval is 900 (seconds) , the AFT postanalysis will run at 7.5, 
22.5, 37.5 and 52.5 minutes past every even hour, using the previous 15 minutes of analyed data.

Data averaging options can be specified. Either a “mean” or “median” velocity components can be 
estimated. If “mean” is selected, the mean (M) and standard deviation (SD) are estimated.  Data 
outside M +/- N*SD are rejected, where M is “Standard Deviation multiple”. The mean and 
standard deviation are then recalculated. This process is repeated until there is no data outside M 
+/- N*SD, or until the percentage of data remaining is below the “Minimum Data Percentage”, in 
which case a velocity component estimate is not made. If the final standard deviation exceeds the 
“Deviation Threshold” a velocity component estimate is not made. If “median” is selected, the 
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median velocity is determined using all data within the upper and lower quartiles. If the 
percentage of data remaining is below the “Minimum Data Percentage” a velocity component 
estimate is not made. If the difference between the median and the upper and lower quartiles 
exceeds the “Deviation Threshold” a velocity component estimate is not made. For both “Mean” 
and “Median” averages, a velocity is reported only if an estimate is possible for both velocity 
components. Only data with SNR exceeding “Minimum SNR” are used in the processing.

If ftp is required, the remote IP address can be specified. The specified IP address requires an 
entry in the radar users ".netrc" file with the username and password for ftp for use. Remote file
transfer issues provides information on the use of the ".netrc" file. If ftp is required, the file 
destination corresponds to the directory to store the file on the remote ftp site. If ftp is not 
required, file destination corresponds to the directory to store the file locally. The files are also 
locally stored in the directory specified by the “AVERAGE_DATA” environment variable, which is 
setup in the file “/home/radar/analysis/lib/analysisvars” . The default value of the 
“AVERAGE_DATA” environment variable is “/home/RadarData/AverageData/”.

Multiple configurations may be configured to allow the AFT postanalysis to run at different times 
with different averaging intervals and analysis types. Multiple copies of the AFT postanalysis may 
be configured to act on each data set, each with its own unique parameters. For example, it is 
possible to perform two or more AFT postanalyses on the same analysed data-set, allowing, for 
instance, files to be produced and sent to different destinations, or borh display and pilot files to 
be generated for the same processing interval. Additional configurations are composed by 
choosing the "Add Configuration" or "Copy Configuration" options under the "File" menu. "Add 
Configuration" allows the user to configure a new PFT postanalysis, while "Copy Configuration" 
allows the user to copy the currently displayed postanalysis configuration and reconfigure it. 
Unwanted configurations may be deleted with the "Remove Configuration" option. Different 
configurations may be examined one at a time by clicking on the left and right selection buttons 
the top of the window.
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4.10.26   The PFT Postanalysis Module

4.10.26.1  Description
The Plot File Transfer (PFT) postanalysis produces files containing plots of analysed data. Any plot 
available from the relevant display module (e.g. FCA Display for FCA data) can be selected.

The PFT postanalysis configuration utility specifies the output of the PFT postanalysis, as 
described on page 15. The analysed data type, analysis parameter, display format, color table, file 
format and processing and data time information used for PFT postanalysis are configured 
through the PFT postanalysis configuration utility. The plots can be stored in "Postscript", 
"Greyscale Postscript", "PNG", "TIFF", "BMP" and "JPEG" file formats. If ftp of the files is 
required, the remote IP address can be specified. The specified IP address requires an entry in the 
radar users ".netrc" file with the username and password for ftp for use. Remote file transfer
issues provides information on the use of the ".netrc" file. If ftp is required, the file destination 
corresponds to the directory to store the file on the remote ftp site. If ftp is not required, file 
destination corresponds to the directory to store the file locally. The files can also be time-
stamped if required.

Multiple configurations may be configured to allow the PFT postanalysis to run  at different times 
with different averaging intervals and analysis types. Multiple copies of the PFT postanalysis may 
be configured to act on each data set, each with its own unique parameters. For example, it is 
possible to perform two or more PFT postanalyses on the same analysed data-set, allowing, for 
instance, display and pilot files to be produced and sent to different destinations, or various plots 
of same or different parameters from the same data-set to be produced. Additional configurations 
are composed by choosing the "Add Configuration" or "Copy Configuration" options under the 
"File" menu. "Add Configuration" allows the user to configure a new PFT postanalysis, while 
"Copy Configuration" allows the user to copy the currently displayed postanalysis configuration 
and reconfigure it. Unwanted configurations may be deleted with the "Remove Configuration" 
option. Different configurations may be examined one at a time by clicking on the left and right 
selection buttons near the top of the window.

Note that if the PFT postanalysis produced files are to be used for display on a web page, PNG 
format is recommended as it is the most efficient format in terms of file size.
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4.10.27  The Data Management Utility

4.10.27.1  Description
The Data Management Utility (DMU) is a compound widget allowing the management of Analysed 
data. The utility allows the data to be backed up to a backup medium and to a local backup 
directory, and also allows the data from the local backup directory to be deleted once the data has 
been archived off-site.

The DMU is divided into four main areas. At the top of the widget are four motif-style pull-down 
menus which provides access to DMU functionality. This includes the "File" menu, including the 
"Close" option for closing the widget, and the "Help" menu, which includes information about the 
Data Management Utility version number and this help information. Below this is the "Backup 
Information Area" Below this is the "Analysed data selection area", which is a text display window 
in which the relevant analysed data files are displayed. The bottom area is the "Hint Display Area" 
which provides useful information about the functionality of the area over which the cursor is 
placed.

The DMU has two modes of operation, namely "Backup" and "Delete". The appropriate mode can 
be selected from the "Data Mode" option of the "Control" menu. If "Backup" Data Mode is 
selected, the "Backup" option allows data backup once file selection is made from the analysed 
data files list. File selection is made using the left mouse "Backup" option allows data backup once 
file selection is made from the analysed data files list. File selection is made using the left mouse 
button. Multiple files can be selected by dragging the mouse with the left mouse button held 
down. Holding down the <SHIFT> key and an item selects the range from the previously selected 
item to the item. Holding down the <CTRL> key and clicking an item toggles item between the 
selected and unselected state. Data is copied to a configured backup medium (e.g. JAZ disk, ZIP 
disk), and also moved to a backup directory on the local machine. If "Delete" Data Mode is 
selected, the analysed data file list shows the contents of the local backup directory, and allows 
these to be deleted once file selection is made. The user is asked to confirm the deletion once the 
Display option is chosen.

The "Backup Information Area" provides information on the available disk space, the analysed and 
local backup directory sizes, the specified backup directories, the mount status of the backup 
medium and it's available disk space, and the selected file sizes. If the Backup Medium Mount 
Directory or the Local Backup Directory are labelled "Undefined", they may be defined from the 
"Options" pull down menu via the "Change Backup Medium Mount Directory'" and "Change Local 
Backup Directory" options. This launches a "pickfile" widget allowing the user to select the 
desired directory. The default directories of the backup medium and local backup directories are 
specified by the environment variables BACKUP_DIR and ANALYSED_BACKUP, respectively. 
These environment variables are  defined in the file “/home/radar/analysis/lib/analysisvars”.

4.10.27.2  Keyboard Accelerators
The pull-down menu options are accessible from the keyboard ith the use of <ALT>-<single key> 
combinations. For example, the "File" menu options may be invoked with the use of <ALT>-W to 
close the widget. This manual page may be displayed by pressing <ALT>-H.
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4.10.28  The Housekeeping Raw Data Utility

4.10.28.1  Description
The Housekeeping Utility is a compound widget allowing raw data file housekeeping data to be 
displayed.

The Housekeeping Utility is divided into four main areas. At the top of the widget are two motif-
style pull-down menus which provides access to Housekeeping Utility functionality. Below this is a 
text display window in which the housekeeping data is displayed. Below this are the "Update" 
button and "Auto Update" check-box. Pressing update button results in the housekeeping data 
from the most recent raw data file being displayed. Selecting "Auto Update" check-box results in 
the text display being continually updated with the housekeeping data of the most recent raw data 
file. The bottom area is the "Hint Display Area" which provides useful information about the 
functionality of the area over which the cursor is placed.

The "File" menu includes the "Open" option for opening a raw data file of display, the "Save As..." 
option for saving the current text display window contents to file, the "Print" option for printing 
the current text display window contents to file, and the "Close" option for closing the widget. The 
"Help" menu includes this information about the Housekeeping Utility version number and this 
help information.  

4.10.28.2  Keyboard Accelerators
The pull-down menu options are accessible from the keyboard with the use of <ALT>-<single 
key> combinations. For example, the File menu options may be invoked with the use of <ALT>-O 
for Open File, <ALT>-P for Print File, and <ALT>-W to close the widget. This manual page may be 
displayed by pressing <ALT>-H.

4.10.29  The Analysis Utility

4.10.29.1  Description
The Analysis Utility (AU) is a compound widget allowing archived raw data to be analysed by the 
analysis monitor.

The Analysis Utility is divided into five main areas. At the top of the widget is a row of motif-style 
pull-down menus which provide access to some AU functionality. The menu headings include 
"File" and "Help". The "File" menu includes the "Close" option for closing the widget. The "Help" 
menu allows access to information about the Analysis Utility, the version number, and this help 
information. Immediately below the menu bar appears the data selection pull-down menus, and 
the "Spool raw data" selector. Below these appears the file list allowing selection of raw data files 
to be analysed. Immediately below this are a row of three buttons allowing the analysis to be 
started and stopped, and the window to be closed. The bottom area is the "Hint Display Area" 
which provides useful information about the functionality of the area over which the cursor is 
placed.

The data selection pull-down menus allow the selection of the data directory and data filename 
particulars. The "Archived Data Directory" menu provides a "pickfile" window allowing the user to 
select the directory containing the archived data to be analysed.  The required directory can be 
selected by either manually entering the directory name in the "Filter" window, or by selecting the 
appropriate directory from the "Directories" field using the left mouse button, which allows the 
user to step through the directory structure. Once the required directory is selected, the "OK" 
button should selected, and the window will disappear. The "Filter" menu provides a dialog 
window allowing a file filter to be selected. The "Experiment tag" menu provides a window 
allowing the selection of any of the available experiment tags existing in the archived data 
directory. The "Spool raw data" option specifies how the data is to be presented for analysis. If the 
"Enable" option is chosen, the data from the selected files is written to individual raw data files 
which are spooled in temporal order in the ACQSPOOL directory. This is analogous to the way raw 
data is analysed on-line. If the "Disable" option is chosen, the data from each selected archived 
data file is analysed in sequence before proceeding to the next selected archived data file. This is 
analogous to the way raw data is analysed by selecting the "File|Analyse Archived Data" from the 
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"Analysis and Display Control" window, with the exception that more than one archived data file 
can be selected. The appropriate selection for the "Spool raw data" option depends on the analysis 
is required. If the resulting analysed data is to be postanalysed, it is important that the data is 
analysed in sequence. In this case, the "Enable" option should be selected. If the resulting 
analysed data is not to be postanalysed, the "Disable" option should be chosen, as it will result in 
quicker analysis without unnecessarily writing the data to individual raw data files. 

The file list allows the selection of archived raw data files to be analysed. This list is updated if 
any of the data selection pull-down menus are used. File selection is made using the left mouse 
button. Multiple files can be selected by dragging the mouse with the left mouse button held 
down. Holding down the <SHIFT> key and clicking an item selects the range from the previously 
selected item to the new item. Holding down the <CTRL> key and clicking an item toggles that 
item between the selected and unselected state. All files on the list can be selected using the 
"Select All" button at the end of the list.

The "Start Analysis" button commences the analysis of the selected raw data files. This button 
becomes active once a selection has been made. The "Stop Analysis" button stops the analysis. 
This button becomes active when analysis of archived raw data has commenced. The "Close 
Utility" button allows the utility to be closed.

4.10.29.2  Keyboard Accelerators
The pull-down menu options are accessible from the keyboard with the use of <ALT>-<single 
key> combinations. <ALT>-W closes the widget. This manual page may be displayed using <ALT>-H. 

4.10.29.3  Resizing Facility
The widget may be resized as desired.

4.10.29.4  Environment Variables
ACQSPOOL: The directory where individual raw data files are placed.

4.10.29.5  Files
Analysis Utility usage is logged to the file $ANALYSIS_DIR/log/display.log. A background 
process $ANALYSIS_DIR/libexec/analyse_archived.sh is started to handle the production of 
raw data for analysis. This processing is logged to the file 
$ANALYSIS_DIR/log/analyse_archived.log The analysis of the raw data is handled by the 
analysis monitor. This processing is logged to the file: $ANALYSIS_DIR/log/analysis.log
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4.10.30  The Postanalysis Utility

4.10.30.1  Description
The Postanalysis Utility (PU) is a compound widget allowing analysed data to be postanalysed by 
the postanalysis monitor.

The Postanalysis Utility is divided into five main areas. At the top of the widget is a row of motif-
style pull-down menus which provide access to some PU functionality. The menu headings include 
"File" and "Help". The "File" menu includes the "Close" option for closing the widget.The "Help" 
menu allows access to information about the Analysis Utility, the version number, and this help 
information.

Immediately below the menu bar appears the data selection pull-down menus. Below these 
appears the file list allowing selection of analysed data files to be analysed. Immediately below 
this are a row of three buttons allowing the analysis to be started and stopped, and the window to 
be closed. The bottom area is the "Hint Display Area" which provides useful information about the 
functionality of the area over which the cursor is placed.

The data selection pull-down menus allow the selection of the data directory and data filename 
particulars. The "Analysed Data Directory" menu provides a "pickfile" window allowing the user to 
select the directory containing the analysed data to be analysed. The required directory can be 
selected by either manually entering the directory name in the "Filter" window, or by selecting the 
appropriate directory from the "Directories" field using the left mouse button, which allows the 
user to step through the directory structure. Once the required directory is selected, the "OK" 
button should selected, and the window will disappear. The "Filter" menu provides a dialog 
window allowing a file filter to be selected. The "Experiment tag" menu provides a window 
allowing the selection of any of the available experiment tags existing in the analysed data 
directory. The "Suffix" menu provides a dialog window allows a suffix to be selected.

The file list allows the selection of analysed analysed data files to be postanalysed. This list is 
updated if any of the data selection pull-down menus are used. File selection is made using the 
left mouse button. Multiple files can be selected by dragging the mouse with the left mouse button 
held down. Holding down the <SHIFT> key and clicking an item selects the range from the 
previously selected item to the new item. Holding down the <CTRL> key and clicking an item 
toggles that  item between the selected and unselected state. All files on the list can be selected 
using the "Select All" button at the end of the list.

The "Start Postanalysis" button commences the analysis of the selected analysed data files. This 
button becomes active once a selection has been made. The "Stop Postanalysis" button stops the 
analysis. This button becomes active when postanalysis of analysed data has commenced. The 
"Close Utility" button allows the utility to be closed.

4.10.30.2  Keyboard Accelerators
The pull-down menu options are accessible from the keyboard with the use of <ALT>-<single 
key> combinations. <ALT>-W closes the widget. This manual page may be displayed using <ALT>-H. 

4.10.30.3  Resizing Facility
The widget may be resized as desired.

4.10.30.4  Files
Postanalysis Utility usage is logged to the file $ANALYSIS_DIR/log/display.log. The postanalysis 
of the analysed data is handled by the postanalysis monitor. This processing is logged to the file 
$ANALYSIS_DIR/log/postanal.log. Users should consult these log file for further information on 
any problems observed using Postanalysis Utility.
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5.  APPENDICES

5.1  Appendix A: ATRAD Raw Data Format 
The following notes describe the raw data file format used for ATRAD radar systems. This format 
is known  as “ATRAD Data Format” (ADF). Each ADF raw data file consists of a sequence of 
“records”. Each file includes “Sequence”, “Experiment”, “Site Parameter”, “Acquisition”, and raw 
data records.  Raw data files written by radars with extra functionality (e.g. beam steering) 
include extra records describing the parameters relevant to this functionality. The order in which 
parameter records appear is not defined, except that the raw data record is guaranteed to appear 
last.

Individual data records are written to separate files by the acquisition software, but may be 
appended to larger, contiguous data sets if raw data archiving is selected from the Analysis and 
Display Control GUI. 

5.1.1  Explanatory Notes
1. Each ADF raw data file begins with a four longword information header made up of [File 

magic number, Number of ADF records in file, Time stamp, Not used]. The first element 
(32 bits) is the magic number and revision number. The file magic number is 0x1200xxxx, 
where xxxx is the revision number of the file as a whole.  The number of ADF records 
refers to the total number of information records (each type of which is detailed below) 
contained in the entire file. For archived raw data files, the fourth element of the header 
contains the time stamp of the last raw data record contained in the file.

2. Each parameter record is preceded by a four longword information header. The first 
element is the magic number and revision number for that parameter block. The second 
element is the length (in bytes) of the parameter block. The third longword is the time at 
which the parameter block was written (Unix format). The fourth longword is the offset (in 
bytes) in the file of the beginning of the parameters.

3. A “Sequence” is defined as a set of different acquisition configurations which are to be 
scheduled in some way and repeated some number of times.  A Sequence is initiated by 
the user through the Radar Configuration , and no hardware needs to be manually 
configured during the lifetime of a Sequence.

4. Each different experimental configuration within a sequence is defined as an 
“Experiment”.  An Experiment is defined by the user through the Radar Configuration, 
and selected for scheduling in some order (relative to other experiments) within the 
Sequence.  Once defined, an Experiment may be scheduled as often or as rarely as the 
user desires.

5. An “Acquisition” is defined as a single complete data set acquired under a certain 
configuration.  One or more Acquisitions make up an Experiment.  At this time, the only 
difference in configuration between Acquisitions within a single Experiment is the beam 
pointing direction.

6. The boolean data type specified in the following list may take values of zero, 
corresponding to “false”, or “no”, or it may be non-zero, signifying “true”, or “yes”.

7. Data sizes are given as 8-bit bytes, and all data types are integer multiples of 4 bytes.

8. Multiple-byte integers are written as signed, network order entities.

9. Floating point numbers are written as 4-byte IEEE floats.

10. The raw data are written as 16-bit signed quantities.

11. Strings are null-terminated and thus may store one less character than the allotted space 
in bytes.

12. Receiver test parameters are hard-coded and do not appear in the data 

13. Data format revisions are recorded in the magic number system using the least significant 
16 bit of the number.  Header revision numbers are independent of each other.
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5.1.2  Sequence Parameter Record
Magic number: 0x1201xxxx where “xxxx” is the revision number of the record.

Revision 0x0001:

Parameter Description Data Type Data Size Allowable Values

File ID An identification number for radar 
system consisting of radar model 
and serial number.

Integer 4 E.g., 7004, 1201

Sequence Name The name for the sequence of 
experiments specified for this data 
set.

String 80 E.g., Spring 
Rocket sequence, 
1997.

Number of 
Background 
Events

The number of  background events 
for the complete sequence (1 - 
based).

Integer 4 1 - ?

Number of 
Scheduled 
Events

The number of scheduled events 
for

this sequence

Integer 4 0 - ?

Scheduling 
interval

The number of seconds between 
experiment starts (or a multiple of 
this number of seconds).

Integer 4 20 - 231

Rx Test 
Schedule

The number of Sequence cycles 
between Rx calibration tests. (Zero 
implies no testing.)

Integer 4 0 - 231

5.1.3  Experiment Parameter Record
Magic number: 0x1202xxxx where “xxxx” is the revision number of the record. 

Revision 0x0001:

Parameter Description Data Type Data Size Allowable Values

Experiment 
Name

The name and/or description of the 
experiment corresponding to the 
following data.

String 80 E.g., 
Tropospheric 
wind profiling 
using FCA.

Experiment Tag The tag name given to the 
following experiment.

String 80 E.g., TRWP

Number of 
Repetitions

The number of times the 
experiment is to run.

Integer 4 1 - 231

Pulse Repetition 
Frequency

The PRF used for this experiment 
in Hertz.

Integer 4 1 - 5x105

Number of Data 
Points

The number of coherently-
averaged data points collected in 
each acquisition cycle for this 
experiment.

Integer 4 1 - 231

Number of 
Coherent 
Integrations

The number of coherent 
integrations performed on each 
acquired data point for this 
experiment

Integer 4 1 (none) - 4096

Zero Range 
Calibration

The value of the software-specified 
range marker calibration delay in 
nanoseconds.

Integer 4 0 - ?

Number of 
Receiving 
Channels

The number of receiving channels 
used for data acquisition

Integer 4 1 - 16

Active The active receiving channels used Integer 4 x 16 1 - 16
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Parameter Description Data Type Data Size Allowable Values

Receiving 
Channels

for data acquisition (1-based). Array

Number of 
Transmitting 
Channels

The number of receiving channels 
used for data acquisition

Integer 4 1 - 16

Active 
Transmitting

Channels

The active transmitting channels 
used for data acquisition (1-based).

Integer 
Array

4 x 16 1 - 16

Transmitter 
output 
amplitude 
percentage     

The output amplitude percentage 
(relative to maximum amplitude) of 
the active Tx channels

Integer 4 0 - 100

Dual Range 
Sampling Active

Whether two sampling regions are 
active or not

Boolean 4 0, 1

Phase inversion 
Active

Whether or not phase is inverted 
on Successive Tx pulses

Boolean 4 0, 1

Tx Polarisation 
Inversion Active

Whether of not the transmitted 
polarisation is inverted for 
successive acquired data points.

Boolean 4 0, 1

Rx Polarisation 
Inversion Active

Whether of not the received 
polarisation is inverted for 
successive acquired data points.

Boolean 4 0, 1

Lowest Range 1 The first (lowest) sampled range 
for the first sampling region (m).

Integer 4 0 - ?

Range Interval 
1

The range interval between 
samples in the first sampling 
region (m).

Integer 4 0 - ?

Range extent 1 The range of sampled ranges in the 
first sampling region (m).

Integer 4 0 - ?

Lowest Range 
21

The first (lowest) sampled range 
for the second sampling region 
(m).

Integer 4 0 - ?

Range Interval 
2

The range interval between 
samples in the second sampling 
region.

Integer 4 0 - ?

Range extent 2 The range of sampled ranges in the 
second sampling region (m).

Integer 4 0 - ?

Tx Polarisation The polarisation used for 
transmission. (0 = “O”, 1 = “E”, 2 
= interleaved O and E).

Integer 4 0, 1, 2, 3

Rx Polarisation The polarisation used for 
reception. (0 = “O”, 1 = “E”, 2 = 
interleaved O and E).

Integer 4 0, 1, 2, 3

Receiver Filter 
width

The receiver filter width (= 
receiver bandwidth/2) (Hz)

Float 4 ?

5.1.4  Site Parameter Record
Magic number: 0x1203xxxx where “xxxx” is the revision number of the record.

Revision number: 0x0002

1 Note that Lowest Range2 is higher than Lowest Range 1 and that the two regions may not overlap. If 
dual range sampling is not active (or if dual range sampling is not implemented) then all “Range 2” 
values will be zero.

ATRAD Page 67 of 110



AT R A D
DISPLAY AND ANALYSIS SOFTWARE REFERENCE MANUAL

Parameter Description Data Type Data Size Allowable Values

Site Name The name of the physical location 
of the radar system

String 80 chars ?

Nominal 
Frequency

The nominal operating frequency 
(Hz)

Float 4 ?

Latitude The latitude of the site (+ = North, 

 - = South)

Integer 
Array

3 x 4 ?

Longitude The longitude of the (+ = East, 

- = West)

Integer 
Array

3 x 4 ?

Altitude The altitude of the site above sea 
level (in meters)

Float 4 ?

GPS present Timing handled by GPS Boolean 4 0,1

Number Tx Number of transmit antenna 
groups.

Integer 4 1 - ?

Number Rx Number of receive antenna groups. Integer 4 1 - ?

Tx Antenna 
Coordinates

The antenna coordinates of the Tx 
antennas in (range, bearing) pairs. 
(Number Tx) Pairs, metres and 
degrees relative to any arbitrary 
zero.

Float Array 4 x 
(Number 
Tx) x 2

Range: 0.0 - 
± 1038 metres

Bearing: 0.0 - 
360.0°

Tx Antenna 
Names

The names or descriptions of the 
transmitter antenna groups.

String Array 80 x 
(Number 
Tx)

E.g. Folded 
dipole array

Rx Antenna 
Coordinates

The antenna coordinates of the Rx 
antennas in (range, bearing) pairs. 
(Number Rx) Pairs, metres and 
degrees relative to any arbitrary 
zero.

Float Array 4 x 
(Number 
Rx) x 2

Range: 0.0 - 
± 1038 m

Bearing: 0.0 - 
360.0°

Rx Antenna 
orientation

The orientation of the receiving 
antennas in (azimuth, zenith) pairs

Float Array 4 x 
(Number 
Rx) x 2

Azimuth: 0.0 – 
360.0°
Zenith:, 0.0 – 
90.0°

Rx Antenna 
Names

The names or descriptions of the 
receiver antenna groups.

String Array 80 x 
(Number 
Rx)

E.g. Meteor 
array
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5.1.5  Gain Control Record
Magic number: 0x1204xxxx where “xxxx” is the revision number of the record.

Revision 0x0002:

Parameter Description Data Type Data Size Allowable Values

Gain Algorithm 
Number

The number of the gain calculation 
algorithm to use. (Zero implies no 
dynamic gain control.)

Integer 4 0 (in the first 
instance)

Dual Gain 
Regime Active`

Whether dual gain regimes are in 
use.

Boolean 4 0 (in the first 
instance)

Rx Gains1 The Rx gains applicable to this data 
set (16 values in dB). If dual gain 
regime active, then these gains 
correspond to the lower range gain 
range.

Integer 
Array

4 x 16 = 
64

E.g., 62 - 122

Rx Gains2 The Rx gains applicable to this data 
set (16 values in dB) if dual gain 
regime active. These gains 
correspond to the upper range gain 
range.

Integer 
Array

4 x 16 = 
64

E.g., 62 - 122

Rx Gain 
Minimum

The minimum gain supported by 
the hardware (dB).

Ìnteger 4 E.g., 0 dB

Rx Gain 
Maximum

The maximum gain supported by 
the hardware (dB).

Ìnteger 4 E.g., 80 dB

5.1.6  Acquisition Parameter Record
Magic number: 0x1206xxxx where “xxxx” is the revision number of the record.

Revision 0x0002:

Parameter Description Data Type Data Size Allowable Values

Time Stamp The time at which the acquisition 
began (Unix time format).

Time 4 0 - 

Time Stamp – 
Vector

The time stamp of the acquisition 
stored as a six element integer 
vector; [Year, Month, Date, Hour, 
Min, Sec].  Year is 4-digit, month 
and date are 1-based.  The format 
is GMT.

Integer 
Array

4 x 6 = 24 E.g., [1996, 12, 
31, 23, 59, 59]

Acquisition 
Number

The number of the current 
acquisition

Integer 4 1 - 232

Background or 
scheduled event 

Whether the experiment is a 
background or scheduled event.

Integer 4 0 = Background

1 = Scheduled

Sequence Event 
Number     

The number of the experiment in 
the sequence (1-based) 

Integer 4 1 - ?

GPS locked Indicates whether GPS was locked 
through acquisition of data-set

Boolean 4 0,1
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5.1.7  Tx Pulse Record 
Magic number: 0x1207xxxx where “xxxx” is the revision number of the record.

Revision 0x0001:

Parameter Description Data Type Data 
Size

Allowable Values

Pulse Mode The mode of Tx pulse operation. 0 = 
normal or coded pulses, 1 = pulse 
pair transmission.

Integer 4 0 or 1

Pulse Width The width of the Tx pulse in metres. 
This is the baud length if coded 
pulses are in use.

Integer 4 100, 125, 150,….

Tx Pulse 
Shape

The pulse shape used for 
transmission. (For example, 1 = 
Gaussian, 2 = Square, 3 = 
Triangular, 4 = “Normal”)

Integer 4 1, 2, 3, 4

Pulse 
Separation

The distance (in metres) between 
the two pulses if pulse pair mode is 
selected.

Integer 4 15000 typical, but 0 
in the first instance

Number of 
Codes

The number of codes transmitted. 0 
= uncoded, 1 = Barker code, 2 = 
Complementary codes.

Integer 4 0, 1, 2

Code Length The number of “bits” or “bauds” in 
the code.

Integer 4 2 - 64

Pulse Codes The pulse codes themselves. These 
are two 64-bit values, least 
significant bit corresponds to the 
LAST code element transmitted.

Long-
Integer 
array

8 x 2 = 
16

0 - (264-1)

External 
Triggering 
Active

Whether external triggering of Tx 
pulses enabled

Boolean 4 0, 1

5.1.8  RASS Generator Record
Magic number: 0x1209xxxx where “xxxx” is the revision number of the record.

Revision 0x0001:

Parameter Description Data Type Data 
Size

Allowable Values

RASS Mode The mode of operation of the RASS 
generator.

Integer 4 1 = Triangular Sweep

2 = Sawtooth Sweep

Start Frequency The start frequency of the audio 
sweep in Hertz.

Float 4 100 Hz typical

Step Size The frequency interval between 
successive frequencies in the 
sweep in Hertz.

Float 4 0.5 Hz typical

Number of 
Steps

The number of discrete frequency 
steps used in the sweep.

Integer 4 40 steps typical

Step Dwell Time The amount of time spent on each 
frequency in the sweep or in the 
pseudo-random spectrum in ms.

Integer 4 20 ms typical
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5.1.9  Beam steering record
Magic number: 0x120axxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data 
Size

Allowable Values

Number of 
beam directions

The number (N) of point-to-point 
beam directions present in this 
acquisition

Integer 4 1 - ?

Beam directions An array of [azimuth, zenith] pairs 
indicating the beam directions 
present in this acquisition.

Float Array 4 x N x 
2

Azimuth = 0 - 360 
degrees, Zenith = 0 
to 90 degrees

5.1.10  Frequency Agility record
Magic number: 0x120cxxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data 
Size

Allowable Values

Number of 
frequencies

The number (N) of frequencies 
present in this acquisition

Integer 4 1 - ?

Frequencies An array of frequencies present in 
this acquisition.

Float Array 4 x N Frequency (Hz)

5.1.11  Receiver calibration record (ADAC)
Magic number: 0x120dxxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data 
Size

Allowable Values

Number of 
phases

The number (N) of phases present 
in this acquisition (default = 3)

Integer 4 3 - ?

Phases An array of phases present in this 
acquisition.

Float Array 4 x N Phases (degrees)

5.1.12  Beam offset record (ADAC)
Magic number: 0x120exxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data 
Size

Allowable Values

Offset Direction offset introduced by cable 
delays in the antenna array

Integer 4 -90 – 90 degrees
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5.1.13  Phase table record
Magic number: 0x120fxxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data 
Size

Allowable Values

Number of 
phase tables

The number (N) of phases present 
in this acquisition (default = 3)

Integer 4 3 - ?

Rx Phase flag Flag to indicate whether Rx phases 
are equal to Tx phases.

Integer 4 0: all rx phases = 0

1: rx phases equal to 
tx phases

Transmitter 
phases [1-N]

An array of [phase table number] 
[Transmitters 1-M] indicating the 
phases of the transmitter.  For 
corssed dipoles, phases are the 
reference phase values (N-S 
default)

Float array N x 4 x 
M (1)

Phase = 0-360°

Set to -1 if tx is 
disabled

Revision 0x0001:

Parameter Description Data Type Data 
Size

Allowable Values

Number of 
phase tables

The number (N) of phases present 
in this acquisition (default = 3)

Integer 4 3 - ?

Rx Phase flag Flag to indicate whether Rx phases 
are equal to Tx phases.

Integer 4 0: all rx phases = 0

1: rx phases equal to 
tx phases

Transmitter 
phases [1-N]

An array of [phase table number] 
[Transmitters 1-M] indicating the 
phases of the transmitter.  For 
corssed dipoles, phases are the 
reference phase values (N-S 
default)

Float array N x 4 x 
M (1)

Phase = 0-360°

Set to -1 if tx is 
disabled

Effective beam 
direction

The effective beam direction 
(azimth, zenith) of the beam formed 
by each phase table

Float array N x 4 x 2 Azimuth: 0-180°

Zenith: 0-90°

Effective beam 
width

The effecitve beam width of the 
beam formed by each phase table

Float array N x 4 0-180°

Notes:

1) M is the number of tx, as written to site parameter record.

2) Currently the phase table record is written only by APAC MF radars using a hardware 
type of 4, 5 or 6.

3) For APAC MF radars (hardware types 4, 5 or 6), the phase table is always written if a 
beam steering record is written.  It is also written if the beam direction is specified in 
terms of 1 or more phase tables.
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5.1.14  Interference Removal Data Record
Magic number: 0x1250xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data 
Size

Allowable Values

Secondary data 
start range 

The start of the secondary data 
range in kilometres.

Float 4 0 - ?

Secondary data 
end range

The end of the secondary data 
range in kilometres.

Float 4 0 - ?

5.1.15  Raw Data Record
Magic number: 0x1280xxxx where “xxxx” is the revision number of the record. 

Revision 0x0000: IP/QP components appear in the data with QP data records preceding IP data 
records.

Revision 0x0001: IP/QP components appear in the data with IP data records preceding QP data 
records.

Dimensionally the data record is arranged in majority order as follows; Range (lowest first), 
Channel, Component, Point.  In the case of multiplexed data, each receiver channel’s data (from 
more than one antenna input) is stored as a single channel.  No de-multiplexing is performed by 
the acquisition software.  Similarly, for point-to-point beam steered data acquisition, sequential 
beam directions appear in the raw data in an interleaved fashion.

Data is written as 2-byte integers.

The following table illustrates the order in which data are stored:
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Lowest Range Channel 1 Component 1 (IP) Point 1, Point 2,…..

Component 2 (QP) ……….

Channel 2 …………

…….

Next Range Channel 1

Channel 2

……..

………….

5.1.16  Coded Raw Data Record
Magic number: 0x1281xxxx where “xxxx” is the revision number of the record.

Revision 0x0001: IP/QP components appear in the data with IP data records preceding QP data 
records.

The coded data are arranged identically to the “normal” raw data. For two part codes, the second 
set of coded data immediately follows the first, and the number of points stored in the coded data 
record will be twice as many as the number of decoded points. The number of ranges written to 
the experiment is N-1 larger than the number of heights that would be present in the decoded 
data as configured using the experiment editor, where N is the bit-length of the code in use. The 
additional ranges correspond to range gates above those configured as required by the decoding 
process.
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5.2  Appendix B: ATRAD SPEC, AOA and COVF Data Format
The following notes describe the data file format produced by SPEC, COVF and IDI analyses, 
which are available with version 3 of the ATRAD IDL analysis and display suite (ADS).  This format 
uses the same conventions as the ATRAD Raw data format (or ADF) as discussed in Appendix A:
ATRAD Raw Data Format. Each file includes “Sequence”, “Experiment”, “Site Parameter”, 
“Acquisition”, and SPEC, AOA, and COVF data records.  Data files written by radars with extra 
functionality (e.g. beam steering) include extra records describing the parameters relevant to this 
functionality. The order in which parameter records appear is not defined, except that the data 
record is guaranteed to appear last.

Individual data records are written to separate files by the analysis monitor, but may be appended 
to larger, contiguous data sets if data archiving is selected from the Analysis and Display Control 
GUI. 

5.2.1  SPEC parameter Record
Magic number: 0x1220xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data 
Size

Allowable Values

Interference 
rejection

Whether interference rejection 
applied  in analysis

Boolean 4 0 = NO, 1 = YES

Sea scatter flag. Whether sea scatter removal 
applied in analysis

Boolean 4 0 = NO, 1 = YES

Sea scatter ratio 
threshold

The ratio threshold for sea scatter 
removal

Float 4 0.5 Hz typical

Sea scatter 
frequency width

The frequency (full-) width used for 
sea scatter removal

Integer 4 ? m/s

Sea scatter 
application 
ranges

The ranges between which sea 
scatter removal applied (inclusive)

Integer 
Array

4 x 2 ? km

Splitting flag The number of time-series split to 
produce spectra

Integer 4 1 - ?

Time-series 
combining flag

Indicates whether time-series have 
been combined

Boolean 4 0 = NO, 1 = YES

Combine map The active receiving channels used 
for time-series combining (1-
based).

Integer 
Array

4 x 2 ? km

5.2.2  SPEC Magnitude Data Record
Magic number: 0x1221xxxx where “xxxx” is the revision number of the record. 

Revision 0x0000: Dimensionally the data record is arranged in majority order as follows: Beam 
direction, Split Index, Range (lowest first), Channel, Spectral point.

5.2.3  SPEC Complex Data Record
Magic number: 0x1222xxxx where “xxxx” is the revision number of the record. 

Revision 0x0000: Dimensionally the data record is arranged in majority order as follows: Beam 
direction, Split Index, Range (lowest first), Channel, Component (IP first), Spectral point.
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5.2.4  SPEC information Record
Magic number: 0x1223xxxx where “xxxx” is the revision number of the record. 

Revision 0x0000: 

Parameter Description Data Type Data 
Size

Allowable Values

Number of 
spectra 
averaged

Number of spectra averaged to 
produce spectra

Integer As 
below

1-?

Error flag Error status of spectra Integer As 
below

0 = good data, 1 = 
bad data

Dimensionally the data record is arranged in majority order as follows: Beam direction, Split 
Index, Range (lowest first), Channel, Component (IP first), Data.

5.2.5  AOA parameter Record
Magic number: 0x1230xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data 
Size

Allowable Values

Number of 
AOAs

The number of AOAs (and radial 
velocities) included in file

Boolean 4 1 - ?

Interference 
rejection

Whether interference rejection 
applied  in analysis

Boolean 4 0 = NO, 1 = YES

Sea scatter flag. Whether sea scatter removal 
applied in analysis

Boolean 4 0 = NO, 1 = YES

Sea scatter ratio 
threshold

The ratio threshold for sea scatter 
removal

Float 4 0.5 Hz typical

Sea scatter 
frequency width

The frequency (full-) width used for 
sea scatter removal

Integer 4 ? m/s

Sea scatter 
application 
ranges

The ranges between which sea 
scatter removal applied (inclusive)

Integer 
Array

4 x 2 ? km

5.2.6  AOA SNR/Power Record
Magic number: 0x1231xxxx where “xxxx” is the revision number of the record. 

Revision 0x0000: 

Parameter Description Data Type Data 
Size

Allowable Values

SNR array Array containing estimated SNR for 
each range gate

Float 4 x No. 
of 
heights

?

Power array Array containing estimated power 
for each range gate

Float 4 x No. 
of 
heights

?
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5.2.7  AOA Data Record
Magic number: 0x1232xxxx where “xxxx” is the revision number of the record. 

Revision 0x0000: 

Parameter Description Data Type Data 
Size

Allowable Values

Radial velocity 
array

Array containing radial velocities Float 4 x No. 
of AOAs

?

Scatterer 
positions array

Array containing (x, y, z) positions 
of scattering locations

Float 4 x No. 
of AOAs

?

5.2.8  COVF parameter Record
Magic number: 0x1240xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data 
Size

Allowable Values

Number of lags The number of lags calculated for 
covariance functions

Integer 4 1 - ?

Number of pairs Number of receiver channel pairs 
used to calculate covariance 
functions

Integer 4 1 - ?

ACOVF map Map of channels for which auto 
covariance functions calculated

Integer 
Array

4 x ? 1 - ?

COVF map Map of channels for which cross-
covariance functions calculated

Integer 
Array

4 x ? 1 - ?

Interference 
rejection

Whether interference rejection 
applied  in analysis

Boolean 4 0 = NO, 1 = YES

Sea scatter flag. Whether sea scatter removal 
applied in analysis

Boolean 4 0 = NO, 1 = YES

Sea scatter ratio 
threshold

The ratio threshold for sea scatter 
removal

Float 4 0.5 Hz typical

Sea scatter 
frequency width

The frequency (full-) width used for 
sea scatter removal

Integer 4 ? m/s

Sea scatter 
application 
ranges

The ranges between which sea 
scatter removal applied (inclusive)

Integer 
Array

4 x 2 ? km

Splitting flag The number of time-series split to 
produce spectra

Integer 4 1 - ?

Time-series 
combining flag

Indicates whether time-series have 
been combined

Boolean 4 0 = NO, 1 = YES

Combine map The active receiving channels used 
for time-series combining (1-
based).

Integer 
Array

4 x 2 ? km

Number of 
ACOVFs

The number of auto-covariance 
functions calculated

Integer 4 1 - ?

Number of 
CCOVFs

The number of cross-covariance 
functions calculated 

Integer 4 1 - ?
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5.2.9  COVF Autocovariance Function Data Record 
Magic number: 0x1241xxx where “xxxx” is the revision number of the record. 

Revision 0x0000: Dimensionally the data record is arranged in majority order as follows: Beam 
direction, Split Index, Range (lowest first), Channel, Component (IP first) , Lag (zero to largest 
positive). 

5.2.10  COVF Cross-covariance Data Record
Magic number: 0x1242xxxx where “xxxx” is the revision number of the record.

Revision 0x0000: Dimensionally the data record is arranged in majority order as follows: Beam 
direction, Split Index, Range (lowest first), Channel, Component (IP first), Lag (zero to largest 
positive). 
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5.3  Appendix C: ATRAD Analysed Data Format
A new analysed data format has been introduced with version 3 of the ATRAD IDL analysis and 
display suite (ADS). This format uses similar conventions to the ATRAD raw data format (ADF). 
The revised data format has several advantages over the previous data format:

1. the data is stored more economically. File sizes for some analyses are reduced by up to 
40%.

2. the display modules are able to read in the data faster. This is a result of the information 
required for reading in the data being more readily accessible, and due to the more 
economical format.

3. the use of "revision numbers" for different analysis versions. This allows the ADS to 
handle data written by analyses updated to include extra output parameters. For instance, 
with version 3 the ADS, the full correlation analysis (FCA) can be used to calculate and 
store the mean angle of arrival (MAOA) and the vertical velocity corrected for the effects 
of the MAOA being off-zenith if receiver calibration is used. There is no simple manner for 
including such extra information using the previous data format.

4. the use of "revision numbers" also means that fields not used in a particular analysis (e.g. 
aspect sensitivity and effective beam direction for "combined" DBS) which are necessarily 
stored (as zero fields) in the previous data format are not included in the revised analysed 
data records.

5. the storage of housekeeping information, such as the receiver channels used for analysis, 
which is not stored in the previous format, can be stored in the revised format.

The following notes describe the analysed data file. The analysed data is written to daily files as 
described on page 15. The files are written in external data representation (XDR) for cross-
platform compatibility.

5.3.1  Explanatory Notes
Each ADF analysed data file begins with a four longword information header made up of [File 
magic number, Number of ADF records in file, Time stamp of first record in file, Time stamp of 
last record in file]. The first element (32 bits) is the magic number and revision number. The file 
magic number is 0x2000xxxx, where xxxx is the revision number of the file as a whole.  The 
number of AADF records refers to the total number of information records (each type of which is 
detailed below) contained in the entire file. 

Each parameter record is preceded by a four longword information header. The first element is 
the magic number and revision number for that parameter block. The second element is the 
length (in bytes) of the parameter block. The third longword is the time at which the parameter 
block was written (Unix format). The fourth longword is the offset (in bytes) in the file of the 
beginning of the parameters.

An analysed data record is stored after its applicable parameter record.  Since an analysed data 
file usually contains more than one data point, a single analysed data file will typically contain 
multiple sets of parameter and analysed data records.

All data sizes are given as 8-bit bytes, and all data types are integer multiples of 4 bytes.

Multiple-byte integers are written as signed, network order entities.

Data format revisions are recorded in the magic number system using the least significant 16 bit 
of the number.  Header revision numbers are independent of each other.

Note that all velocities are specified in terms of the direction in which the wind is heading. All 
vertical and radial velocities are specified as positive in the direction away from the radar, such 
that positive vertical velocities are upwards.

All analysed data records are stored from lowest to highest range.

5.3.2  FCA parameter Record.
Magic number: 0x2010xxxx where “xxxx” is the revision number of the record. 
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Revision 0x0001:

Parameter Description Data Type Data Size Allowable Values

Number of 
Receiving 
Channels

The number of receiving channels 
used for data analysis (N)

Integer 4 1 - 16

Active 
Receiving 
Channels

The active receiving channels used 
for data acquisition (and hence 
SNR calculation) (1-based)

Integer 
Array

4 x N 1 - ?

FCA Receiving 
channels 

The four receiving channels used 
for  full correlation analysis (1-
based)

Integer 
Array

4 x 4 1- ?

Lowest Range 1 The first (lowest) sampled range 
for the first sampling region (m).

Integer 4 0 - ?

Range Interval 
1

The range interval between 
samples in the first sampling 
region (m).

Integer 4 0 - ?

Range extent 1 The range of sampled ranges in the 
first sampling region (m).

Integer 4 0 - ?

Radar 
frequency

The operating frequency of the 
radar in Hz during this experiment.

Float 4 0 - ?, Hz

5.3.3  FCA Analysed Data Records
Magic number: 0x2011xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data Size Allowable Values

Error code Analysis error code Integer 4 01/19/09

Apparent 
velocity

Apparent velocity components 
(Zonal, Meridional)

Float Array 4 x 2 ?,  ms-1

True velocity True velocity components (Zonal, 
Meridional)

Float Array 4 x 2 ?, ms-1

Vertical velocity Vertical velocity (upwards  = 
positive)

Float 4 ?, ms-1

Fading time Mean auto-correlation function 
half-width

Float 4 0 - ?, s

Pattern lifetime Fading time in the frame of the 
ground diffraction pattern

Float 4 0 - ?, s

Pattern scale Major axis of the characteristic 
ellipse

Float 4 0 - ?, m

Axial ratio Ratio of the major to minor axes of 
the characteristic ellipse

Float 4 1 - ?

Axial rotation Direction of major axis of 
characteristic ellipse, East of North

Float 4 0 - ?, degrees

Percentage time 
discrepancy

Ratio of sum of cross-correlation 
function maximum delay times to 
sum of absolute cross-correlation 
function delay times.

Integer 4 0 - 100, %

SNR The signal to noise ratios for each 
receiver channel data collected on

Float Array 4 x Number 
of Channels

?, dB

Amplitude The amplitude for each receiver 
channel data collected on

Float Array 4 x Number 
of Channels

?, Square root of 
digitisation units
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Revision number 0x0001: This includes fields for the mean angle of arrival and corrected vertical 
velocity if these quantities are calculated in the analysis.

Parameter Description Data Type Data Size Allowable Values

Error code Analysis error code Integer 4 1 - 18

Apparent 
velocity

Apparent velocity components 
(Zonal, Meridional)

Float Array 4 x 2 ?,  ms-1

True velocity True velocity components (Zonal, 
Meridional)

Float Array 4 x 2 ?, ms-1

Vertical velocity Vertical velocity (upwards  = 
positive)

Float 4 ?, ms-1

Corrected 
Vertical velocity

Vertical velocity corrected for 
effects of off-zenith mean angle of 
arrival (upwards  = positive)

Float 4 ?, ms-1

Mean angle of 
arrival

Mean angle of arrival in cartesian 
coordinates

Float Array 4 x 2 -90 – 90, degrees

Fading time Mean auto-correlation function 
half-width

Float 4 0 - ?, s

Pattern lifetime Fading time in the frame of the 
ground diffraction pattern

Float 4 0 - ?, s

Pattern scale Major axis of the characteristic 
ellipse

Float 4 0 - ?, m

Axial ratio Ratio of the major to minor axes of 
the characteristic ellipse

Float 4 1 - ?

Axial rotation Direction of major axis of 
characteristic ellipse, East of North

Float 4 0 - ?, degrees

Percentage time 
discrepancy

Ratio of sum of cross-correlation 
function maximum delay times to 
sum of absolute cross-correlation 
function delay times.

Integer 4 0 - 100 %

SNR The signal to noise ratios for each 
receiver channel data collected on

Float Array 4 x Number 
of channels

?, dB

Amplitude The amplitude for each receiver 
channel data collected on

Float Array 4 x Number 
of channels

?, Square root of 
digitisation units
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5.3.4  DAE/DPE Analysed Data Records
Magic number: 0x2021xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data Size Allowable Values

Error code Overall analysis error code Integer 4 0 - 2

DAE Error code DAE error code Integer 4 0 - 5

DPE Error code DPE error code Integer 4 0 - 6

DAE electron 
density

Electron density calculated by DAE 
analysis

Float 4 ?, Electrons per 
cm-3

DPE electron 
density

Electron density calculated by DPE 
analysis

Float 4 ?, Electrons per 
cm-3

Amplitude ratio Amplitude ratio of X- to O-mode 
signal amplitudes

Float 4 0 - ?

Reflection 
coefficient ratio

Reflection coefficient ratio of X- to 
O-mode signal amplitudes

Float 4 0 - ?

Phase 
difference

Difference of X- minus O-mode 
signal phases

Float 4  ?, degrees

Reflection 
coefficient 
phase 
difference

Difference of X- minus O-mode 
reflection coefficient phases

Float 4 0 - ?, degrees

O-mode power Ordinary mode power Float 4 0 - ?, W

X-mode power Extraordinary mode power Float 4 0 - ?, W

Revision 0x0001: Applicable to systems without point-to-point mode interleaving

Parameter Description Data Type Data Size Allowable Values

Error code Overall analysis error code Integer 4 0 - 2

DAE Error code DAE error code Integer 4 0 - 5

DAE electron 
density

Electron density calculated by DAE 
analysis

Float 4 ?, Electrons per 
cm-3

Amplitude ratio Amplitude ratio of X- to O-mode 
signal amplitudes

Float 4 0 - ?

Reflection 
coefficient ratio

Reflection coefficient ratio of X- to 
O-mode signal amplitudes

Float 4 0 - ?

O-mode power Ordinary mode power Float 4 0 - ?, W

X-mode power Extraordinary mode power Float 4 0 - ?, W
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5.3.5  Beam Steering Data Record.
Magic number: 0x2030xxxx where “xxxx” is the revision number of the record. Applicable for DBS 
and RASS analyses.

Parameter Description Data Type Data Size Allowable Values

Number of 
Receiving 
Channels

The number of receiving channels 
used for data analysis (N)

Integer 4 1 - 16

Receiving 
Channels

The receiving channels used for 
data analysis (1-based).

Integer 
Array

4 x N 1 - ?

Lowest Range 1 The first (lowest) sampled range 
for the first sampling region (m).

Integer 4 0 - ?

Range Interval 
1

The range interval between 
samples in the first sampling 
region (m).

Integer 4 0 - ?

Range extent 1 The range of sampled ranges in the 
first sampling region (m).

Integer 4 0 - ?

Radar 
frequency

The operating frequency of the 
radar in MHz during this 
experiment.

Float 4 0 - ?

Transmit Beam 
direction

The transmit beam direction used 
during this experiment in polar 
coordinates.

Float array 4 x 2 Azimuth = 0 – 
360

Zenith = 0 - 90

Nyquist velocity The maximum unambiguous radial 
velocity used in the analysis

Float 4 0 - ? ms-1

5.3.6  DBS Analysed Data Records
Magic number: 0x2031xxxx where “xxxx” is the revision number of the record. 

Revision 0x0000: used for hybrid Doppler interferometer DBS analysis

Parameter Description Data Type Data Size Allowable Values

Error code Analysis error code Integer 4 0 - 2

Effective beam 
direction

The effective beam pointing 
direction

Float Array 4 x 2 Azimuth = 0 – 
360,

Zenith = 0 – 90,

degrees

Radial velocity Radial velocity Float 4 ?, ms-1

Aspect 
sensitivity

Aspect sensitivity parameter (e-1 

half width of effective polar 
diagram)

Float 4 0 - ?, degrees

Spectral width Spectral width Float 4 0 - ?, ms-1

SNR Signal to noise ratio Float 4 ?, dB

Power Signal power Float 4 0 - ?, dB

Revision 0x0001: used for single channel or combined DBS analysis:
Parameter Description Data Type Data Size Allowable Values

Error code Analysis error code Integer 4 0 - 2

Radial velocity Radial velocity Float 4 ?, ms-1

Spectral width Spectral width Float 4 0 - ?, ms-1
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Parameter Description Data Type Data Size Allowable Values

SNR Signal to noise ratio Float 4 ?, dB

Power Signal power Float 4 0 - ?, dB

5.3.7  MET Parameter Record
Magic number: 0x2050xxxx where “xxxx” is the revision number of the record.

Revision 0x0001: phase differences not stored

Parameter Description Data Type Data Size Allowable Values

Number of 
Ranges

The number of ranges included in 
the analysed data record

Integer 4 0 - ?2

Radar 
frequency

The operating frequency of the 
radar in Hz during this experiment.

Float 4 0 - ?

Transmit Beam 
direction

The transmit beam direction used 
during this experiment.

Integer 
array

4 x 2 Azimuth = 0 – 
360

Zenith = 0 - 90

Nyquist velocity The maximum unambiguous radial 
velocity used in the analysis

Float 4 0 - ? ms-1

GPS locked Indicates whether GPS was locked 
through acquisition of data-set

Boolean 4 0,1

Number of 
Receiving 
Channels

The number of receiving channels 
used for data analysis (N)

Integer 4 1 - 16

Receiving 
Channels

The receiving channels used for 
data analysis (1-based).

Integer 
Array

4 x N 1 - ?

Revision 0x0002: phase differences stored

Parameter Description Data Type Data Size Allowable Values

Number of 
Ranges

The number of ranges included in 
the analysed data record

Integer 4 0 - ?84 

Radar 
frequency

The operating frequency of the 
radar in Hz during this experiment.

Float 4 0 - ?

Transmit Beam 
direction

The transmit beam direction used 
during this experiment.

Integer 
array

4 x 2 Azimuth = 0 – 
360

Zenith = 0 - 90

Nyquist velocity The maximum unambiguous radial 
velocity used in the analysis

Float 4 0 - ? ms-1

Phase 
Difference Pairs

The number of pairs (Np) of phase 
differences stored to file

Integer 4 0 - ?

GPS locked Indicates whether GPS was locked 
through acquisition of data-set

Boolean 4 0,1

Number of 
Receiving 
Channels

The number of receiving channels 
used for data analysis (N)

Integer 4 1 - 16

Receiving 
Channels

The receiving channels used for 
data analysis (1-based).

Integer 
Array

4 x N 1 - ?

Antenna Pairs The antenna pairs used for phase Integer 4 x 2 x Np 0 - ?

2 A number of ranges equals zero means there were no detected meteor events in this 
record. In this case, a MET analysed data record will not follow the parameter record. 
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Parameter Description Data Type Data Size Allowable Values

differences

5.3.8  MET Analysed Data Records
Magic number: 0x2051xxxx where “xxxx” is the revision number of the record.

Revision 0x0001: phase differences not stored

Parameter Description Data Type Data Size Allowable Values

Event Start 
Time

The start time of the event from 
the start of the data acquisition 
period (as recorded in MET 
parameter record) 

Float 4 0 - ?, s

Range Range Float 4 0 - ?, km

Error code Analysis error code Integer 4 0 - 2

SNR Signal to noise ratio of detected 
event

Float 4 ?, dB

Power Signal power of detected event.
Note: Power(dB) = 20log(Power)

Float 4 0 - ?, (ADC units)2

Angle of arrival The angle of arrival of the detected 
meteor

Float Array 4 x 2 Azimuth = 0 – 
360,

Zenith = 0 – 90,

degrees

Decay time Decay time Float 4 0 - ?, s

Decay time 
error

Error in decay time estimate Float 4 0 - ?, s

Diffusion 
coefficient

Diffusion coefficient Float 4 0 - ?, s

Diffusion 
coefficient error

Error in diffusion coefficient 
estimate

Float 4 0 - ?, s

Radial velocity Radial velocity Float 4 ?, ms-1

Radial velocity 
error

Error in radial velocity estimate Float 4 ?, ms-1

Revision 0x0002: phase differences stored

Parameter Description Data Type Data Size Allowable Values

Event Start 
Time

The start time of the event from 
the start

of the data acquisition period

Float 4 0 - ?, s

Range Range Float 4 0 - ?, km

Error code Analysis error code Integer 4 0 - 17

SNR Signal to noise ratio of detected 
event

Float 4 ?, dB

Power Signal power of detected event.
Note: Power(dB) = 20log(Power)

Float 4 0 - ?, (ADC units)2

Angle of arrival The angle of arrival of the detected 
meteor

Float Array 4 x 2 Azimuth = 0 – 
360,

Zenith = 0 – 90,

degrees
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Parameter Description Data Type Data Size Allowable Values

Decay time Decay time Float 4 0 - ?, s

Decay time 
error

Error in decay time estimate Float 4 0 - ?, s

Diffusion 
coefficient

Diffusion coefficient Float 4 0 - ?, s

Diffusion 
coefficient error

Error in diffusion coefficient 
estimate

Float 4 0 - ?, s

Radial velocity Radial velocity Float 4 ?, ms-1

Radial velocity 
error

Error in radial velocity estimate Float 4 ?, ms-1

Phase 
Differences

Phase differences for the number 
of pairs used (Np), and mean phase 
difference error 

Float Array 4 x (Np +1) 0 to 360 degrees

Revision 0x0003: meteoroid speeds stored

Parameter Description Data Type Data Size Allowable Values

Event Start 
Time

The start time of the event from 
the start

of the data acquisition period

Float 4 0 - ?, s

Range Range Float 4 0 - ?, km

Error code Analysis error code Integer 4 0 - 2

SNR Signal to noise ratio of detected 
event

Float 4 ?, dB

Power Signal power of detected event.
Note: Power(dB) = 20log(Power)

Float 4 0 - ?, (ADC units)2

Angle of arrival The angle of arrival of the detected 
meteor

Float Array 4 x 2 Azimuth = 0 – 
360,

Zenith = 0 – 90,

degrees

Decay time Decay time Float 4 0 - ?, s

Decay time 
error

Error in decay time estimate Float 4 0 - ?, s

Diffusion 
coefficient

Diffusion coefficient Float 4 0 - ?, s

Diffusion 
coefficient error

Error in diffusion coefficient 
estimate

Float 4 0 - ?, s

Radial velocity Radial velocity Float 4 ?, ms-1

Radial velocity 
error

Error in radial velocity estimate Float 4 ?, ms-1

Meteoroid 
speed

Meteoroid speed Float 4 0 - ?, ms-1

Meteoroid 
speed error

Meteoroid speed error Float 4 0 - ?,  ms-1

“Fitted” range 
estimate

Range estimate obtained by 
Gaussian fit to echo range profile

Float 4 0 to ? km

“Frequency 
agility” range 
estimate

Range estimate obtained using 
frequency agility

Float 4 0 to ? km
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Revision 0x0004: phase differences and meteoroid speeds stored

Parameter Description Data Type Data Size Allowable Values

Event Start 
Time

The start time of the event from 
the start of the data acquisition 
period

Float 4 0 - ?, s

Range Range Float 4 0 - ?, km

Error code Analysis error code Integer 4 0 - 2

SNR Signal to noise ratio of detected 
event

Float 4 ?, dB

Power Signal power of detected event.
Note: Power(dB) = 20log(Power)

Float 4 0 - ?, (ADC units)2

Angle of arrival The angle of arrival of the detected 
meteor

Float Array 4 x 2 Azimuth = 0 – 
360,

Zenith = 0 – 90,

degrees

Decay time Decay time Float 4 0 - ?, s

Decay time 
error

Error in decay time estimate Float 4 0 - ?, s

Diffusion 
coefficient

Diffusion coefficient Float 4 0 - ?, s

Diffusion 
coefficient error

Error in diffusion coefficient 
estimate

Float 4 0 - ?, s

Radial velocity Radial velocity Float 4 ?, ms-1

Radial velocity 
error

Error in radial velocity estimate Float 4 ?, ms-1

Meteoroid 
speed

Meteoroid speed Float 4 0 - ?, ms-1

Meteoroid 
speed error

Meteoroid speed error Float 4 0 - ?, ms-1

“Fitted” range 
estimate

Range estimate obtained by 
Gaussian fit to echo range profile

Float 4 0 to ? km

“Frequency 
agility” range 
estimate

Range estimate obtained using 
frequency agility

Float 4 0 to ? km

Phase 
Differences

Phase differences for the number 
of pairs used (Np), and mean phase 
difference error 

Float Array 4 x (Np +1) 0 to 360 degrees

5.3.9  VEL Record (non beam steering)
Magic number: 0x2070xxxx where “xxxx” is the revision number of the record. Used if VEL 
analysis is applied to vertical beam DBS or all sky meteor system MET analysed data.

Revision 0x0000: Used for results which do not use beam steering (e.g. all sky meteor)

Parameter Description Data Type Data Size Allowable Values

Lowest height 1 The first (lowest) sampled height 
for the first sampling region (m).

Integer 4 0 - ?

Height Interval 
1

The height interval between 
samples in the first sampling 
region (m).

Integer 4 0 - ?
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Parameter Description Data Type Data Size Allowable Values

Height extent 1 The range of sampled heights in 
the first sampling region (m).

Integer 4 0 - ?

5.3.10  VEL Parameter Record (beam steering)
Magic number: 0x2080xxxx where “xxxx” is the revision number of the record. Used if VEL 
analysis is applied to multi-beam DBS or MET analysed data.

Revision 0x0000: 

Parameter Description Data Type Data Size Allowable Values

Lowest height 1 The first (lowest) sampled height 
for the first sampling region (m).

Integer 4 0 - ?

Height Interval 
1

The height interval between 
samples in the first sampling 
region (m).

Integer 4 0 - ?

Height extent 1 The range of sampled heights in 
the first sampling region (m).

Integer 4 0 - ?

Number of 
beam directions

The number (N) of beam directions 
used to produce results

Integer 4 1 - ?

Beam directions The transmit beam direction used 
during this experiment in polar 
coordinates.

Float Array 4 x N x 2 Azimuth = 0 – 
360

Zenith = 0 - 90

5.3.11  VEL-MET Postanalysed Data Record
Magic number: 0x2071xxxx where “xxxx” is the revision number of the record.

Revision 0x0001:

Parameter Description Data Type Data Size Allowable Values

Error code Analysis error code Integer 4 1 - 18

Horizontal 
Velocity

Horizontal velocity components 
(Zonal, Meridional)

Float Array 4 x 2 ?, ms-1

Vertical velocity Vertical velocity (upwards  = 
positive)

Float 4 ?, ms-1

Number of 
accepted data

Number of data used for velocity 
estimate

Integer 4 0 - 

SNR Signal to noise ratio of detected 
event

Float 4 ?, dB

Power Signal power of detected event Float 4 0 - ?, dB

Revision 0x0002: two dimensional velocity estimation

Parameter Description Data Type Data Size Allowable Values

Error code Analysis error code Integer 4 1 - 18

Horizontal 
Velocity

Horizontal velocity components 
(Zonal, Meridional)

Float Array 4 x 2 ?, ms-1

Number of 
accepted data

Number of data used for velocity 
estimate

Integer 4 0 - 
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Parameter Description Data Type Data Size Allowable Values

SNR Signal to noise ratio of detected 
event

Float 4 ?, dB

Power Signal power of detected event Float 4 0 - ?, dB

Revision 0x0003: two dimensional velocity and “turbulent velocity” estimation

Parameter Description Data Type Data Size Allowable Values

Error code Analysis error code Integer 4 1 - 18

Horizontal 
Velocity

Horizontal velocity components 
(Zonal, Meridional)

Float Array 4 x 2 ?, ms-1

Turbulent 
Velocity

Turbulent (residual RMS) velocity Float 4 ?, ms-1

Number of 
accepted data

Number of data used for velocity 
estimate

Integer 4 0 - 

SNR Signal to noise ratio of detected 
event

Float 4 ?, dB

Power Signal power of detected event Float 4 0 - ?, dB

5.3.12  VEL-DBS Postanalysed Data Records 
Magic number: 0x2081xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data Size Allowable Values

Error code Analysis error code Integer 4 1 - 18

Velocity Velocity components (Zonal, 
Meridional)

Float Array 4 x 2 ?, ms-1

Vertical velocity Vertical velocity (upwards  = 
positive)

Float 4 ?, ms-1

Acceptance rate The percentage of data used for 
each beam direction

Float Array 4 x No. of 
Beams

0 - 100, %

SNR The signal to noise ratios for each 
beam direction

Float Array 4 x No. of 
Beams

?, dB

Power The power for each receiver each 
beam direction

Float Array 4 x No. of 
Beams

?, dB

Magic number: 0x2081xxxx where “xxxx” is the revision number of the record.
Revision 0x0001: radial velocity included

Parameter Description Data Type Data Size Allowable Values

Error code Analysis error code Integer 4 1 - 18

Velocity Velocity components (Zonal, 
Meridional)

Float Array 4 x 2 ?, ms-1

Vertical velocity Vertical velocity (upwards  = 
positive)

Float 4 ?, ms-1

Radial velocity The radial velocity for each beam 
direction

Float Array 4 x No. of 
Beams

?, ms-1

Acceptance rate The percentage of data used for 
each beam direction

Float Array 4 x No. of 
Beams

0 - 100, %
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Parameter Description Data Type Data Size Allowable Values

SNR The signal to noise ratios for each 
beam direction

Float Array 4 x No. of 
Beams

?, dB

Power The power for each beam direction Float Array 4 x No. of 
Beams

?, dB

Magic number: 0x2081xxxx where “xxxx” is the revision number of the record.

Revision 0x0002: radial and turbulent velocity included

Parameter Description Data Type Data Size Allowable Values

Error code Analysis error code Integer 4 1 - 18

Velocity Velocity components (Zonal, 
Meridional)

Float Array 4 x 2 ?, ms-1

Vertical velocity Vertical velocity (upwards = 
positive)

Float 4 ?, ms-1

Radial velocity The radial velocity for each beam 
direction

Float Array 4 x No. of 
Beams

?, ms-1

Turbulent 
velocity

The turbulent velocity for beam 
direction

Float Array 4 x No. of 
Beams

?, ms-1

Acceptance rate The percentage of data used for 
each beam direction

Float Array 4 x No. of 
Beams

0 - 100, %

SNR The signal to noise ratios for each 
beam direction

Float Array 4 x No. of 
Beams

?, dB

Power The power for each beam direction Float Array 4 x No. of 
Beams

?, dB

5.3.13  IDI parameter Record.
Magic number: 0x2090xxxx where “xxxx” is the revision number of the record. 

Revision 0x0000, 0x0001:

Parameter Description Data Type Data Size Allowable Values

Number of 
Receiving 
Channels

The number of receiving channels 
used for data analysis (N)

Integer 4 1 - 16

Active 
Receiving 
Channels

The active receiving channels used 
for data acquisition (and hence 
SNR calculation) (1-based)

Integer 
Array

4 x N 1 - ?

FCA Receiving 
channels 

The four receiving channels used 
for  full correlation analysis (1-
based)

Integer 
Array

4 x 4 1- ?

Lowest Range 1 The first (lowest) sampled range 
for the first sampling region (m).

Integer 4 0 - ?

Range Interval 
1

The range interval between 
samples in the first sampling 
region (m).

Integer 4 0 - ?

Range extent 1 The range of sampled ranges in the 
first sampling region (m).

Integer 4 0 - ?

Radar 
frequency

The operating frequency of the 
radar in Hz during this experiment.

Float 4 0 - ?, Hz
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5.3.14  IDI Analysed Data Records
Magic number: 0x2091xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data Size Allowable Values

Error code Analysis error code Integer 4 1 - 18

Velocity True velocity components (Zonal, 
Meridional)

Float Array 4 x 2 ?, ms-1

Vertical velocity Vertical velocity (upwards  = 
positive)

Float 4 ?, ms-1

Turbulent 
velocity

Turbulent (residual RMS) velocity Float 4 ?, ms-1

Scatterer 
azimth

Mean azimuth angle of scatterers Float 4 0 – 360 degrees

Scatterer zenith RMS zenith angle of scatterers Float 4 0 – 20 degrees

Number of 
scatterers

Number of scatterers located Integer 4 1 - ?

SNR Signal to noise ratio Float 4 ?, dB

Power Signal power Float 4 ?, dB

5.3.15  IDBS Parameter Record
Magic number: 0x20a0xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data Size Allowable Values

Number of 
Ranges

The number of ranges included in 
the analysed data record

Integer 4 0 - ?3

Radar 
frequency

The operating frequency of the 
radar in Hz during this experiment.

Float 4 0 - ?

Transmit Beam 
direction

The transmit beam direction used 
during this experiment.

Integer 
array

4 x 2 Azimuth = 0 – 
360

Zenith = 0 - 90

Nyquist velocity The maximum unambiguous radial 
velocity used in the analysis

Float 4 0 - ? ms-1

GPS locked Indicates whether GPS was locked 
through acquisition of data-set

Boolean 4 0,1

Number of 
Receiving 
Channels

The number of receiving channels 
used for data analysis (N)

Integer 4 1 - 16

Receiving 
Channels

The receiving channels used for 
data analysis (1-based).

Integer 
Array

4 x N 1 - ?

5.3.16  IDBS Analysed Data Record
Magic number: 0x20a1xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

3 A number of ranges equals zero means there were no detected meteor events in this 
record. In this case, a MET analysed data record will not follow the parameter record. 
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Parameter Description Data Type Data Size Allowable Values

Range Range Float 4 0 - ?, km

Error code Analysis error code Integer 4 0 - 2

Effective beam 
direction

The effective beam pointing 
direction

Float Array 4 x 2 Azimuth = 0 – 
360,

Zenith = 0 – 90,

degrees

Radial velocity Radial velocity Float 4 ?, ms-1

Spectral width Spectral width Float 4 0 - ?, ms-1

SNR Signal to noise ratio Float 4 ?, dB

Power Signal power Float 4 0 - ?, dB

5.3.17  MRAD Postanalysed Parameter Record
Magic number: 0x20b0xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data Size Allowable Values

Number of 
latitudes (Nlat)

The number of lattitudes used in 
the radiant count array

Integer 4 90 to 180

Minimum 
lattitude

The minimum latitude used in the 
radiant count array

Integer 4 -90 to 0 degrees

5.3.18  MRAD Postanalysed Data Record
Magic number: 0x20b1xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data Size Allowable Values

Radiant counts Radiant count data Float Array 4 x Nlat x 
360

0 - ?

5.3.19  MPC Postanalysed Parameter Record
Magic number: 0x2100xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data Size Allowable Values

Start time Unix time stamp of earliest data 
used in postanalysis

Long Integer 4 ?

End time Unix time stamp of latest data used 
in postanalysis

Long Integer 4 ?

Number of 
receivers (Nr)

Number of receivers present Integer 4 5 - 16

Number of 
receiver pairs 
(Np)

Number of receiver pairs used in 
MET analysis

Integer 4 4 - 6

Receiver pairs Receiver pairs used in MET 
analysis

Integer 
Array

Np x 2 x 4 1 - 16

Minimum height Minimum acceptable height used Float 4 ? km
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Parameter Description Data Type Data Size Allowable Values

Maximum 
height

Maximum acceptable height used Float 4 ? km

Number of 
echoes used

The number of echoes used in the 
analysis

Long integer 4 ?

Number of good 
echoes

The number of echoes for which a 
height between the minimum and 
maximum height is obtained

Long integer 4 ?

Secondary 
calibration 

Indicates whether secondary 
calibration used

Integer 4 ? km

Minimum height 
for secondary 
calibration 

Minimum acceptable height used 
for secondary calibration (if used)

Float 4 ? km

Maximum 
height for 
secondary 
calibration 

Maximum acceptable height used 
for secondary calibration (if used)

Float 4 ? km

Grid size Grid size used for final calibration 
estimates

Float 4 ?

5.3.20  MPC Postanalysed Data Records 
Magic number: 0x2101xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data Size Allowable Values

Phase offsets4 Array of estimated phase offsets Float 4 x 4 0 – 360 deg

Phase offset 
error

Array of estimated phase offset 
errors

Float 4 x 4 0 – 360 deg

Phase 
calibration 
values

Phase calibration values stored in 
analysis/lib/rx_cal.dat (only present 
if this file exists)

Float 4 x Nr 0 – 360 deg

5.3.21  MTMP Postanalysis Parameter Records
Magic number: 0x2110xxxx where “xxxx” is the revision number of the record.

Revision 0x0000:

Parameter Description Data Type Data Size Allowable Values

Height model 
flag

Indicates whether a peak height 
model assumed

Integer 4 0 or 1

Pressure Model 
climatogy at 
peak height flag

Array of estimated phase offset 
errorsIndicates whether a 
pressure/temperature gradient 
climatogy at the peak height is 
used

Integer 4 0 or 1

Temperature 
gradient 
climatogy at 
peak height flag

Indicates whether a 
pressure/temperature gradient 
climatogy atthe peak height is used

Integer 4 0 or 1

4 Note that the phase offsets reported are those obtained once the phase calibration 
values stored in analysis/lib/rx_cal.dat have been applied to the data.
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Parameter Description Data Type Data Size Allowable Values

Maximum 
zenith angle

Indicates the maximum allowable 
zenith angle used for temperature

Integer 4 60O  (currently 
hardwired)

5.3.22  MTMP Postanalysis Data Records
Magic number: 0x2111xxxx where “xxxx” is the revision number of the record.

Revision 0x0000

Parameter Description Data Type Data Size Allowable Values

Pressure 
climatology 
temperature

 Temperature derived using the 
pressure climatology technique

Float 4 ?? (0 = no 
estimate)

Temperature 
gradient 
climatology 
temperature

Temperature derived using the 
temperature gradient climatology 
technique

Float 4 ?? (0 = no 
estimate)

Peak height The peak height of the meteor 
height distribution

Float 4 85 - 95 km

Height width The standard deviation of the 
meteor height distribution

Float 4 3 - 5 km

Peak height 
pressure

The pressure at the peak height Float 4 ?? Pa

Peak height log 
D

The (10-based) log diffusion 
coefficient at the peak height

Float 4 ??

Log D slope The slope of the (10-based) log 
diffusion coefficient vs height 
scatter plot at the peak height

Float 4 ??

Temperature 
gradient

The temperature gradient at the 
peak height

Float 4 ?? K/km

Float 4 x Nr 0 – 360 deg
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5.4  Appendix D: Control files used by the analysis and display 
suite
The following table lists the control files used by the ADCG and analysis monitor for 
communication. These files may be found in the directory /home/radar/analysis/control. 
Note that the file names all begin with a “.” and will not be visible unless the “-a” option is 
specified with the ls command. 

 “Zero length” control files may be created using the touch command. For example, to create the 
“.sea_scatter” file, type: “touch ~radar/analysis/control/.sea_scatter”.

Control File File Type Purpose

.<name>_config IDL save file Contains configuration structure providing 
information for the "name" analysis module.

.<name>_halted Zero length Indicates Analysis Monitor has stopped invoking 
"name" analysis due to excessive errors.

.<name>_invoke Zero length Instructs Analysis Monitor to call analysis “name” 
during each analysis cycle.

.<name>dm_default IDL save file Contains structure providing default initial 
parameters for the “name” display module

.<name>2_ config IDL save file Contains configuration structure providing 
information for the "name" postanalysis module.

.<name>2_halted Zero length Indicates Postanalysis Monitor has stopped 
invoking "name" postanalysis due to excessive 
errors.

.<name>2_invoke Zero length Instructs Postanalysis Monitor to call postanalysis 
"name" during each postanalysis cycle.

.<ip address> 
<name>_config

IDL save file Contains configuration structure providing 
information for the "name" analysis module, as 
transferred from the IP address “IP address”.

.<ip address> 
<name>_2config

IDL save file Contains configuration structure providing 
information for the "name" analysis module, as 
transferred from the IP address “IP address”.

.analyse_archive IDL save file Instructs the analysis monitor to apply the 
currently enabled and configured analyses to the 
data file located in the directory  specified by the 
string 

"dir" and name specified by the string "file".
.analyse_archive_done IDL save file Renamed “.analyse_archive” file produced after 

completion of analysis. Allows reanalysis of file by 
renaming to “.analyse_archive”

.analysis_lock Zero length Indicates  the analysis is running.

.analysis_utility Zero length Contains names of archived raw data files 
selected for analysis using the analysis utility

.analysis_utility_done IDL save file Renamed “.analysis_utility” file produced 
after completion of analysis. Allows reanalysis of 
file by renaming to “.analysis_utility”

.archive_period IDL save file Contains parameter "archive_period" denoting 
time period for data archiving by the analysis and 
postanalysis.

.arch_mon_config IDL save file Archiving monitor configuration file.

.arch_mon_invoke Zero length Archiving monitor invocation file

.arch_util_config IDL save file Archiving utility configuration file.

.arch_util_invoke Zero length Archiving utility invocation file

.cache_post_time Zero length Indicates that .post_time files should be written 
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Control File File Type Purpose

(with time stamps) to the cache directory rather 
than the control directory. Applicable to offline 
analysis only.

.cadm_ranges IDL savefile Specifies default plotting ranges for FCA, SCA, 
IDI and VEL display

.ci_extra Zero length Allows the user to configure the extra coherent 
integrations for applicable analysis modules (FCA, 
DAE, SCA).

.config_extra Zero Length Allows configuration of extra acceptance criteria 
thresholds for FCA, SCA and IDI analysis

.config_range Zero length Allows the user to configure the ranges over 
which each analysis or postanalysis takes place in 
the analysis and postanalysis configuration.

.daedm_ranges IDL savefile Specifies default plotting ranges for DAE display

.dbsdm_ranges IDL savefile Specifies default plotting ranges for DBS display

.debug Zero length Execute display suite in debug mode - enables 
more accurate error messages to be generated 
during widget application crashes.

.default printer Text Name of default printer. Used in the "Print utility" 
if plot to be sent directly to printer.

.disable_archiving Zero length Instructs analysis and postanalysis that archiving 
should not be performed due to low disk space 
(e.g. storing raw data of detections in MET 
analysis, and incoherently averaged spectra in 
DBS postanalysis)

.discard_raw Zero length Instruct Analysis Monitor to delete raw data files 
once analysed. The default is to archive raw data.

.display_lock Zero length Indicates the display is running.

.display_name Text Contains the DISPLAY environment variable used 

by the IDL analysis and postanalysis sessions
.flush_full Zero Length Instructs Analysis Monitor to remove analysed 

data files awaiting analysis. Purged data files are 
either deleted or archived depending on the 
existence of the “.discard_raw” control 
file.Contains the DISPLAY environment variable 
used by the IDL analysis and postanalysis sessions

.flush_partial Text Contains the DISPLAY environment variable used 
by the IDL analysis and postanalysis sessions

.local_time Zero length Set to indicate data time reference is local time 
(LT) rather than universal time (UTC)

.max_disk_perc IDL save file Contains parameter "max_disk_perc " which 
indicates at what percentage of disk space that 
raw data archiving should be disabled. Default 
value is 95%.

.met_vel Zero length Enable meteor velocity analysis if MET analysis 
module is present.

.mode_swap Zero length Indicates first mode of a mode-interleaved data 
set is E-mode (applicable to RD12 radars only)

.new_data IDL save file Contains structure providing information on latest 
data set in analysis queue.

.offline Zero length Set to indicate display and analysis suite is for 
offline use.

.post_analysis Zero length Indicates to the analysis and display sessions that 
postanalysis is present.
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Control File File Type Purpose
.postanalysis_
utility

IDL save file Contains names of analysed data files selected for 
analysis using the analysis utility

.postanalysis_
utility_done

IDL save file Renamed “.postanalysis_utility” file after 
completion of analysis. Allows reanalysis of file by 
renaming to “.postanalysis_utility”

.post_flush_full Zero length Instructs Postanalysis Monitor to remove analysed 
data files awaiting postanalysis. Purged data files 
are either deleted or archived depending on the 
existence of the “.discard_raw” control file.

.post_flush_partial IDL save file Contains structure providing the names of the 
analysed spooled data files to be removed from 
the postanalysis queue.

.post_time IDL save file Contains parameters providing time and 
acquisition

information supplied by analysis monitor for 
postanalysis monitor.

.proc_int IDL save file Contains arrays "processing_interval" and 
"processing_duration" of user defined values (in 
seconds) for processing interval and duration for 
postanalysis.

.pause Zero length Pause analysis and postanalysis sessions.

.rddm_ss_config IDL save file Contains configuration structure default 
parameter information used by raw data display 
sea scatter removal utility

.real_time Zero length Instruct Analysis Monitor to offer the most recent 
raw data file to enabled analyses for analysis (i.e. 
Real time mode).  Default behaviour is to offer the 
oldest raw data file for analysis (Queued mode).

.remote_config Zero length Instructs Display software to make remote 
configuration options available if they are 
installed.

.restart_analysis Zero length Instructs Analysis Monitor to exit, then restart. 

.restart_display Zero length Instructs Display  to exit, then restart. 

.restart_postanal Zero length Instructs Postanalysis Monitor to exit, then 
restart. 

.sea_scatter Zero length Instructs analysis configuration widget to allow 
Sea Scatter Rejection to be configured for 
analysis.

.terminate Zero length Instructs the Analysis and Postanalysis Monitors 
to exit.

.time_info IDL save file Contains timing information on the most recent 
analysis cycle to the ADCG.

.time_unambig Zero length Indicates all times are to be displayed in the form 
“Month Day Year” (e.g. August 25 2004).

.transfer Text Contains IP addresses and destination directories 
detailing where spooled raw data should be 
transferred to after analysis.

.version Text Indicates version number and date of the analysis 
and display suite.
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5.5  Appendix E: Remote file transfer issues
To allow automated ftp to a remote location from the PFT or AFT postanalyses, the file ".netrc" 
file must be present in the radar users home directory (/home/radar). This file requires read and 
write permissions to be set for the radar user (i.e. rw-------, or 600), and must contain an entry 
for each remote location used by the PFT or AFT postanalyses. An example of the entries required 
for the use of these files:

machine <IP number> login <login name> password <password>.

For security reasons, it is suggested that these entries relate to anonymous ftp accounts rather 
than individual users accounts. For example, the appropriate entries to allow remote ftp into the 
anonymous ftp server aaa.bbb.ccc.ddd by a user with email address “radar@atrad.com.au’’ 
would be:

machine aaa.bbb.ccc.ddd  login anonymous password radar@atrad.com.au
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5.6  Appendix F: Coding New Software Modules 
The following explains the procedure to be followed for a user to include an third party analysis 
within the ATRAD IDL analysis and display suite. This involves the generation of an IDL "savefile". 
This savefile must be generated using the same version of IDL as that used for the analysis and 
display suite. At present, user analyses cannot use analysis configuration information. This will be 
addressed in a later version of the IDL suite.

The user analysis must be an IDL function stored in a file with name of the form 
"abc_analysis.pro". The result to be written to file should be returned from the function. The 
inputs are assumes to be the complex raw data array "data" of format [Number of time-series 
samples, Number of receivers, Number of ranges], and the "data_state" structure, which contains 
the parameters written to the "parameter records" as described in the "ATRAD raw data format" 
shown in Appendix A: ATRAD Raw Data Format. The various "tags" of the data_state structure are 
shown in 5.6.3. These tags can be accessed in the following manner:

e.g. 

Number of samples:  data_state.n_pts

Number of receivers: data_state.n_rx

   ...etc.

An example of a simple third party analysis is shown in 5.6.2.

5.6.1  Producing the savefile
To produce the save file for user analyses, type the following from an IDL session:

IDL> resolve_routine, "abc_analysis", /is_function

IDL> resolve_all

IDL> save, /routines, file = "user_abc_analysis.sav"

This will produce an IDL savefile "user_abc_analysis.sav". This file should be placed in the 
directory "/home/radar/analysis/lib". The ACDG will need to be restarted to recognise the 
presence of the analysis. The analysis should appear in the "Analysis Control" options as 
"USER_ABC Analysis". The "Invoke" and "Disable" options are available, but the "Configuration" 
option will not be available. The analysed data will be written to files of the form “19990823.abc”
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5.6.2  Example of a third party analysis
The following provides an example of a simple analysis that determines the zero mean values of 
each receiver time-series at each range level.

function zma_analysis, data, data_state, config

;

; Zero-mean analysis. This takes zero mean and writes it to the 

;"result" structure, which is then written to the analysed data

; file with name [year][month][day].[zma]

;

; First, set result structure to be written to file

;

  result = {TIME:  0L,  $ ; Unix time – long int.

        RANGE:  0., $ ; Range - floating point

      ZERO_MEAN: complexarr(data_state.n_rx)}

;

; Replicate this structure over all ranges

;

  result = replicate(result, data_state.n_ht)

;

; Set time

;

  result.time = data_state.unix_time

;

; Set range array

;

  result.range = data_state.ht_interval*indgen(data_state.n_ht) + $

                 data_state.ht_start

;

; For loop over each range

;

  for ht = 0, data_state.n_ht-1 do $

  begin

;

; Take zero mean value for each receiver, and store it

;

      for n = 0, data_state.n_rx-1 $

      do $ 

          result(ht).zero_mean(n) = $

                     total(data(*, n, ht))/data_state.n_pts

  endfor

  return, result

  

end  
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5.6.3  Data_state structure definition 
The following provides information of the available tags for the data_state structure definition. 
Note that the values of these tags for any raw data file can be viewed using the Housekeeping raw 
data utility described on page 62.

5.6.3.1  Parameter types

  max_rx = 32 ; Maximum number of Rx channels

  max_tx = 32 ; Maximum number of Tx channels

  max_bs = 64 ; Maximum number of PTPBS directions

  int = 0 ; Integer type (2-byte integer)

  lint = 0L ; Long int type (4-byte integer)

  flt = 0. ; Float type (4-byte float)

  dflt = 0D ; Double prec. float (8-byte)

  str = '' ; String type (null)

  bool = 0 ; Boolean flag type (an integer: 0 = NO, 1 = YES)

5.6.3.2  File parameters

DATA_FILE : str  ; data file name

DATA_DIRECTORY : str  ; data path (ends in /)

LUN   : lint  ; lun of opened file.

DATA_FORMAT : int  ; format (1 to 7)

FORMAT_NAME : str  ; format abbreviation

FORMAT_REVISION : lint ; Rev. no. of data format

DATA_REVISION : lint  ; Raw data revision.

DATA_RANGE : lonarr(2) ; min and max data value

FILE_SIZE : lint  ; file size in bytes

FILE_PTR : lint  ; current file position.

5.6.3.3  Sequence parameters
MAX_RX  : max_rx ; 32 Rx channel. maximum

MAX_TX  : max_tx ; 32 Rx channel. maximum

FILE_ID  : lint  ; Equipment/Site ID.

SITE_NAME : str  ; Radar site name

CAMPAIGN_NAME : str  ; Campaign name

N_EXPT  : lint  ; Number. of expteriments in sequence

ACQ_INTERVAL : lint  ; Experiment scheduling interval (s)
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5.6.3.4  Experiment parameters
EXPERIMENT_NAME : str  ; Verbose experiment. name 

EXPERIMENT_TAG : str  ; Experiment. tag name

EXPERIMENT_NO : lint  ; Sequence no. of experiment.

EXPERIMENT_REPS : lint  ; No. of reps. of experiment.

FREQ  : flt  ; radar frequency (Hz)

LIGHT_SPEED : 3e8  ; speed of light (m/s) 

LAMBDA  : flt  ; radar wavelength (m)

PRF  : lint  ; pulse rep. freq. (Hz)

N_PTS  : lint  ; no of data points

N_CI  : lint  ; no coherent integrations.

DELTA  : flt  ; interpulse period (s)

RANGE_CAL : lint  ; Radar range cal. (ns)

N_RX  : int  ; no of active channels

CHAN_MAP : intarr(max_rx) ; Which channels are sampled and in
; what order (1 - based).

N_BEAMS : int  ; no of tx beam dirs.

DUAL_SAMP : bool  ; Dual range samp. flag

PHASE_FLIP : bool  ; Phase inversion flag

POL_FLIP_TX : bool  ; Pol. flip Tx?

POL_FLIP_RX : bool  ; Pol. flip Rx?

HT_START : flt  ; lowest range1 (km)

HT_INTERVAL : flt  ; sampling interval1 (km) < 0 if lowest
; range appears first in data.

N_HT  : int  ; no. ranges1 in data.

HT_START2 : flt  ; lowest range2 (km)

HT_INTERVAL2 : flt  ; sampling interval2 (km) < 0 if lowest
; range appears first in data.

N_HT2  : int  ; no. ranges2 in data.

RX_POLARISATION : int  ; Mode of reception
 ;    0=O, 1=E, 2=NS, 3=EW

TX_POLARISATION : int  ; Mode of transmission
;    0=O, 1=E, 2=NS, 3=EW

5.6.3.5  Gain parameters
GAIN_ALG_NO : int  ; ID of gain algorithm in use for dynamic

; gain calculations. 0 => no dynamic
; control.

DUAL_GAIN : bool  ; Dual gain regimes?

GAIN  : intarr(max_rx) ; gain settings (units depend on data)

GAIN2 : intarr(max_rx) ; gain settings for upper gain ranges.

GAIN_MIN : int  ; Min. possible gain

GAIN_MAX : int  ; Max. possible gain
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 RX_FILTER : int  ; Rx filter setting

5.6.3.6  Site parameters
N_TX_ANT : int  ; No. of Tx groups.

N_RX_ANT : int  ; No. of Rx groups.

TX_COORD : fltarr(max_tx,2); (range in m,  bearing in deg)

TX_ANT_LABELS : strarr(max_tx) ; Names of Tx antennas

RX_COORD : fltarr(max_rx,2); (range in m, bearing in deg)

RX_ANT_LABELS : strarr(max_rx) ; Names of Rx antennas

5.6.3.7  Transmit pulse parameters
TX_PULSE_MODE : int  ; 0 = normal,1 = coded,  2 = pulse pairs.

TX_PULSE_WIDTH : lint  ; Pulse width in metres

TX_PULSE_SHAPE : int  ; 1 = Gauss, 2 = Square,  3 = coded.

 TX_PULSE_SEP : lint  ; Distance (m) between pulses in pulse
; pair transmission.

CODE_NO  : int  ; No. codes to trans.

CODE_BITLEN : int  ; No. of bits in code.

CODE_1  : bytarr(8) ; Code 1. MSB -> LSB

CODE_2  : bytarr(8) ; Code 2. MSB -> LSB
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5.6.3.8  Acquisition parameters
UNIX_TIME : lint  ; unix-style time stamp

TIME   : intarr(6) ; [SS, MM, HH, DD, MM, YYYY]

ACQ_NO  : lint  ; Acquisition number

CUR_BEAM : int  ; which Tx beam direction  (1 to
; no_beams)

BEAM_DIR : fltarr(2) ; Tx beam direction (azimuth,  zenith) in
; degrees

5.6.3.9  Receiver calibration parameters
RX_CAL_NO : int  ; No. channels tested.

RX_CAL_DC : lonarr(max_rx,2); Channel offsets.

RX_CAL_AMP : lonarr(max_rx) ; receiver test amps. in digitizer units

RX_CAL_PHASE : fltarr(max_rx) ; receiver test phases in degrees

5.6.3.10  Beam steering parameters
PTPBS : bool  ; PTPBS active?

PTPBS_NO : int  ; Number of beam directions.

PTPBS_DIRS : fltarr(max_bs,2); (Azimuth, Zenith) pairs.

5.6.3.11  RASS parameters
RASS_MODE : int  ; Mode: 0,1,2,3

RASS_SW_START : flt  ; Sweep start frequency

RASS_SW_STEP : flt  ; Frequency sweep step

RASS_SW_NO : int  ; Number of steps.

RASS_SW_DWELL : int  ; Dwell time (ms)

RASS_PR_CENTRE : flt  ; pseudorandom centre frequency

RASS_PR_PEAKDEV : flt  ; pseudorandom peak deviation

5.6.3.12  SPECTRAL and COVARIANCE parameters
CORR_FNS : bool ; Denotes whether data-set is

; covariance functions or not

SPECTRA  : bool ; Denotes whether data-set spectral or
; not

COMBINE  : int   ; Indicates whether receiver
; combination used in data-set   

 N_SPLIT  : int   ; Indicates time-series splitting factor    

 N_LAG  : int   ; Number of lags

 N_PAIRS  : int   ; Number of cross-covariance pairs

 ACF  : intarr(max_rx) ; Index of auto-covariance functions
; present

 CCF  : intarr(max_rx) ; Index of cross-covariance functions
; present
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5.6.3.13  Various other parameters
ACQ_MULTIPLE : lint

DAY_FLAG : bool  ; set if daytime

DAWN  : intarr(2) ; dawn time [minute, hour]

DUSK  : intarr(2) ; dusk time [minute, hour]

PCM_ZERO : intarr(max_tx) ; PCM phase zero steps

PCM_SETTING : intarr(max_tx) ; PCM phase setting 

RX_TEST  : bool  ; set if test data possibly available.

RX_TEST_VALID : bool  ; set if Rx test data valid

RX_TEST_TIME : intarr(6) ; time of last Rx test

RX_PTS  : lint   ; no of Rx phase samples
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5.7  Appendix G: Including receiver calibration estimates in the 
analysis and display suite
This appendix explains how to include receiver calibration estimates within the ATRAD IDL 
analysis and display suite. This involves the generation of an IDL "savefile". This savefile must be 
generated using the same version of IDL as that used for the analysis and display suite.

The use of receiver calibration estimates is important for analyses requiring addition of time-
series acquired on individual receiving channels (such as DAE, DBS and RASS analyses), and 
those requiring estimation of the phase difference between receiving channels to measure angles 
of arrival (such as MET, and from version 3 of the analysis and display suite onwards, FCA and 
SCA analyses). The need for using estimated receiver calibration values results from the fact that 
the hardware receiver calibration procedure calculates complex gain differences through the 
transmitting and receiving hardware only. If complex gain differences are introduced prior to the 
transmitting and receiving hardware, such as through the antennas, combiners, and cabling, the 
hardware estimated gain estimates will not apply to gain differences throughout the entire radar 
system.

The receiver calibration values are stored in an IDL savefile 'rx_cal.dat', which should be 
placed in the '/home/radar/analysis/lib' directory. The analysis will use the values stored in 
this file in preference to the values estimated using receiver calibration testing. The savefile 
generation procedures differ for radars with and without beam steering capabilities.

5.7.1  Radar without beam steering capabilities 
Consider the case for a three receiver radar system where the amplitude ratios with respect to 
receiver channel 1 are a12 and a13, and the phase differences with respect to receiver channel 1 
are p12 and p13 (in degrees). The following steps should be followed to produce a receiver 
calibration savefile for this case:

IDL> amp_corr = 1./[1., a12, a13]

IDL> phase_corr = -[0, p12, p13]

IDL> save, file = 'rx_cal.dat', amp_corr, phase_corr

On restoring a configuration file with this information included, the analysis will multiply the 
amplitudes of each receiver channel by amp_corr, and correct the phases by phase_corr, thereby 
resulting in each channel having the same (average) amplitude ratio and zero relative phase 
difference.

5.7.2  Radar with beam steering capabilities
If a single set of receiver calibration estimates are considered applicable for each antenna 
configuration (i.e. Spaced antenna, Doppler NS and Doppler EW), the procedure for a radar 
without beam steering capabilities outlined in 5.7.1 should be followed.

However, if the receiver calibration estimates are not the same for each antenna configuration, 
the following steps should be followed to produce a receiver calibration savefile for this case:

Firstly, three dimensional amp_corr and phase_corr arrays must be setup

IDL> amp_corr = fltarr(3, n)

IDL> phase_corr = fltarr(3, n)

where n is the number of receiving channels present (usually 6)

The amplitude ratios [a11_sa,..,a1n_sa] and phase differences [p11_sa,..,p1n_sa] with 
respect to channel 1 for the spaced antenna configuration are stored into the first index of the 
first dimension of the arrays:

IDL> amp_corr(0, *) = 1./[a11_sa,..,a1n_sa]

IDL> phase_corr(0, *) = -[p11_sa,..,p1n_sa]
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The amplitude ratios [a11_dns,..,a1n_dns] and phase differences [p11_dns,..,p1n_dns] with 
respect to channel 1 for the Doppler NS configuration are stored into the second index of the first 
dimension of the arrays:

IDL> amp_corr(1, *) = 1./[a11_dns,..,a1n_dns]

IDL> phase_corr(1, *) = -[p11_dns,..,p1n_dns]

The amplitude ratios [a11_dew,..,a1n_dew] and phase differences [p11_dew,..,p1n_dew] with 
respect to channel 1 for the Doppler EW configuration are stored into the third index of the first 
dimension of the arrays:

IDL> amp_corr(2, *) = 1./[a11_dew,..,a1n_dew]

IDL> phase_corr(2, *) = -[p11_dew,..,p1n_dew]

Finally, the savefile is produced by

IDL> save, file = 'rx_cal.dat', amp_corr, phase_corr

  

5.7.3  Radar with beam steering capabilities and separate meteor 
antennas
If a single set of receiver calibration estimates are considered applicable for each antenna 
configuration (i.e. Spaced antenna, Doppler NS and Doppler EW), the procedure for a radar 
without beam steering capabilities outlined in 5.7.1 should be followed.

However, if the receiver calibration estimates are not the same for each antenna configuration or 
for the meteor antennas, the following steps should be followed to produce a receiver calibration 
savefile for this case:

Firstly, four dimensional amp_corr and phase_corr arrays must be setup

IDL> amp_corr = fltarr(4, n)

IDL> phase_corr = fltarr(4, n)

where n is the number of receiving channels present (usually 6)

The amplitude ratios [a11_sa,..,a1n_sa] and phase differences [p11_sa,..,p1n_sa] with 
respect to channel 1 for the spaced antenna configuration are stored into the first index of the 
first dimension of the arrays:

IDL> amp_corr(0, *) = 1./[a11_sa,..,a1n_sa]

IDL> phase_corr(0, *) = -[p11_sa,..,p1n_sa]

The amplitude ratios [a11_dns,..,a1n_dns] and phase differences [p11_dns,..,p1n_dns] with 
respect to channel 1 for the Doppler NS configuration are stored into the second index of the first 
dimension of the arrays:

IDL> amp_corr(1, *) = 1./[a11_dns,..,a1n_dns]

IDL> phase_corr(1, *) = -[p11_dns,..,p1n_dns]

The amplitude ratios [a11_dew,..,a1n_dew] and phase differences [p11_dew,..,p1n_dew] with 
respect to channel 1 for the Doppler EW configuration are stored into the third index of the first 
dimension of the arrays:

IDL> amp_corr(2, *) = 1./[a11_dew,..,a1n_dew]

IDL> phase_corr(2, *) = -[p11_dew,..,p1n_dew]
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The amplitude ratios [a11_met,..,a1n_met] and phase differences [p11_met,..,p1n_met] with 
respect to channel 1 for the meteor antennas are stored into the fourth index of the first 
dimension of the arrays:

IDL> amp_corr(4, *) = 1./[a11_met,..,a1n_met]

IDL> phase_corr(4, *) = -[p11_met,..,p1n_met]

Finally, the savefile is produced by

IDL> save, file = 'rx_cal.dat', amp_corr, phase_corr
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5.8  Appendix H: IDL License information
The analysis and display software suite supplied with the ATRAD [ADAC] radar system uses 
Interactive Data Language (IDL), which is marketed by Research Systems Inc., Boulder, Colorado. 
The analysis and display software uses the IDL 5.5 distribution with a runtime license.  The 
runtime license uses “savefiles” which are analogous to compiled executables.

The IDL license manager is invoked during the normal booting process and uses the 
license file /usr/local/rsi/license/license.dat.  A typical license file is shown 
below.

################### license.dat #################################
############ license file comments, do not delete ###############
# Installation Number(s): 15518 
SERVER baxter.atrad.com.au 008048e83548 1700
DAEMON idl_lmgrd /usr/local/rsi/idl_5/bin 
FEATURE idl idl_lmgrd 5.100 1-jan-0000 6 DBE670F1E4B93CD90AF7 \
VENDOR_STRING=”15518Atmospheric radar systems” \
HOSTID=008048e83548 \
ck=71
INCREMENT insight idl_lmgrd 2.000 1-jan-0000 1 DB16F021106C64559882 \
VENDOR_STRING=”15518Atmospheric radar systems” ck=225
FEATURESET idl_lmgrd CC626AC76CCF325A
##################### end of license file #######################

The validity of the license is assessed by comparing the identification of the first installed network 
card (eth0, normally used to connect to the Radar Network) with the information stored in the 
license file.  If the network card is replaced it will be necessary to obtain another license file for 
use with the new card.  This license be obtained by contacting ATRAD using the email address 
shown on the front page of this manual

If the Linux PC is renamed it is necessary to edit the license file to reflect this change.  To do this, 
make a copy of the license file and edit the SERVER line to reflect the change. The format of the 
license file is easily corrupted, so it is essential maintain a correctly formatted file to ensure your 
license continues to be valid. The IDL license manager should be terminated before the license file 
is edited (using the /usr/local/rsi/idl/bin/lmdown command), and restarted after the license 
file is edited (using the /usr/local/rsi/idl/bin/lmgrd command).

The expiration date of the license is shown in the “FEATURE idl” line.  An expiry date with a year 
of 0000 indicates there is no expiry date and this will be the case for most licenses supplied by 
ATRAD.  ATRAD maintains a list of the licenses with expiration dates and will organise the supply 
of a new license file prior to the expiration date when appropriate.
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5.9  Appendix I: Acronyms
ACF Auto Correlation Function

ADF ATRAD Data Format

ADCG Analysis and Display Control GUI

ALT The “Alt” key on the computer keyboard.

ATABS Acquisition-to-Acquisition Beam Steering

CCF Cross Correlation Function

CIRA COSPAR International Reference Atmosphere

COSPAR Committee for Space Research

CPU Central Processor Unit

DAE Differential Absorption Experiment

DAEDM DAE Display Module

dB Decibel - logarithmic power units.

DBS Doppler Beam Steering

DBSDM Doppler Beam Steering Display Module

DPE Differential Phase Experiment

EBD Effective Beam Direction

IDL Interactive Data Language (produced by RSI)

IGRF International Geomagnetic Reference Field

FCA Full Correlation Analysis

FCADM FCA Display Module

FTP File Transfer Protocol

GPS Global Positioning System

GUI Graphical User Interface

MF Medium Frequency (300 kHz - 3 MHz)

NT Windows NT Workstation

PBS Post-set Beam Steering

PRF Pulse Repetition Frequency

PSS Post-statistics Beam Steering

PTD Percentage Time Discrepancy

PTPBS Point-to-Point Beam Steering

RDAS Radar Data Acquisition System

RSI Research Systems Inc.

SCA Spatial Correlation Analysis

SCADM SCA Display Module

SNR Signal-to-Noise Ratio

SWR Standing Wave Ratio (often a voltage ratio: “VSWR”)

TR Transmit/Receive (usually “TR switch”)

TX Transmitter

URL Universal Resource Locater

UTC Coordinated Universal Time

VHF Very High Frequency (30 MHz - 300 MHz)

XDR eXternal Data Representation
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